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Getting Started with Street Atlas USA 2005 Plus 
Welcome to Street Atlas USA 2005 Plus 

 

To view Help, click a book once to read its overview. Double-click a book to read its overview and 
view all associated topic pages. Click a topic to view its contents. 

 
With Street Atlas USA 2005 Plus, you can perform the following functions and more: 

• Use the POI feature in the Find tab to quickly search for a specific points of interest within a specified 
distance from the current map center or along the active route 

• Use the QuickSearch Find feature to locate a city or town, a major point of interest, street address, ZIP 
Code, or coordinate point. 

• Use the Advanced Find feature to additionally locate the intersection of two streets, a specific category of 
map items (such as landmarks along the current route), or an area code and exchange within a specified 
area or along your current route. 

• Create a route by adding start and finish points on your map. Customize your route by adding stops and 
vias. 

• Customize your map by adding new routable roads, text, MapNotes, stock symbols, and custom symbols. 
• Connect your GPS device to the program and track your progress on a laptop as you travel. View your next 

turn as well as the turn after that—very helpful when you need to make a turn directly after another turn. 
• Search over 22 million business phone listings with the Phone tab. Visit www.delorme.com to purchase 

Phone Data, which includes over 116 million residential listings! 
• Print high-quality, detailed, single-page maps or mural maps as large as 3 x 3 pages. 
• Print your routes and/or route directions of routes, roads, or draw objects (including measure objects). 

 

What's New in Street Atlas USA 2005 Plus 
• New Auto Back on Track for GPS with distance off-route settings you control, plus improved routing 

decision-making for getting you back on track. If you miss your exit, the software automatically calculates 
new directions.GPS Radar searches now include voice prompts for the nearest place to your current GPS 
position 

• New GPS Next Turn and Turn After That text box with large visible route tracking arrow with improved 
visibility and information on the Show Turns GPS navigation screen 

• More accurate turn directions with distinctions between “turn left,” “bear left,” and “keep left” among 
others 

• New easier-to-use POI Name and Category Search subtab for finding Wal Marts, restaurants, lodgings, post 
offices – more than 4 million places in total 

• QuickSearch subtab expands to large font size for easier typing on a laptop 
• New GPS Radar POI search categories include emergency services, major shopping locales, and 

camping/RV parks 
• GPS voice now gives heads-up alerts for rapid-sequence turns, especially important for complex 

interchanges where several turns are clustered together 
• New flexible XData tab allows for adding, editing, and correcting individual records after they have been 

imported 
• Choose a Route Start, Stops, and Finish directly from your XData results 
• Updated map and POI data for the U.S. 
• One easy-to-use DVD with the entire mapping program plus 22 million FREE business phone listings 
• Includes more advanced file management including ability to work with individual or multiple Draw and 

Route layers 
• Ability to transfer files to other Street Atlas USA 2005 Plus users, who can then make edits to the maps 
• New ability to determine at which magnification levels the large POI icons display 
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• Multiple user profiles in the Voice tab with custom microphone, speaker, volume, voice speed, and voice 
recognition settings 

• Support for USB and Bluetooth microphones for GPS Voice Navigation 
• Better display of multiple route names and shields for dual-named roads (e.g., Route One and Main Street) 
• Multiple Undo for Draw objects 
• Large fonts that expand in certain tabs -- plus more visible exit symbols 
• New pop-up tutorials 
• Software has a faster start-up time 

Learning the Basics 
Below is a list of some of the basic functionality in the tabs in Street Atlas USA 2005 Plus.  

Controlling the Map 
How do I pan the map? 
You can use any of the following methods in Street Atlas USA 2005 Plus to pan (move) or center the map. 

• Click anywhere on the current map view. The point at which you click becomes the new map center. 
• When you point near the map edge, a white hand displays. Drag the hand to move the map in that direction. 
• Click anywhere on the Overview Map. The point where you click becomes the new map center. This 

technique allows you to traverse greater distances with each mouse click than you can within the main map. 
Note: If the Overview Map, the small map in the lower-right corner of the screen, is not displaying, pan or 
zoom the map. 

• Point anywhere on the black view box in the Overview Map window. When the pointer becomes a , 
drag the view box to the desired location. 

• Use the search feature in the Find tab to center the map on a particular location. 
• Press ALT+ an arrow key (up, down, left, or right) to pan the map view in small increments in the desired 

direction. 
• While the Num Lock key is off, you can use the direction keys on your numeric keypad to move the map. 

Press: 
• ALT+UP ARROW to pan the map up. 
• ALT+RIGHT ARROW to pan the map right. 
• ALT+DOWN ARROW to pan the map down. 
• ALT+LEFT ARROW to pan the map left. 

Note: Verify the Num Lock key is off by checking that the Num Lock indicator light is turned off. 

How do I zoom the map in and out? 
You can zoom the map in several different ways: 

• Use the up and down arrows on the Data Zoom Level tool in the Control Panel. 
• Use drag and zoom functionality. Drag down-right on the map to zoom in or up-left to zoom out. 
• Press ALT+PAGE UP on your keyboard to zoom out to the next full data zoom level. Press ALT+PAGE 

DOWN on your keyboard to zoom in to the next full data zoom level. 
• Use the mouse wheel (if available) to zoom the map(s) in and out. Rotate the mouse wheel to zoom in by 

individual data zoom level steps or hold the SHIFT key while rotating the mouse wheel to zoom to the next 
full data zoom level. Make sure that the main map is focused either by clicking on it or by pressing the F12 
key on the keyboard.  

 

Map Files Tab 
What is a map file? 

A Map File consists of the map center coordinates, the current zoom level, the current magnification, preferences, 
and any routes or draw layers you have added to it.  

As you create routes and draw layers, they are added to the currently selected Map File. Map Files are saved by 
default in C:\DeLorme Docs\Map Files. 
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Each associated file is saved in its respective folder in the C:\DeLorme Docs directory. For example, a draw layer is 
saved in C:\DeLorme Docs\Draw. For more information about the DeLorme Docs directory, see Street Atlas USA 
2005 Plus File Directories on page 14. 

How can I work without the data disc? 
Your Street Atlas USA data can be saved to your hard disk drive so that it is readily available without inserting it 
into your DVD-ROM drive when you need it. 

1. Insert the Street Atlas USA 2005 Plus data disc into your CD/DVD-ROM drive. Setup begins 
automatically. 
Note: If setup does not begin automatically, from the Start menu, click Run. Type D:\Setup (where D: is 
the letter of the drive containing the data disc) in the command line text box and then click OK. The Street 
Atlas USA 2005 Plus data setup screen displays. 

2. Click Yes. 
3. Follow the screen directions to complete the data installation. 
4. Click Finish when prompted. It is not necessary to restart your computer. 

Route Tab 
How do I create a road route? 
Use the following steps to create a route. 

1. Click the Route tab and then click New/Edit. The New/Edit Route dialog area displays. 
2. Click File, click New, and then type the name for your route in the Name text box. 

3. Click the Start tool  and then click the point on the map where you want to begin your route. 
OR 
Type your start location in the Start drop-down text box. If you type an address, it must be in one of the 
following formats: street address, city, state OR street address, ZIP Code. 

4. Click the Finish tool  and then click the spot on the map where you want to end your route. 
OR 
Type your finish location in the Finish drop-down text box. If you type an address, it must be in one of the 
following formats: street address, city, state OR street address, ZIP Code. 

5. Select a route type (road-shortest or road-quickest) from the available drop-down list. 
Note: Your route will fail to calculate if you select a route type that your dataset does not support. 

6. If you do not have the Auto Calc check box selected, click Calculate. 
OR 
If you do not have the Auto Calc check box selected, right-click the route, select Manage Route, and then 
select Calculate Road Quickestor Calculate Road Shortest from the shortcut menu. 
Note: If Street Atlas USA is unable to find an exact match for the item that you typed, a dialog box 
displays with a list of the closest matches. Scroll through the list of search results until you find the one you 
want to locate, click the item to select it, and then click OK. 

7. Click Directions to view the route directions. 
AND/OR 
Click Advanced to display the advanced routing options. 
AND/OR 
Click Back on Track to add your current GPS position as a stop to the current route. 

Print Tab 
How can I print my route? 
Use the following steps to print an existing route. 

1. Click the Print tab and then click the Route subtab. 
Note: If you do not have a route in this Map File, the print route options are unavailable. 

2. Select the route you want to print from the Name drop-down list. 
Note: If the route you want to print is not available in the Name drop-down list, you may not have the 
correct Map File open. For more information, see Opening a Map File on page 76. 

3. Under Options, select from one of the following choices: 
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• Overview—Provides an optimized map of your route and the route summary (trip distance, trip 
time, start, total stops, and finish). 

• Travel Package—Provides maps of the route with corresponding directions. 
• Directions—Provides action-based directions (turn, merge, bear, depart, arrive, and continue) 

including the time frame for each action.  
Note: Route directions can be saved as a text file. 

• Route Maps—Provides detailed maps in the direction of travel of the route along with directions 
which appear in the map margin. Route maps are not printed North Up like other printed maps. 
They are printed so that the direction of travel is always at the top of the printed map. 

4. Select the miles per page that you want your route to cover from the Miles Per Page drop-down list. 
5. Click Print. 

Draw Tab 
How do I add a road to my map? 
Use the following steps to add routable roads to the map. 

1. Click the Draw tab to open the Draw dialog area. 
2. Click and hold the Routable Roads/Waypoints/Tracks tool to view its hidden options. Select the Routable 

Roads tool  to create a routable road. 
3. Type the name of the road you want to add in the Road Name text box. 
4. Hover the mouse pointer over existing roads to display the yellow diamond symbol . The yellow 

diamond symbol indicates where on an existing road the point for your new road will connect (connection 
point). 
Note: It is necessary for the new road to be connected to an existing non-limited access road for routing on 
the new road to occur. 

5. Once you have located the connection point for your new road, click the map to place the first point. Click 
point-to-point or drag to add the new road to the road layer.  

6. To finish the line draw for the new road, enter the last point on the map screen and click Done.  

GPS Tab 
How do I start tracking with my GPS device? 
In order to begin properly tracking with your GPS device, you must first configure the GPS tab with your 
appropriate device settings. For more information, see Initializing GPS on page 130. 

How do I import waypoints from my GPS device? 
Use the following steps to receive waypoints from your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
4. Under Device Type, select GPS. 
5. Select Receive from Device. 
6. Select Waypoints from the Object drop-down list. 
7. Select Draw File if you want to save the waypoints as a draw file (or User Map Data - Waypoints if you 

want to save the waypoints as a waypoint file) from the Save As drop-down list. 
8. Click Next. 
9. If you selected Draw File in step 7, select the draw file you want to add the waypoint information to from 

the Draw File drop-down list. If you want to create a new draw file, select New from the Draw File drop-
down list and type the new draw file name in the available text box.  
OR 
If you selected User Map Data - Waypoints in step 7, select the waypoint file you want to add the waypoint 
information to from the Waypoint File drop-down list. If you want to create a new Waypoint file, select 
New from the Waypoint File drop-down list and type the new waypoint file name in the New Waypoint 
File text box.  
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10. Click Receive From Device. 
11. Repeats steps 9–10 for each waypoint file you want to receive. 
12. Click Finish. 

Map Display Tab 
How can I change the coordinate system of the map? 
Use the following steps to change how coordinate measurement units display. 

1. Click the Map Display tab and then click Units to display the Units options. 
2. Select the desired coordinate display format from the Coords drop-down list. 

 Degrees 
 Degrees, Minutes 
 Deg, Min, Sec 

Handheld Export Tab 
How do I export a map in Street Atlas USA for use on my handheld device? 

Important: You must have Street Atlas USA 2005 Handheld or XMap® Handheld Pro (available separately 
from DeLorme) to view raster and vector maps on your handheld device. 
Use the following steps to export a map to a Palm OS or Pocket PC device. 

1. In Street Atlas USA, click the Handheld Export tab. The Handheld Export dialog area displays. 
2. Use the Search text box to find the desired export area or select a pre-determined area from the available 

list. 
3. Click Go To. The map centers on the area you selected. The default export area displays as shaded 

rectangles. 
4. If you want to accept the shaded rectangles as the export area, click Select. 

OR 
If you want to modify the default export area, click Edit and select or clear the rectangles you want to 
include/exclude. Then, click Select. 

5. Select if you want to export the map with regional or street detail (street detail is routable). 
6. Click Save. The exported map is then listed in the saved map list on the right side of the tab area. 
7. Select the map from the saved map list and then click Sync to export the map to your handheld device. 

Helpful Tips 
The following are helpful hints for using various functions of Street Atlas USA. Some of the hints are available as a 
pop-up tutorial when you click on a related function within the program. 

 

Selecting the "don't show again" check box in a pop-up tutorial ensures that pop-up will not display 
whenever you click on its related function. If you change your mind and want to view the pop-up 
tutorials later, click the Reset All Pop-up Tutorials option in the Street Atlas USA Help menu. If 
you want to disable all of the pop-up tutorials so they do not display, click the Shut Off All Pop-up 
Tutorials option in the Help menu. 

 
If you want to... Use this tip... 
Zoom the map out/in quickly You can drag the map cursor in an up-left direction to zoom the map out 

or drag it in a down-right direction to zoom the map in. 
Pan the map quickly If you position your cursor on the edge of the map, it becomes a white 

hand that you can use to drag the map to the desired location. 
Update the coordinate format that 
displays in the Control Panel 

You can update your measurement preferences at any time using the Units 
subtab in the Map Display tab. 

Adjust the size of the tab area You can adjust the size of the tab area by dragging the top or right side of 
the tab area. 

Show, hide, or reorder tabs You can use the Tab Manager option in the Help menu to show, hide, or 
reorder tabs. 

Stop a page in a multi-page map 
from printing 

If you do not want to print all the pages in a multi-page map, you can click 
the page(s) you do not want to print on the Layout graphic. 
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If you want to... Use this tip... 
Create a route using a road you 
have added to the map with the 
Draw tab 

When drawing a routable road, be sure to click each existing road it 
crosses to ensure that routing can be done on the new road. When you 
open a track you've imported from your GPS device, be sure to join the 
imported line with existing lines by right-clicking the intersection(s) and 
selecting Manage Draw/Join. 

Join/break linear objects on the 
map 

You can join and break linear objects using keys on your keyboard. Select 
the item(s) you want to join/break (press the SHIFT key to select multiple 
items) and then press CTRL+N to join or CTRL+B to break. 

View a GPS log on the map You can use the Draw tab to import a GPS log file and view it as a line 
object on the map. 

Determine the difference between 
adding and inserting Stops/Vias 

When Stops/Vias are added to a route, they are placed in the order they 
were added to the route. When Stops/Vias are inserted in a route, Street 
Atlas USA places them in the order they would be approached between 
the Start and Finish points of the route. 

Create a route quickly For quick route creation, right-click the map and select one of the Create 
Route options or click the Start (green), Stop (yellow), Via (white), or 
Finish (red) buttons in the Route tab. 

View the last map center Press the middle button in the Compass Rose (in the Control Panel)to 
center the map on the previous map view. This button performs an undo 
function for the last pan or zoom (up to 256 times). 

Quickly view information for a 
location on the map. 

Hover your cursor over objects on the map to see information (such as 
road names, city/town, details about draw objects, etc.) in the status line 
that appears at the bottom of the map, just above the tab area. 

Know if there are NetLink 
updates available 

Check to see if "NetLink" is displayed as red on the NetLink tab. If it is, 
updates/offers are available. 

 

Running Street Atlas USA 2005 Plus 
After you have installed Street Atlas USA 2005 Plus, you can run the program with the data disc, or without it by 
installing the data to your hard drive. For more information on installing data to your hard drive, see Saving Street 
Atlas USA 2005 Plus Data to Your Hard Disk Drive on page 13. 

To Run Street Atlas USA 2005 Plus with the Data Disc 
Choose one of the following ways to access the program using the program data disc. 

• If you installed a desktop shortcut, insert the Street Atlas USA 2005 Plus data disc into your DVD-ROM 
drive, and then double-click the Street Atlas USA 2005 Plus icon. 

OR 
• Insert the Street Atlas USA 2005 Plus data disc into your DVD-ROM drive. From the Start menu, point to 

Programs, point to DeLorme, point to Street Atlas USA 2005 Plus, and then click Street Atlas USA 
2005 Plus. 

Exiting Street Atlas USA 2005 Plus 
To exit the program, click the close button  in the upper-right corner of the screen. 
 
A Save Changes dialog box displays if only one item was changed, such as the data zoom level, resulting in a 
change to the Map File. 

• Click Yes to save any changes to the item. 
• Click No to discard changes to the item.  
• Click Cancel to return to Street Atlas USA 2005 Plus. Changes are not saved. 

An Exit dialog box displays if more than one item has been updated. All updated files are listed and are selected by 
default. 
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• Click Save and Exit to save any changes for the selected files and close the program. 
Note: Clear the check box of any item you do not want saved prior to using this option. 

• Click Exit without Saving to close the program without saving any file changes.  
• Click Cancel to return to Street Atlas USA 2005 Plus. No files are saved. 

Frequently Asked Questions 
Below is a list of the questions which are asked most frequently by our customers about the Street Atlas USA® 
family of products.  

• How do I create a route on the map? 

Street Atlas USA 2005 Plus allows you to create a route by simply adding Start and Finish points. If you 
find the route does not take your favorite streets or you need to make a stop along the way, add/insert Vias 
or Stops. 
You can also create a route using right-click functionality while in any tab. Your route receives a default 
name when creating it using right-click options. However, you can rename your route any time in the Route 
tab to make it easier to retrieve. 
For more information on adding a route to your map, see Creating a Route on page 145. 

• How do I save a route? 

Street Atlas USA 2005 Plus retains the route as it is added. Routes have .anr extensions and are saved in the 
C:\DeLorme Docs\Navigation directory by default. For more information, see Saving a Route on page 150. 

• How do I find a specific location? 

Street Atlas USA 2005 Plus offers powerful search tools that enable you to locate any place in the United 
States or Canada.  
In addition, Street Atlas USA 2005 Plus lets you search for places along your route, within a certain radius 
of the current map center, or within a particular region. 
To access the search feature in Street Atlas USA 2005 Plus, click the Find tab. For more information on 
searching for specific locations, see Using QuickSearch on page 43 and Using Advanced Search on page 
45. 

• How do I turn on voice navigation? 

There are two ways voice is used in Street Atlas USA 2005 Plus. Click a link below to view a topic with 
more information. 

• Listen to your route directions while tracking along a route using GPS. 
• Use the voice recognition feature to issue commands or ask questions about map panning and 

zooming, navigation, or GPS functions. 

• Why can't I hear the voice during voice navigation? 

The Voice Navigation systems in DeLorme products are directly dependent on your computer's sound 
system for its volume levels. 
To Set the Volume Level 
If your system is not playing the sound loud enough, use the following steps to verify the Wave volume 
control is set to its highest levels. 

1. From the Start menu, point to Programs, point to Accessories, point to Multimedia (or 
Entertainment depending on your operating system) and then click Volume Control.  
OR 
If available, click the audio control shortcut on your taskbar. 

2. In the Wave column, move the Volume slider to the top.  
3. Close the Volume Control dialog box.  
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If the voice commands are still not loud enough to hear, contact your sound card manufacturer to download 
and install the latest driver for your specific model sound card. The new driver may be able to provide 
louder output. 
There are a variety of external speaker output options for your laptop. Some of them are simply larger 
external speakers; others allow you to send the voice to your car stereo cassette deck, if you have one. 
Local computer superstores, such as CompUSA, Computer City, Best Buy, etc., have a wide variety of 
external sound options that you can consider for your laptop. 

• How can I run Street Atlas USA 2005 Plus without having to use the data disc? 

The Street Atlas USA 2005 Plus data disc comes with an installation utility on the disc so that you can save 
the data to your hard drive. For more information, see Saving Street Atlas USA 2005 Plus Data to Your 
Hard Disk Drive on page 13.   

• How do I get data updates or fix the roads on my map? 

The data in Street Atlas USA 2005 Plus can only be updated by buying a more recent version of the 
product when it is available. 
However, if you find there is a local road that is missing, you can add it to the current draw layer using the 
Routable Roads Draw tool. For more information, see the topic Routable Roads: Drawing Editing, and 
Placing on page 99. 

• How do I initialize my GPS receiver? 

Each time you use your GPS receiver, you initialize it, which means you set your starting position on the 
map by obtaining the initial coordinates of your location. This can be done automatically or manually.  
The two Help topics with initialization information are Getting Started with Your GPS Connection on page 
130 and Initializing GPS on page 130. 

• How can I get information about an item on the map? 

Street Atlas USA 2005 Plus offers a status bar above the tab area which displays information relative to the 
point the cursor is positioned on. 
You can also right-click virtually any point, symbol, feature, or area on the map and then click Info to 
identify it and view detailed information about it. The type of descriptive information varies, depending on 
the item you have right-clicked. You can also copy this information and paste it into another program, such 
as a word processor. For more information, see Getting Information About Map Features on page 155. 

• What is a Map File? 

Street Atlas USA 2005 Plus lets you save all of the work you have done in the mapping application as a 
single workspace so you can open it again later. These saved workspaces are called Map Files. 
A Map File consists of the following items: coordinates of the map center, current zoom level, current 
magnification, map display preferences, any added items: such as draw layer(s), route(s), and so forth. As 
you create new routes or draw layers, change preferences or the map center, and so forth, they are added to 
the current Map File. Changes can be saved or discarded. 
To learn how to create a Map File in Street Atlas USA 2005 Plus, see Creating and Deleting Map Files on 
page 75. 

• What do the different colors and symbols on the map mean? 

The different colors on the map represent different areas of land use and land cover (for example: parks, 
population centers, water, forests, and so forth). The Map Legend provides examples and descriptions of 
the map features. 
Click the Help button  in Street Atlas USA 2005 Plus and click Map Legend to display the Map 
Legend Help topic. You can view the Map Legend for all map features on the map or view the legends for 
individual feature categories. 
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• How do I zoom in for a closer view of the map? 

You can use the Zoom tools to quickly change the data zoom level (2-0 to 17-0) of the map view. 
Increasing the data zoom level number shows a smaller area at greater detail. Decreasing the data zoom 
level number shows a larger area at lesser detail. 
For more information, see Data Zoom Level on page 41 and Zooming In and Out on page 41. 

• How do I find radio stations? 

• If you want to find a radio station for a given location, right-click the location and then click Info. 
Information (including radio station information) for that location displays in lower-right corner of 
the screen. 

• You can also use the Advanced Search feature in the Find tab to search for all of the radio stations 
in a certain area. After you click the Advanced subtab, select Category from the Find drop-down 
list, select the appropriate Within option from the Within drop-down list, type Radio Coverage in 
Keywords text box, and then click Search.  

 

• What can I do with my Find search results? 

Once you complete a search using the Find tab, you can view that results information and then cut and 
paste your Find results into any text editor. 
Use the following steps to get information about a map feature and then cut and paste the results into a text 
editor: 

1. Right-click the desired map feature, such as a road or town. The right-click options available for 
that type of feature display. 

2. Click Info. A description displays in the Overview Map display area (lower-right corner of your 
screen).  
Note: Descriptive information may include a name or feature type, distance, ZIP Code, town 
name, county name, state, coordinates, available radio stations, and so forth. 

3. Select the desired text by dragging across it. 
OR 
If you want all the information in the box, right-click the information box and then click SelectAll. 

4. Copy the data by pressing CTRL+C on your keyboard. 
OR 
Right-click the information box with the selected text and then click Copy. 

5. Open or switch to the program where you want to paste the text. 
6. Click to select the location where you want to paste the text and then press CTRL+V on your 

keyboard. 
OR 
Right-click the selected location and then click Paste. 
OR 
If the program you are pasting information into has a menu bar, under the Edit menu, click Paste. 

• Why can't I turn off/on my microphone? 

If you experience difficulty turning off/on your microphone, press F4 on the keyboard. Pressing F4 is a 
shortcut for clearing/selecting the Microphone check box in the Voice tab. 

• Why doesn't Street Atlas USA 2005 Plus recognize my voice? 

To troubleshoot why Street Atlas USA 2005 Plus may not recognize your voice, verify the following: 
• Ensure Street Atlas USA 2005 Plus is the active application. "Street Atlas USA 2005 Plus" should 

display in the title bar of the active application. 
• Ensure you are wearing your microphone correctly (see your microphone's user guide for more 

information). 
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• Train your speech engine in the environment in which you are using the Voice tab of Street Atlas 
USA 2005 Plus. It is important to speak as naturally as you did during the training. 

Note: You can also use the Simon Says feature within the program or the Speech settings in your Windows 
Control Panel to change your voice settings. 

• How do I interrupt the map when it is redrawing? 

Press the spacebar on your keyboard to interrupt a map redraw. 

• What's the difference between a stop and a via? 

When routing in Street Atlas USA, you have the option of adding/inserting stops or vias in the route. A stop 
is a location in the middle of a route where you want to stop and then proceed from. A via is a road on the 
map that you want to specifically use when routing.   
For example, if you create a route between Portland, Maine and Yarmouth, Maine without any stops or 
vias, the route directions will tell you to take I-295. However, if you want to take US Route 1 instead, you 
can place vias in the route on US Route 1 to force the route to go by way of US Route 1. If you plan on 
stopping in Falmouth Foreside for lunch, you will want your route directions to reflect that stop. When you 
add a stop, the route can be recalculated to include the stop in the middle of your route. 
The map below shows the area between Portland, Maine and Yarmouth, Maine with two vias and 1 stop.  

 

• What's the difference between adding and inserting a stop or via? 
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The Insert Stop/Via function arranges stops/vias geographically in the route. The Add Stop/Via function 
adds stops/vias in the order they are added to the route.  

• Why don't the town lines display on the map? 

Town lines are only available for the following states: 
• AR 
• CT  
• DC  
• IA  
• IL  
• IN  
• KS  
• LA  
• MA  
• MD  
• ME  
• MI  
• MN  
• MO  
• MS  
• NC  
• ND  
• NE  
• NH  
• NJ  
• NY  
• OH  
• PA  
• RI  
• SD  
• VA  
• VT  
• WI  
• WV 

• How can I move a start, finish, stop, or via in a route? 

Click the Route tab and click the button for the type of point you want to move (for example, to move your 

start, click ). Then, drag the point to the desired location. 

• How can I find all of the nearby points of interest? 

Right-click your location on the map, click Find Travel POIs, and then click the distance you want to 
search within (1 mile, 5 miles, or 10 miles). The gas stations (and other points of interest) display in results 
area in the Find tab. 
OR 
If you are tracking with a GPS device, perform a radar search to locate points of interest within a 
designated distance of your current GPS position. 

• How do I import an address book file into Street Atlas USA 2005 Plus? 

You can use the Draw tab to import address book files into Street Atlas USA 2005 Plus. Once you have 
imported an address book file, you can search for the contents of that file within the program.  
*Note: Address book text files must be: 
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• Comma or tab delimited. 
• In the format: name, address, city, state, ZIP, phone. 
• Less than 50 records long. 

For more information, see Importing Files to Draw Files on page 89. 

• How do I join routable roads so that I can route on them?  

If you want to be able to route on a routable road you have added to your map, you need to use the Join 
Roads option to join the new road to an existing road. 
To join a routable road to an existing road, use the Routable Roads feature to add the road to the map. 
Then, right-click the existing road that the new routable road intersects and select Join Roads. You are 
now able to route on the new routable road. 

• How can I center the map on the previous map center? 

Click the center button in the compass rose to center the map on the previous map view. This button 
performs an undo function for the last pan or zoom (up to 256 times). 

• How do I perform an Along the Way search in the Find tab and print my results? 

You can search for names or categories along your current route by performing an advanced search in the 
Find tab. You can then print your search results using the Along the Way print option. Use the following 
steps to search for a name/category along your current route and print the results: 

1. Click the Find tab and then click Advanced. The Advanced dialog area displays. 
2. Select Name or Category from the From drop-down list. 
3. Select CurrentRoute from the Within drop-down list. 
4. Type the appropriate keyword in the Keyword text box. 
5. Type the desired distance in the Distance text box. 
6. Click Search. The search results display in the dialog area. 
7. Click the Print tab and then click Route. The Route dialog area displays. 
8. Select the Along the Way check box. 
9. Click Print Now. The search results are printed. 

• My computer recognizes too many voice commands. Also, when it is speaking and the microphone is 
on, sometimes it listens to itself even though I don't give it a command. How can I stop this? 

If your microphone is near your speakers, and you are using the microphone together with voice reminders 
(GPS VoiceNav), the program may recognize some of the words that it is speaking and react to them.  Here 
are ways to eliminate this problem: 

• Make sure that you have chosen the Voice Output device (speakers, headset) and the Input device 
(on-board microphone, headset microphone) that you intend to use with DeLorme GPS voice 
navigation. Use the selections that are available in the Input Prefs and Output Prefs subtabs. 

• If more than one speech recognizer is available in the drop-down list, choose the most recent 
(highest version number). 

• Your best voice recognition responses will always be to use a close-talk microphone with voice 
output using the laptop speakers rather than a headphone speaker so that the computer will not 
"hear itself.". 

• If you are speaking with someone else in the room, have a radio or television on, and so on, the 
computer may think those sounds are commands to follow.  Only select the Microphone check 
box on the Voice tab when you intend to use it (press the F4 key on your keyboard to toggle the 
microphone on/off at any time). If you exit the program with the Microphone check box selected, 
the program will start voice recognition again when you restart the program. Voice recognition 
requires a lot of disk space and slows down the system if you are not using it.   

• Use the “Simon Says” feature to clearly distinguish commands from other noise and speech. In the 
Input Prefs subtab (of the Voice tab), set the “Commands start with” phrase to something like 
“computer” or “Simon Says” to reduce the chances of an unexpected command recognition. When 
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choosing a phrase, make sure that it is more than one syllable. The phrases "Computer" or "Simon 
Says" work well. But the simple word "Map" probably will not. 

• The sensitivity of some voice engines can be tuned using the Engine Properties button in the Input 
Prefs subtab. 

• Train the voice recognition system in the environment in which you will use it (for example, in a 
noisy car). 

 

• Why do I have 2 speech icons in my Windows Control Panel? 

This problem can occur on a Windows 98 system. 
If you use the Speech icon in the Windows Control Panel to modify speech engine properties for your 
computer, there may be two "Speech" icons in your Windows Control Panel. Please ensure that you choose 
the newer speech engine properties dialog. The dialog contains separate tabs labeled "Speech Recognition" 
and "Text to Speech". The older dialog contains only a "Speech" tab. 

• Why does my route fail to calculate? 

Your route will fail to calculate if you create a route: 
• That includes route points in Mexico. 
• On an island without roads. In this case, Street Atlas USA will look for the nearest road to that 

island to place the route point. If the nearest road is not routable (for example, it is the only road 
on the island and/or the island does not have ferry access), you will get an error message saying 
"Route failed to calculate." 

• What happens when I place a route point on a location that isn't on a street (such as in a field)? 

When you place a route point in a location that isn't on a street, Street Atlas USA finds the closest street to 
that location, marks the space between the point you clicked and the street with X marks, and starts the 
route at the street. 

• Why is the tab area and control panel so narrow?  

Street Atlas USA was designed to accommodate resolutions of 800 x 600 or higher. If you are using a very 
high resolution (such as 1920x 1200), the tab area and control panel in Street Atlas USA may appear to be 
very narrow.  

Note: Use the Windows Control Panel to adjust your display settings. 

Saving Street Atlas USA 2005 Plus Data to Your Hard Disk Drive 
Your Street Atlas USA 2005 Plus data can be saved to your hard disk drive so that it is readily available without 
inserting it into your DVD-ROM drive when you need it. 

To Save Street Atlas USA 2005 Plus Data 
Use the following steps to save Street Atlas USA 2005 Plus data to your hard disk drive. 

5. Insert the Street Atlas USA 2005 Plus data disc into your CD/DVD-ROM drive. Setup begins 
automatically. 
Note: If setup does not begin automatically, from the Start menu, click Run. Type D:\Setup (where D: is 
the letter of the drive containing the data disc) in the command line text box and then click OK. The Street 
Atlas USA 2005 Plus data setup screen displays. 

6. Click Yes. 
7. Follow the screen directions to complete the data installation. 
8. Click Finish when prompted. It is not necessary to restart your computer. 
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Street Atlas USA 2005 Plus File Directories 
Street Atlas USA 2005 Plus allows you to save route files, draw files, print files, and so forth in designated 
directories. The table below describes the different file types the program supports, which default directory each file 
type is saved in, and the file extension(s). 
File Type Default Directory Extension(s) 
Draw files C:\DeLorme Docs\Draw .an1 
Export files (Draw) C:\DeLorme Docs\Export .txt 
GPS Log files C:\DeLorme Docs\GPSLogs .gpl 
Map Files C:\DeLorme Docs\Map Files .saf 
Print files C:\DeLorme Docs\Print .txt (route directions) 

.bmp (all other files) 
Route files C:\DeLorme Docs\Navigation .anr 
Transfer files C:\DeLorme Docs\Map Files .dmt 

Keyboard Shortcuts 
The following are shortcut keys you can use on your keyboard to perform a variety of actions in Street Atlas USA 
2005 Plus. 
Shortcut key(s) Action 

F1 View the online Help topics 

F4 Select/clear the Microphone check box on the Voice tab 

F5 Next turn? (voice navigation) 

F7  Are we there yet? (voice navigation) 

F8  Where am I? (voice navigation) 

F9 Next stop (voice navigation) 

F10  Resize the tab area to its default 

F11 Pick up the top corner between overview map and the tab for resizing 

F12 Get focus to map 

CTRL+TAB Tab forward through the tabs 

CTRL+SHIFT+TAB Tab backward through the tabs 

CTRL + F5  Show next turn (voice navigation) 

CTRL+ F9 Show next (voice navigation) 

CTRL + F7 Show finish (voice navigation) 

CTRL + F8  Directions (voice navigation) 

CTRL + B  Break line object  

CTRL + C Copy selected text in text field or query results list; copy selected draw 
object 

CTRL + D  Voice navigation on/off (voice navigation) 

CTRL + E Be quiet (voice navigation) 

CTRL + G Start/stop GPS (GPS command) 
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Shortcut key(s) Action 

CTRL + P Print map at current layout 

CTRL + S Save current Map File 

CTRL + V Paste copied text into selected text field in the tab area or MapNote on the 
map; paste copied draw object over the original one 

CTRL + W Toggle auto pan on/off (GPS command) 

CTRL + X Cut selected text; cut selected draw object 

CTRL + Z Undo/redo text edit; undo/redo drawing line or polygon object 

ALT + F1 Opens the Help menu 

ALT + F4 Closes the application 

ALT + F5 Show next turn (voice navigation) 

ALT + F7 Show finish (voice navigation) 

ALT + F9 Center on next stop (voice navigation) 

ALT + LEFT ARROW Pan the map left 

ALT + RIGHT ARROW Pan the map right 

ALT + UP ARROW Pan the map up 

ALT + DOWN ARROW Pan the map down 

ALT + PAGE DOWN Zoom the map in  

ALT + PAGE UP Zoom the map out 

SHIFT+TAB Go back through the controls on the tab 

Glossary 
ADT 
Alaska daylight time 
 
Almanac 
Data downloaded from the satellites that contains the identity codes, location, and time information for each 
satellite. 
 
Arctic Circle 
Parallel, or line of latitude around the Earth, at approximately 66°30' N. Because of the Earth's inclination of about 
23 1/2° to the vertical, it marks the southern limit of the area within which, for one day or more each year, the Sun 
does not set (about June 21) or rise (about December 21). 
 
AST 
Alaska standard time 
 
Attach 
As in attaching a draw road to existing roads. See Snapping Draw Objects on page 97. 
 
Average Speed field 
When tracking with GPS, displays your average speed. 
 
Azimuth 
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The direction of travel or the direction between two points in reference to true or magnetic north. When expressed in 
degrees, its value ranges from 0 to 360 . A compass heading is an azimuth. In most places the word bearing has 
grown to mean the same thing as azimuth. However, azimuth is always measured from true or magnetic north in a 
clockwise direction. For example; due east is 90 and due west is 270 . See also, Bearing. 
 
Battery Voltage field 
Displays the current voltage of your 3Com Palm Computing Organizer's batteries. 
 
Bearing 
Like an azimuth, a bearing is measured in reference to true or magnetic north, but its value never goes over 90 . A 
bearing is always measured from the cardinal directions of north or south. A typical bearing would be N45 E, which 
is the same as an azimuth of 45 . The bearing S45 W is an azimuth of 225 . The use of the word bearing has changed 
over the years and now means the same as azimuth. When tracking, bearing displays the direction of travel between 
your current position and your next waypoint, relative to true or magnetic North. 
 
Bread crumb trail 
A set of dots that display on your computer screen to record your progress as you travel. 
 
CDT 
Central daylight time 
 
Coordinates 
A set of numbers (e.g., latitude and longitude) used to identify the specific location of a point. 
 
Course 
The azimuth and length of a line, considered together. 
 
CST 
Central standard time 
 
Date field 
When connected to a DeLorme GPS receiver, displays the current date. 
 
Differential GPS (DGPS) 
A technique to improve GPS accuracy that uses pseudo-range errors recorded at a known location to improve the 
measurements made by other GPS receivers within the same general geographic area. 
 
Dilution of Precision (DOP) 
The total effect of all error sources in locating a position. 
 
DOP 
Dilution Of Precision 
 
Download 
To transfer information from a remote unit, such as a GPS receiver, to a computer. 
 
EDT 
Eastern daylight time 
 
Elevation field (GPS) 
When GPS tracking, displays your current elevation (due to Selective Availability which can vary as much as 512 
feet (156 meters); however, 95 percent of the time you can expect greater accuracy.) Elevation is the height above 
sea-level. 
 
Ephemeris 
Data which indicates the position and status of satellites. 
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EST 
Eastern standard time 
 
GMT 
Greenwich mean time; used as the standard of time throughout the world. 
 
GPS 
Global Positioning System; a "constellation" of orbiting satellites used to calculate a precise position on or near the 
earth's surface. 
 
HDOP 
The measure of how much the geometry of the satellites affects the horizontal position estimate. 
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Heading 
Azimuth of the longitudinal axis of an aircraft or ship. Heading may differ from direction of travel when flying or 
boating due to currents in the air or water. 
 
Initialize 
To set to a starting position, as in obtaining initial coordinates for a GPS receiver. 
 
Latitude 
Position north or south of the equator in degrees, minutes, and seconds. 
 
Log 
A record of the speed, direction, and route of travel as obtained via GPS. 
 
Logging 
Recording the speed, direction, and route traveled using GPS. 
 
Longitude 
Position east or west of the prime meridian in degrees, minutes, and seconds. 
 
Maximum Speed field 
When GPS tracking, displays your maximum speed. 
 
MDT 
Mountain daylight time 
 
MST 
Mountain standard time 
 
NMEA 
National Marine Electronics Association 
 
PDOP 
The measure of how much the error in the position estimate produced from satellite range measurements is 
amplified by a poor arrangement of satellites (with respect to the receiver antenna). 
 
Port 
A hardware interface used by a computer to communicate with an external device. 
 
PPS 
Precise Positioning System; radio signals available to military and other authorized personnel for GPS. 
 
Proxy server 
An application that breaks the connection between sender and receiver. All input is forwarded out a different port, 
closing a straight path between two networks and preventing a cracker from obtaining internal addresses and details 
of a private network. Proxy servers are available for common Internet services; for example, an HTTP proxy is used 
for Web access, and an SMTP proxy is used for e-mail. 
 
Real time 
The actual time during which something takes place. 
 
Receiver 
Hardware device that receives data, such as from satellites. 
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Snapping 
Attaching a point on one draw object to the exact coordinates of a point in another draw object. You can snap the 
central shape point of an arc to another object or snap a routable road to an existing road, enabling routing from the 
drawn road to the road system on the map database . 
 
Speed field 
When GPS tracking, displays your speed as you travel. 
 
Third-party GPS device 
A GPS receiver manufactured by a company other than DeLorme, such as GARMIN, Magellan, Brunton, Lowrance, 
Trimble, and so forth. 
 
Time field 
When connected to a DeLorme GPS receiver, displays the Greenwich mean time. 
 
Time to the End of the Route field 
When GPS tracking, displays the time from your current position to your Finish (based on your current speed). 
 
Time to Next Turn field 
When tracking, displays the time from your current position to your next turn or route change (based on your current 
speed). 
 
Track 
To observe or plot the moving path of an object. 
 
Upload 
To transfer information from a computer to a remote unit, such as a GPS receiver. 
 
VDOP 
The measure of how much the geometry of the satellites affects the vertical position estimate. 
 
Waypoints 
Marked positions with specific coordinates that can be downloaded or uploaded. 

Travel Condition Information 
This list below provides phone number and Web site information by state/province for road conditions and road 
construction forecasts in the United States and Canada.  
State/Province Road 

Construction 
Road 
Conditions 

Web Site 

Alabama 334-242-
4128 

N/A www.dot.state.al.us 

Alaska 800-478-
7674 

511 www.dot.state.ak.us 

Alberta 780-427-
2731 

Calgary: 403-
246-5853  
Edmonton: 
780-471-6056 

www.ama.ab.ca 

Arizona 888-411-
7623 

511 www.azfms.com 

Arkansas 501-569-
2000 

501-569-2000 www.arkansasinterstates.com 

British 
Columbia 

900-565-
4997 

900-565-4997 www.th.gov.bc.ca/bchighways/roadreports/roadreports.htm 

California 800-427- 800-427-7623 www.dot.ca.gov/hq/roadinfo 
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State/Province Road 
Construction 

Road 
Conditions 

Web Site 

7623 
Colorado 303-573-

7623 
Denver: 303-
639-111 
877-315-7623 

www.cotrip.org 

Connecticut 860-594-
3061 

in-state: 800-
443-3061 
outside CT: 
860-594-2650 

www.dot.state.ct.us/trav_info/index.html 
www.dot.state.co.us/TravelInfo/Index.htm 

Delaware 800-652-
5600 

N/A www.deldot.net/static/travel.html 

Florida 511 (partial 
coverage) 
Lake City: 
800-749-
2967 
Miami: 800-
435-2368 
Orlando: 
800-780-
7102 
Southwest: 
800-292-
3368 
Tampa: 800-
226-7220 
Turnpike: 
800-749-
7453 
I-75 or I-10: 
800-475-
0044 

511 (partial 
coverage) 
Lake City: 
800-749-2967 
Miami: 800-
435-2368 
Orlando: 800-
780-7102 
Southwest: 
800-292-3368 
Tampa: 800-
226-7220 
Turnpike: 
800-749-7453 
I-75 or I-10: 
800-475-0044 

www.dot.state.fl.us 
www.myflorida.com 
www.fhp.state.fl.us 

Georgia 888-635-
8287 

888-635-8287 www.dot.state.ga.us 

Hawaii 808-536-
6566 

808-536-6566 N/A 

Idaho Treasure 
Valley: 208-
336-6600 
All other 
areas: 888-
432-7623 

Treasure 
Valley: 208-
336-6600 
All other 
areas: 888-
432-7623 

www.itd.idaho.gov 

Illinois Toll-free 
roads: 312-
368-4636 
Toll-free 
roads: 800-
452-4368 
Toll 
highways: 
800-865-
5394 

Toll-free 
roads:312-
368-4636 
Toll-free 
roads:800-
452-4368 
Toll 
highways: 
800-865-5394 

www.illinoisroads.info 
www.dot.state.il.us 

Indiana 317-232- 317-232-8300 www.in.gov/dot/motoristinfo 
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State/Province Road 
Construction 

Road 
Conditions 

Web Site 

8300 
Iowa 511 511 www.dot.state.ia.us/roadcons.htm 
Kansas 511 511 www.ksdot.org 
Kentucky 511 511 www.kytc.state.ky.us 
Louisiana N/A N/A www.dotd.state.la.us 
Maine 511 511 www.state.me.us/mdot/homepage.htm 
Manitoba 877-627-

6237 
204-945-
3704 

877-627-6237 
204-945-3704 

www.gov.mb.ca/tgs/hwyinfo/roadinfo1.html 

Maryland 800-323-
6742 
410-545-
0300 

877-229-7726 www.sha.state.md.us 

Massachusetts 617-374-
1234 

617-374-1234 www.mass.gov 

Michigan 800-381-
8477 

800-381-8477 www.michigan.gov/mdot 

Minnesota 511 
800-657-
3774 

511 www.dot.state.mn.us 

Mississippi 601-359-
7338 

601-987-1211 www.gomdot.com 

Missouri 888-275-
6636 
800-222-
6400 

888-275-6636 www.modot.state.mo.us 

Montana 511 511 www.mdt.state.mt.us/travinfo 
Nebraska 511 511 www.dor.state.ne.us 
Nevada 877-687-

6237 
877-687-6237 www.nevadadot.com/traveler 

New 
Brunswick 

N/A 800-561-4063 www.gnb.ca/0113/roadcond/road-conditions-e.asp 

New 
Hampshire 

511 In state: 511 
Outside NH: 
866-282-7579 

www.state.nh.us/dot/traveler.htm 

New Jersey Central: 732-
308-4074 
Northern: 
973-770-
5025 
Southern: 
609-866-
4940 

N/A www.state.nj.us/transportation 

New Mexico 800-432-
4269 

800-432-4269 www.nmshtd.state.nm.us 

New York N/A NY Thruway: 
800-847-8929 

www.dot.state.ny.us/roads/roads.html 

Newfoundland N/A N/A www.roads.gov.nf.ca 
North Carolina 919-733-

2210 
N/A www.doh.dot.state.nc.us/impact 
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State/Province Road 
Construction 

Road 
Conditions 

Web Site 

North Dakota 511 511 www.state.nd.us/dot/road.html 
Northwest 
Territories 

N/A 800-661-0750 www.gov.nt.ca/Transportation/index.html 

Nova Scotia N/A 902-424-3933 www.gov.ns.ca/tran/roadconditions 
Nunavut 888-252-

9869 
888-252-9869 http://www.gov.nu.ca/Nunavut 

Ohio 511 511 www.dot.state.oh.us/ 
Oklahoma N/A 405-425-2385 www.okladot.state.ok.us 
Ontario Within 

Canada: 800-
268-4686 
Toronto: 416-
235-4686 

Within 
Canada: 800-
268-4686 
Toronto: 416-
235-4686 

www.mto.gov.on.ca/english/ 

Oregon In state: 511 
Outside OR: 
503-588-
2941 

In state: 511 
Outside OR: 
503-588-2941 

www.tripcheck.com 

Pennsylvania Within PA: 
888-783-
6783 
Outside PA: 
717-783-
5186  

Within PA: 
888-783-6783 
Outside PA: 
717-783-5186  

www.dot.state.pa.us 

Prince Edward 
Island 

N/A Charlottetown: 
902-368-4750 
Georgetown: 
902-652-8960 
Summerside: 
902-888-8275 

www.gov.pe.ca/roadconditions/index.php3 

Quebec 888-355-
0511 

888-355-0511 www.mtq.gouv.qc.ca/en/accueil/plansite.asp 

Rhode Island 401-222-
4545 

N/A www.dot.state.ri.us/webtraf/index.html 

Saskatchewan N/A In province: 
888-335-7623 
Outside SK: 
306-933-8333 

roadinfo.telenium.ca/shwyw.html 
www.highways.gov.sk.ca 

South Carolina N/A N/A www.dot.state.sc.us 
South Dakota 511 511 www.sddot.com/travinfo.asp 
Tennessee 800-858-

6349 
800-342-3258 www.tdot.state.tn.us/information-office/const.htm 

Texas 800-452-
9292 

800-452-9292 www.dot.state.tx.us/hcr/main.htm 

Utah 511 511 www.dot.state.ut.us 
Vermont N/A 800-429-7623 www.aot.state.vt.us/travelinfo.htm 
Virginia 800-367-

7623 
800-367-7623 virginiadot.org/comtravel/default.asp 

Washington 800-695-
7623 

800-695-7623 www.wsdot.wa.gov/traveler.htm 

West Virginia N/A 877-982-7623 www.wvdot.com/6_motorists/6_motorists.htm 
Wisconsin 800-762- 800-762-3947 www.dot.state.wi.us 
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State/Province Road 
Construction 

Road 
Conditions 

Web Site 

3947 
Wyoming 307-772-

0824 
In state: 888-
996-7623 
Outside WY: 
307-772-0824 

www.wyoroad.info/highway/text_road.html  

Yukon 
Territory 

867-456-
7623 
877-456-
7623 

867-456-7623 
877-456-7623 

www.gov.yk.ca/roadreport 

 

Travel Contacts 
This Help topic contains hotel, car rental, and airline information. 

Hotel Information 
Hotel Name Phone Number 
AmeriHost Inn 800-434-5800 
AmeriSuites 877-774-6467 
Baymont Inn & Suites 866-999-1111 
Best Inns and Suites 800-237-8466 
Best Western International, Inc. 800-780-7234 
Clarion Hotels 877-424-6423 
Comfort Inns 877-424-6423 
Country Inns & Suites 888-201-1746 
Courtyard by Marriott 888-236-2427 
Crowne Plaza 888-303-1746 
Days Inn 800-329-7466 
Doubletree Hotels 800-222-TREE 
Drury Inn 800-DRURY INN 
Econo Lodge 800-55 ECONO  
Embassy Suites 800-EMBASSY 
Extended StayAmerica 800-804-3724 
Fairfield Inn 800-228-2800 
Fairmont Hotels 800-257-7544 
Hampton Inn 800-HAMPTON  
Hawthorn Suites  800-527-1133 
Hilton Hotels 800-HILTONS 
Holiday Inn 800-HOLIDAY 
Holiday Inn Express 800-HOLIDAY 
Homewood Suites 800-CALLHOME 
Howard Johnson 800-446-4656 
Hyatt Hotels and Resorts 800-633-7313 
Inter-Continental Hotels 888-303-1758 
Jumer's Hotels 800-AT JUMER 
La Quinta Inns 866-725-1661 
Loews Hotel 800-23 LOEWS 
MainStay Suites 877-424-6423 
Marriott Hotels  888-236-2427 
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Hotel Name Phone Number 
Microtel Inn 888-222-2142 
Motel 6 800-4MOTEL6 
Omni Hotels  800-THE-OMNI 
Park Plaza International 888-201-1803 
Quality Inn 877-424-6423 
Radisson Hotels International 888-201-1718 
Raffles International Hotels and Resorts 800-637-9477 
Ramada Hotels  800-2-RAMADA 
Red Roof Inn 800-RED ROOF 
Regal Hotels 800-222-8888 
Renaissance Hotels  800-HOTELS1 
Residence Inn by Marriott  800-331-3131 
Rodeway Inn 877-424-6423 
Sheraton Hotels & Motor Inns  800-325-3535 
Shoney's Inn  800-552-4667 
Signature Inn  800-822-5252 
Sleep Inn  800-SLEEP INN 
Staybridge Suites 877-932-4117 
Super 8 Motels, Inc.  800-800-8000 
Travelodge & Viscount Hotels 800-578-7878 
W Hotels 888-625-5144 
Westin Hotels & Resorts  888-625-5144 
Wyndham Hotels and Resorts 877-999-3223 

Car Rental Information 
Car Rental Company Phone Number 
Alamo 800-603-5471 
Avis 800-230-4898 
Budget 800-527-0700 
Dollar 800-800-3665 
Enterprise 800-261-7331 
Hertz 800-654-3131 
National 800-227-7368 
Payless 800-729-5377 
RentaWreck 800-944-7501 
Thrifty 800-847-4389 

Airline Information 
Airline Name Phone Number 
Airtran Airways 800-AIRTRAN 
Alaska Airlines 800-252-7522 
America West Airlines 800-235-9292  
American Airlines 800-433-7300  
American Eagle 800-433-7300 
Continental Airlines 800-525-0280 
Delta Airlines 800-221-1212 
Hawaiian Airlines 800-367-5320  
Midwest Express Airlines 800-452-2022  
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Airline Name Phone Number 
Northwest Airlines 800-225-2525 
Southwest Airlines 800-435-9792  
United Airlines 800-864-8331 
USAirways 800-428-4322  
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Help 
Help Overview 
There are several ways to get more information on Street Atlas USA 2005 Plus features and functionality. 

On-Screen Help 
Help is available in the dialog area of Street Atlas USA 2005 Plus in the form of ToolTips and information boxes.  

Help Menu 
Click the Help button  on the title bar to view the online Help options available with Street Atlas USA 2005 
Plus. Then, click an item to select it.  

 

To access a Help menu item using its underlined letter, click the Help button and then press the 
underlined letter (for the desired item) on your keyboard. For example, to access the Map Legend, 
click the Help button and then press the M key on your keyboard. 

Context-Sensitive Help 
Click the context-sensitive Help button  to receive overview Help information for the tab you are using. 

Using the Help System 
This Help system provides explanations of all of the features and functions of Street Atlas USA 2005 Plus. To 
access the Help system, click the Help button  on the title bar and then click Help Topics, or press the F1 
key on your keyboard. 
The Help system displays three tabs: 

 Contents 

To view an outline of the Help system contents, click the Contents tab. 
• To view the overview for a particular book, click the book. 
• To view the additional topics under a particular book, double-click the book. 
• To view a topic, click the desired page. 

 Index 

Use the following steps to search the Help system index. 
1. While in the Help system, click the Index tab.  
2. Type a keyword in the entry field. The list automatically scrolls to the closest matching 

entry. 
3. Double-click the desired topic. 

OR 
Click the topic and then click Display. 
OR 
Click the topic and press the ENTER key on your keyboard. 

Notes: 
• If a topic has any secondary index references, a window displays the 

secondary index options. Click the item of interest to display the topic. 
• If you don't find what you're looking for in the index, click the Search tab and 

try a search for your keyword. 

 Search 

Use the following steps to search for particular words or phrases within topics in the Help system. 
1. While in the Help system, click the Search tab.  
2. Type a keyword in the entry field and then click List Topics or press the ENTER key on 

your keyboard. A list of topics containing the keyword displays.  
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3. Double-click the desired topic under Select Topic to Display. 
OR 
Click the topic and then click Display. 
OR 
Click the topic and press the ENTER key on your keyboard. 

 
• The Help system keeps a history of viewed topics. Click the Back button  to browse 

backward through previous topics. Click the Forward button  to browse forward 
through the topics previously viewed. 

• Print any of the Help Topics by selecting a topic or heading (next to the book symbol) and 

then clicking the Print button . You can choose to print only the selected topic or a 
heading and all subtopics. 
OR 
Right-click the topic displaying in the right window to print only that topic. 
Tip: Before clicking Print, expand any links in the topic which include information you want 
to print within your topic. 

• While in the Help system, the pointer changes to a hand when it passes over text or graphics 
that you can click for more information. 

• The Help Topics window is a standard window that can be moved or resized. 
• To exit Help, click the close button  in the upper-right corner of the screen. 

 

Help Documentation Conventions 
To help you easily locate and interpret information, this Help system has been formatted with various words in all 
capital letters, in color, in boldface type, and so forth. There are also hyperlinks which expand, jump to another 
location within the same topic, or link you to other topics. 
The table below defines each convention and its use. 
The convention... Is used for... 
ALL CAPITALS Acronyms, names of certain commands, and keys on the keyboard.  

Note: Use of the plus sign (+) between key names indicates key combinations 
which perform various actions. For example, in the directions "Press 
CTRL+SHIFT+F3 on your keyboard," you must press and hold the CTRL and 
SHIFT keys while pressing F3. 

Bold Command buttons, tab names, and options when used in procedures and exercise 
steps. Also used for information that you type exactly into a particular field. 
Headings and table headings are bold for emphasis. 

Italic Directory names and paths; used sparingly for emphasis; also used when referring 
to titles of chapters, sections, and publications. 

Blue underlined text Hyperlinks. These links act differently depending on their context. When it is: 
• Referenced with "for more information," the link always goes to another 

topic. 
• Embedded in text, such as in the example "Open the file," the link either goes 

to another topic or displays a secondary window with a definition or graphic. 
Red underlined text Drop-down text which expands within the same topic to reveal more information 

(such as a procedure). 

symbol in a yellow 
box 

A note that applies to the entire Help topic. If there is more than one note, the 
Notes symbol is used and the notes are bulleted. 
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The convention... Is used for... 
Note(s): in Yellow 
Highlight 

A note within a procedure. If there is more than one note, the notes are bulleted. 

symbol in a blue 
box 

A tip that applies to the entire Help topic. If there is more than one tip, the Tips 
symbol is used and the tips are bulleted. 

Tip(s): in Blue Highlight A tip within a procedure. If there is more than one tip, the tips are bulleted. 
 

Street Atlas USA 2005 Plus User Guide 
The Street Atlas USA 2005 Plus User Guide includes the entire Help system contents, modified for print format, in a 
portable document format (.pdf). When the guide is accessed, Adobe® Acrobat® Reader launches. The User Guide 
contains a table of contents and can be printed out as a hard-copy reference. 
To access the User Guide, click the Help button  on the title bar and then click User Guide. 

On-Screen Help 
There are three ways to obtain on-screen Help while using Street Atlas USA 2005 Plus. 

Pop-up Tutorials 
When you a click a variety of functions in Street Atlas USA 2005 Plus, a pop-up message displays. The pop-up 
message provides additional information for using that particular function in Street Atlas USA. If you do not want to 
see the pop-up tutorials throughout the program, click the Help button in the upper-right corner of the application 
and then click Shut Off All Pop-Up Tutorials. 

ToolTips 
When you point to any of the Street Atlas USA 2005 Plus tools for a few seconds, a short label (ToolTip) displays 
on your screen describing the tool. ToolTips also display in Street Atlas USA 2005 Plus windows and dialog boxes 
when you point to a button, icon, or other feature. 

Information Boxes 
Several of the Street Atlas USA 2005 Plus tabs contain information boxes that often display to the left of the 
Overview Map (the small map in the lower-right corner of your screen). Information boxes provide descriptions 
about the features and functions of the selected tab. 
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Basic Functions 
Basic Functions Overview 
Map control in Street Atlas USA 2005 Plus is accomplished by using standard mouse point-and-click functionality 
and the Control Panel tools. Right-click options provide flexibility for labeling, routing, getting information, and so 
forth. For more information, see other Basic Functions topics. If they are not currently displaying, double-click the 
Basic Functions book. 

To Control the Map 
The following list details the basic functions for controlling map movement.  

• The mouse is used to pan or center the map view. Click a spot on the map to center the map on that point.  
• A white hand displays when you point near the edge of the map. When the hand is visible, drag the map in 

the desired direction. 
• Use the black view box in the Overview Map window to pan the map. Point anywhere on the view box. 

When the pointer becomes a , drag the view box to the desired location. 
• The mouse button also allows you to quickly zoom the map using drag and zoom functionality. 

To Use the Tabs 
Click on a tab to view the available functionality. You can also use the keyboard arrow keys to browse through the 
tab areas. If it is not possible to display all tabs, horizontal scroll arrows display to the right of the last visible tab. 

Drag and Zoom 
One of the most convenient features of Street Atlas USA 2005 Plus is the ability to quickly zoom in on the map by 
using drag and zoom functionality. Zoom in by dragging the mouse in a down-right direction or zoom out by 
dragging the mouse in an up-left direction. 

To Zoom In 
Zooming in increases the data zoom level number and shows a smaller geographic area at greater detail.  
Use the following steps to zoom in. 

1. Drag the mouse in a down-right direction on the map to encompass the area you want to display. A view 
box displays on the screen and changes dimension as you move the mouse. A label displays the data zoom 
level at the current map center. 

2. Once you reach the desired area or data zoom level you want to display, release the mouse button. The area 
you selected fills the map window, the map re-centers, and the map view adjusts to show the appropriate 
level of detail. 
Tip: You can move the view box to another location by pressing the SHIFT key at anytime during this 
procedure. 

To Zoom Out 
Zooming out decreases the data zoom level number and shows a larger geographic area at lesser detail. The 
maximum zoom-out level is 2-0. 
Use the following steps to zoom out. 

1. Drag the mouse in an up-left direction on the map. A staircase with a small circle displays on the screen. 
2. Continue dragging the mouse in an up-left direction. The small circle moves up the steps, one step per data 

zoom level. A label displays the data zoom level to the bottom-right of the staircase.  
3. Once you reach the desired data zoom level you want to display, release the mouse button. The map view 

adjusts to display the appropriate level of detail. The map center is retained on your screen. 

 

Additional zoom features include the Data Zoom Level controls and the Zoom tools. 
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Panning/Centering the Map 
You can use any of the following methods in Street Atlas USA 2005 Plus to pan (move) or center the map. 

• Click anywhere on the current map view. The point at which you click becomes the new map center. 
• When you point near the map edge, a white hand displays. Drag the hand to move the map in that direction. 
• Click anywhere on the Overview Map. The point where you click becomes the new map center. This 

technique allows you to traverse greater distances with each mouse click than you can within the main map. 
Note: If the Overview Map, the small map in the lower-right corner of the screen, is not displaying, pan or 
zoom the map. 

• Point anywhere on the black view box in the Overview Map window. When the pointer becomes a , 
drag the view box to the desired location. 

• Use the search feature in the Find tab to center the map on a particular location. 
• Press ALT+ an arrow key (up, down, left, or right) to pan the map view in small increments in the desired 

direction. 
• While the Num Lock key is off, you can use the direction keys on your numeric keypad to move the map. 

Press: 
• ALT+UP ARROW to pan the map up. 
• ALT+RIGHT ARROW to pan the map right. 
• ALT+DOWN ARROW to pan the map down. 
• ALT+LEFT ARROW to pan the map left. 

Note: Verify the Num Lock key is off by checking that the Num Lock indicator light is turned off.  

Control Panel 
The Control Panel, located to the right of the map view, displays information pertinent to the current map view and 
map cursor position. It also includes zoom and map pan buttons. 
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Data Zoom Level—The current data zoom level of the map view; ranges between 2-0 
(maximum zoom-out) and 17-0 (maximum zoom-in). 
Zoom Tools—Buttons that quickly zoom out three levels, out one level, or in one level. 
Compass Rose—A group of nine buttons, eight with yellow arrows pointing outward. 
Click one of the arrow buttons to pan the map in that direction. Click the middle button to 
center the map on the previous map view. This button performs an undo function for the 
last pan or zoom (up to 256 times). 
True North Indicator—Indicates the position of North relative to the current map view. 
When the map is rotated using the Map Rotation tool, the True North arrow indicates True 
North in relation to the rotated map. 
Map Rotation Tool—This drop-down list is used to change the orientation of the map 
display by adjusting the degree of map rotation. The angle of map orientation is directly 
related to the degrees of a compass; for example, 90 degrees is always East. 
Latitude/Longitude—Latitidue/longitude coordinates for the current map cursor position 
display based on the units chosen under Coordinates on the Units dialog area in the Map 
Display tab. 
Measure Tool—Measure linear distances and perimeter/area on the map. For more 
information, see Measuring Distance and Area on page 34. 
Print Screen Button—Prints the current view as it displays on the screen (the control 
panel, tab area, map view(s), etc.). 
Scale Bar—Indicates the distance one scale bar unit equals in the measurement chosen 
under Measures on the Units dialog area in the Map Display tab. 

 

Map Rotation Tool 
Street Atlas USA 2005 Plus allows you to change the orientation of the map display by adjusting the degree of map 
rotation. The angle of map orientation is directly related to the degrees of a compass; 90 degrees is always East, 135 
degrees is Southeast, 180 degrees is South, and so forth. For example, when you select 90 degrees from the drop-
down list, the map rotates so that 90 degrees (East) is at the top of the screen. 

To Change the Map Rotation 
Use one of the following two methods to change the angle of map rotation. 

• Select an angle from the available drop-down list  (in 45 degree increments)  
OR 

• Type a specific angle (from 0 to 359 degrees) in the entry field. 

 

• The True North Indicator adjusts when a new degree of map rotation is set.  
• The black rectangle in the Overview Map window, indicating the current map view, also 

rotates to match the angle of map rotation.  
• A rectangle drawn with the Polygon/Rectangle/Circle tool in the Draw tab is positioned in 

relation to North. 
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Measuring Distance and Area 
The Measure Tool allows you to measure linear distance and area on the map based on the units chosen under 
Coordinates on the Units dialog area in the Map Display tab.  
The snapping feature allows you to snap (attach) the point of a measurement line to a point on a road or another 
measurement object. Using the snapping feature helps to ensure a more accurate measurement of distance or area. 
The snap function is essential when measuring area. To measure area, you must completely enclose the desired area 
by snapping your finish point to your starting point. For more information, see the procedure which immediately 
follows. 

 

You can disable the auto-snap function by holding down the ALT key on your keyboard while using 
the Measure Tool. 

To Measure Distance or Area 
Use the following steps to measure linear distance or area on the map. 

1. Verify you have the desired units of measure selected in the Map Display tab. For more information, see 
Setting Units of Measure Preferences on page 166.  

2. On the Control Panel, click the Measure Tool . The pointer changes to .  
3. Click point-by-point to draw a measurement line on the map. A text box displays next to your pointer 

indicating the total distance of the measurement taken. 
Note: When you pass over a point in a road, measurement line, or measurement area to which you can 
snap, a yellow circle  defines the snap point. Click to snap the point of the measure line to the road or 
measurement object's point coordinate. 

4. To end a measurement line, double-click the last point of the measurement line. The measure line displays 
as a two-pixel wide yellow line and the total length of the line displays in a label at each endpoint of the 
line. 

5. To end a measure area, hover over the starting point until the yellow snap circle  displays and then 
double-click the last point to the starting point. The closure area becomes transparently shaded, and the area 
and perimeter measurements displays. 

 

Instead of double-clicking to end measure mode, click the last point of your measure line or area and 

then click the Measure Tool . 

 

 

Measure objects (lines and areas) are saved with the current Map File. When a new file is created, 
the measure objects do not display. If you want the same measure objects on your new Map File, 
you must recreate them. 

 

Using the Overview Map 
The Overview Map is a smaller map in the lower-right corner of the screen, which offers a wide-angle view of your 
current map view area. It is approximately three data zoom-levels out from the current map view.  

 

• Click anywhere on the Overview Map and that point becomes the new map center. This 
technique allows you to travel greater distances with each mouse click than you can within 
the larger, current map view. 

• Use the black view box in the Overview Map window to pan the map. Point anywhere on the 

view box. When the pointer becomes a , drag the view box to the desired location. 
 

Right-Click Mouse Options 
Right-click mouse options in Street Atlas USA 2005 Plus make many functions more convenient. For example, you 
can add and delete routes without going to the Route tab, add MapNotes without going to the Draw tab, and so forth. 
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To Use Right-Click Options for Map Features 
Click the right mouse button while pointing to a draw object, road, river, city, or other map feature. A shortcut menu 
displays near the selection point with the options available for that particular map feature. 

 

If there are multiple (layered) objects on the point that is right-clicked, additional menu options 
corresponding to the map objects are available. 

 
• Open Hyperlink 

Opens the hyperlink attached to the clicked Draw object. 

• Phone Listings 
Right-click a road on the map and then click Phone Listings to view all of the phone information for that 
particular street. 

• Add MapNote 
The Add MapNote right-click option allows you to label map locations with various types of MapNotes. 
Right-click the point on the map you want to label, point to Add MapNote, and then click one of the 
available options.  
Each MapNote type provides different information, as shown in the following table. 

MapNote Type (Color) MapNote Label Information 
MapNote (light blue) 
Not always available. 

Name of feature or its type, if unnamed.  
Note: If there is no feature type, no MapNote displays. This is 
most noticeable when right-clicking on land only. 

Detailed MapNote 
(light blue) 
Not always available. 

Name, feature name, feature category, and measurement 
information, for example: Great Cranberry Island, Land or 
Island, Earth Surface, 1.71 square miles. 

Where Am I MapNote (light blue) City, county, and state names, plus the ZIP Code. 
Coordinate MapNote (light blue) Coordinate information, based on the latitude/longitude format 

chosen in the Map Display tab. 
Blank MapNote (white) A blank label, which you can edit yourself. 

• Manage Route 
 To hide a route, right-click the route and then click Hide Route. 
 To activate an inactive route, right-click the desired inactive route and then click Activate Route. 
 To delete a route, right-click the route and then click Delete Route. 
 To reverse the direction of the route, right-click the route and then click Reverse Route. 
 To convert a Stop to a Via, right-click the Stop/Via and then click Convert to Stop or Convert to 

Via. 
 To delete a Stop or a Via, right-click the Stop/Via and then click Delete Stop or Delete Via. 
 To calculate the quickest route between your Start and Finish points, right-click the route and then 

click Calculate Road Quickest. 
 To calculate the shortest distance between your Start and Finish points, right-click the route and 

then click Calculate Road Shortest. 

• Manage Draw Objects 

• To make changes to symbol or MapNote text, right-click the desired item, click Manage Draw 
Objects, and then click Edit Draw Object Text. 

• To delete a draw object, right-click the desired item, click Manage Draw Objects, and then click 
Delete Draw Object. 

• To join multiple lines, press the CTRL key on your keyboard while you select the lines, click 
Manage Draw Objects, and then click Join Lines. 

• To break a line, select the line on the map, click Manage Draw Objects, and then click Break 
Line. 
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• To copy a line directly on the selected item, click Manage Draw Objects and then click Copy to 
Draw Object. By using options in the Draw tab, you can select and then move and/or manipulate 
the linear object. For example, you can use a road as one edge of a polygon shape, by dragging its 
shapepoints into the desired configuration. Map lines which can be copied to Draw objects include 
all types of roads and highways, railroad, power lines, pipelines, rivers or streams, and grid lines. 

• Info 
Right-click a point, symbol, feature, or area on the map and then click Info to identify it and view detailed 
information about it. This information displays in the Info tab.  
Notes:  

 The type of descriptive information varies, depending on the item you have right-clicked. You can 
also copy the information and paste it into another program, such as a word processor. 

 If there is more than one object under the point you clicked, information for each object displays. 

• Find Travel POIs 
1. Right-click a point on the map, point to Find Travel POIs, and then select a distance. The Find 

tab displays and a category search is launched.  
2. When the Find Category within Distance from Mouse Click dialog box displays the general 

categories, review the listing. Clear the check box of any category you do not want included in 
your results. 

3. Click OK to perform the search. Results are sorted based on the distance from the point where you 
clicked. 
Note: The search may take awhile, depending on the location and the distance specified. 

• Create Route 
You can use Create Route right-click options from any tab. Right-click a point on the map and then select 
one of the options in the table below. 
Note: Once set, route points for the active route can be repositioned or resequenced. For more information, 
see Editing a Route on page 148. 

Routing option Function 
Set as Start Sets the selected point as the starting point of your route. 
Add Stop Adds a numbered stop to your route. All new stops are added in sequence.  
Add Via Adds a numbered via to your route. All new vias are added in sequence. 
Insert Stop Inserts a stop geographically within your route. (If the Automatic Calculation 

check box is selected in the Route dialog area, the route automatically 
recalculates based on shortest distance between each stop.) 

Insert Via Inserts a via geographically within your route. (If the Automatic Calculation 
check box is selected in the Route dialog area, the route automatically 
recalculates based on shortest distance between each stop.) 

Set as Finish Sets the selected point as the endpoint of your route. 
 

• Copy Map to Clipboard 
Copies the current map to the clipboard so that it can be pasted into a third-party application (such as a 
Word Processing application). 

To Use Right-Click Options in the Find Results List 
After performing a QuickSearch or an advanced search, you can right-click an item in the Find results list. A 
shortcut menu displays the following options. 

• Open Hyperlink 
Opens the hyperlink attached to the search result (if applicable). 

• Copy to Clipboard 
Copies the information for the selected item(s) and makes it available for pasting into another program. 
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• Go To 

Provides the same result as clicking the Go To button. 

• Select All 
Selects all items in the list and highlights them on the map (up to 350). The Go To button name switches to 
Add Tags. Click Add Tags to add MapTags to all selected items. Or, if you right-click again (with all items 
selected), you can select Copy to Clipboard or Add MapTags. 

• Add 
Click Add and then click MapTag, MapNote, or Detailed MapNote to add the item to the location 
clicked on the map. 

• Route 
Assign a point on the map as a start, stop, or finish of a route by right-clicking a point on the map and then 
selecting Set as Start, Insert as Stop, or Set as Finish. 

To Use Right-Click Options in the Phone Search Results or Selection Areas 
You can right-click search results or phone selections to perform the following actions: 

• Copy 
Copies the search result(s) or selection(s) to the clipboard. 

• Select All 
Selects all of the items in the list. 

• Search this Address 
Performs a new address search based on the address of the item you've right-clicked. Search results display 
all of the listings for a particular address. 

• Search this Phone 
Performs a new phone search based on the phone number of the item you've right-clicked. Search results 
display all of the listings for a particular phone number. 

• Add 
Adds the selected search result(s) to the Selection area. 

• Add All 
Adds all of the listings in the Search Results area to the Selections area. 

• Clear All 
Clears all of the search results from the Search Results area. 

• Map 
Adds the item(s) which are highlighted in the Selections area to the map. 
Note: The map does not center when multiple items are selected. 

• Remove 

Removes the selected listing(s) from the Selections area. 

• Remove All 

Removes all of the listings from the Selections area. 

• Sort by Name 
Sorts the search results or selections alphabetically by last name. 

• Sort by Address 
Sorts the search results or selections alphanumerically by ZIP Code and then street address. 



Street Atlas USA 2005 Plus User Guide 

38 

• Sort by Phone 

Sorts the search results or selections numerically by telephone number.  

Moving or Deleting MapTags, MapNotes, and Text Labels 
There are several types of tags, notes, and text labels used in Street Atlas USA 2005 Plus. Once these are created, 
you may forget where and how you generated these items, which is important to know when you want to edit, move, 
or delete them. 
Use the following table to determine what type of item you have, read a short description, and find more information 
on moving, deleting, and editing. 
 
Type of item Description 
MapTag 

 

A MapTag displays at the location where a place, street address, feature type, 
coordinate, and so forth are located using the search function in the Find tab.  

MapNote 

 

A MapNote created using right-click functionality, it provides the feature name. 

Detailed MapNote 

 

A MapNote created using right-click functionality, it provides the name, feature 
name, feature category, and measurement information. 

Where am I MapNote 

 

A MapNote created using right-click functionality, it provides the city/town 
name, county name and code, state name and abbreviation, and ZIP Code. 

Coordinate MapNote 

 

A MapNote created using right-click functionality, it provides the coordinate 
position based on the current Units preference selected in the Map Display tab. 

Blank MapNote 

 

You can label your map with a MapNote you edit yourself by using: 
Right-click functionality 
OR 
The MapNote/Text Label tool in the Draw Tab. 

Text Label 
 

You can label your map with a text label you can edit yourself by using the 
MapNote/Text Label tool in the Draw Tab. Text labels do not have a background 
color like other map labeling items. 

 

Reordering the Tabs 
The Tab Manager feature in Street Atlas USA 2005 Plus lets users customize their program by reordering the tabs. 
You can access Tab Manager during installation or after installation using the Tab Manager option in the Help 
menu. 
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• If you reorder the tabs while the program is open, you must exit and restart the program to 
view the tab changes. 

• If you have selected to show all or most of the tabs in Street Atlas USA 2005 Plus, you will 
need to use the tab scroll buttons in Street Atlas USA 2005 Plus to view any tabs that are not 
currently visible. Tab scroll buttons display to the left of the left-most visible tab and to the 
right of the right-most visible tab. The tab scroll buttons are active when additional tabs are 
available and out of view. Hold the active tab scroll buttons to shift the tabs to the right or left. 

To Reorder the Tabs 
Use the following steps to reorder the tabs in Street Atlas USA 2005 Plus using Tab Manager. 

1. Open Street Atlas USA 2005 Plus. 
2. Click the Help button  on the title bar and select Tab Manager from the Help menu. 

OR 
From the Start menu, point to Programs, point to DeLorme, point to Street Atlas USA 2005 Plus, and 
then click Tab Manager. 

3. Click Tab Manager. The Street Atlas USA 2005 Plus Tab Manager dialog box displays. 
4. Select the tab you want to reorder. 

5. Click the up arrow  or the down arrow  to move the tab in the desired position. 
6. Repeat steps 4 and 5 for each tab you want to reorder. 
7. Optional: Click Default if you want to cancel the reordering process and use the default tab order (showing 

all available tabs). 
8. Click OK. 
9. Exit Street Atlas USA 2005 Plus. 
10. Open Street Atlas USA 2005 Plus. 

Showing or Hiding Tabs in Street Atlas USA 2005 Plus 
The Tab Manager feature in Street Atlas USA 2005 Plus lets users customize their program by showing or hiding 
certain tabs. You can access Tab Manager during installation or after installation using the Tab Manager option in 
the Help menu or from the Start menu by pointing to Programs, pointing to DeLorme, pointing to Street Atlas 
USA 2005 Plus, and then clicking Tab Manager. 

 

If you use Tab Manager while the program is open, you must exit and restart the program to view 
the tab changes. 

To Show Tabs 
Use the following steps to show tabs in Street Atlas USA 2005 Plus using Tab Manager. 

1. Open Street Atlas USA 2005 Plus. 
2. Click the Help button  on the title bar and select Tab Manager from the Help menu. 

OR 
From the Start menu, point to Programs, point to DeLorme, point to Street Atlas USA 2005 Plus, and 
then click Tab Manager. 

3. Click Tab Manager. The Street Atlas USA 2005 Plus Tab Manager dialog box displays. 
4. Select the check box next to each tab you want to display in the program. 

Note: Click Default to show all of the tabs in the program in the default order (add-on modules excluded). 
5. Exit Street Atlas USA 2005 Plus. 
6. Open Street Atlas USA 2005 Plus. 

To Hide Tabs 
Hiding tabs may significantly increase the startup speed of Street Atlas USA 2005 Plus. 
Use the following steps to hide tabs in Street Atlas USA 2005 Plus using Tab Manager. 

1. Open Street Atlas USA 2005 Plus. 
2. Click the Help button  on the title bar and select Tab Manager from the Help menu. 

OR 
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From the Start menu, point to Programs, point to DeLorme, point to Street Atlas USA 2005 Plus, and 
then click Tab Manager. 

3. Clear the check box next to each tab you want to hide in the program. 
OR 
Click Minimum. Only the required tabs will display in the program. 
Note: Find, Map Files, Info, Map Display, and NetLink are required tabs and cannot be hidden. 

4. Exit Street Atlas USA 2005 Plus. 
5. Open Street Atlas USA 2005 Plus. 

Resizing the Map and Tab Areas 
The Tab and Overview Map windows in Street Atlas USA 2005 Plus default to 20% your computer's screen height. 
These windows can be resized horizontally and vertically (to a maximum of 40% screen height) using the three 
resize buttons, a drag method, or the F11/F10 keys. 

 

• The Tab and Overview Map window size is retained when you choose another tab. 
• If you have selected to show all or most of the tabs in Street Atlas USA 2005 Plus, you will 

need to use the tab scroll buttons to view any tabs that are not currently visible. Tab scroll 
buttons display to the left of the left-most visible tab and to the right of the right-most 
visible tab. The tab scroll buttons are active when additional tabs are available and out of 
view. Hold the active tab scroll buttons to shift the tabs to the right or left. 

• Some tab areas which provide search results automatically resize depending on the number 
of results. 

To Resize the Map and Tab Area Using the Resize Buttons 
There are three Resize toggle buttons, which switch to the opposite function once they are clicked. The following 
table shows each Resize button, provides its name, and describes its function. Each button is immediately followed 
by its toggle opposite. 
 
Button Button Name Button Function 

 Increase to 
Maximum Width 

Maximizes the tab area. All tabs are in view and the information area 
widens. The right and left scroll arrows do not display and the Overview 
Map is very narrow. 

 Decrease to Normal 
Width 

Restores the tab area to its default size. Right/Left scroll arrows and the 
Overview Map display. 

 Decrease to 
Minimum Height 

Displays a minimum view of the tab names. 

 Increase to Normal 
Height 

Increases to the 20% screen height size. 
Note: You can also double-click the horizontal border to increase the 
screen height size to 20%. 

 Increase to 
Maximum Height 

Increases to the 40% screen height size. 

 Decrease to Normal 
Height 

Decreases to the 20% screen height size. 
Note: You can also double-click the horizontal border to decrease the 
screen height size to 20%. 

To Resize the Map and Tab Area Using the Drag Method 
The drag method can be used to resize these areas horizontally or vertically. Use the following steps to resize using 
the drag method. 

1. Point to the frame area between the Tab and Overview Map windows. The pointer becomes a .  
OR 

Point to the horizontal edge of the Tab or Overview Map window. The pointer becomes a . 
2. Drag to resize. 
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3. To cancel the resize while dragging, press the ESC key on your keyboard. The size just prior to this resize 
is restored. 

To Resize the Map and Tab Area Using Function Keys 

Press the F11 key on your keyboard. Your pointer becomes a  and is repositioned to the top of the Tab and 
Overview Map windows, centered over the frame between the two windows. Move your mouse to resize to the 
desired height and width. Click the mouse once when done. 
To return to the default Tab and Overview Map window size, press the F10 key on the keyboard or double-click 
each border. 

 

You can use the arrow keys on the keyboard to resize, after pressing the F11 key on your keyboard. 
When done, press the ENTER key on your keyboard. 

 

Data Zoom Level 
Street Atlas USA 2005 Plus uses data zoom levels between 2-0 (maximum zoom-out) and 17-0 (maximum zoom-in, 
in most instances).  
Data zoom level has to do with the relationship between what you see in a map view and how it exists in reality. It is 
the amount of geographic data displayed on a computer monitor or handheld device screen. The data zoom level is 
similar to the traditional fractional relationship expressed on paper maps (for example, 1:24,000, 1:100,000, 
1:500,000, and so forth). 

To Change the Data Zoom Level Using the Data Zoom Level Tool 

The Data Zoom Level tool is located on the Control Panel, to the right of the map view.  
Click the up arrow to zoom out one minor data zoom level at a time. As you zoom out, you see a larger geographic 
area with less detail.  
Click the down arrow to zoom in one minor data zoom level at a time. You can continue zooming in to the 
maximum data zoom level. 

 
Use the Zoom In 1 tool  and watch as state routes, local roads, smaller towns, lakes and rivers, 
points of interest, and so forth begin to display on the map. 

 

Zooming In and Out 
With Street Atlas USA 2005 Plus, you can use the Zoom tools to quickly change the data zoom level of the map 
view. Increasing the data zoom level number shows a smaller geographic area at greater detail. Decreasing the data 
zoom level number shows a larger geographic area at lesser detail. 

To Zoom In/Out Using the Zoom Tools 
Use the zoom tools shown below to zoom quickly. 

 
Click the Zoom In 1 tool to increase the detail number to the next full level. 
Note: This tool is unavailable at data zoom level 17-0. 

 
Click the Zoom Out 1 tool to decrease the detail number to the next full level. 

 
Click the Zoom Out 3 tool to decrease the detail number by three full levels. 
Note: This tool is unavailable at data zoom level 4-0 or below. 

 

 

You can also change the data zoom level by using any of the following methods: 
• Use the up and down arrows on the Data Zoom Level tool in the Control Panel. 
• Use drag and zoom functionality. Drag down-right on the map to zoom in or up-left to zoom 

out. 
• Press ALT+PAGE UP on your keyboard to zoom out to the next full data zoom level. Press 
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ALT+PAGE DOWN on your keyboard to zoom in to the next full data zoom level. 
• Use the mouse wheel (if available) to zoom the map(s) in and out. Rotate the mouse wheel to 

zoom in by individual data zoom level steps or hold the SHIFT key while rotating the mouse 
wheel to zoom to the next full data zoom level. Make sure that the main map is focused 
either by clicking on it or by pressing the F12 key on the keyboard.  
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Find 
Find Overview 
There are four Find options you can use to search for and locate places and other map items in Street Atlas USA 
2005 Plus: the QuickSearch, POI, Advanced, and GPS Radar functions. 

• QuickSearch—Search for places, addresses, cities/towns, ZIP Codes, and coordinate positions. If the item 
you are looking for is not recognized, the Advanced tab displays automatically. 

• POI—Search for specific points of interest, such as hotels, restaurants, hospitals, department stores, etc. 
Search a specified distance from the current map center or along an active route. 

• Advanced—Control what you are looking for via the Find field, and where you are looking for it via the 
Within field while you conduct a more detailed search. 

• GPS Radar—Search for points of interest (within a designated distance from your current location) while 
tracking a route with a GPS receiver. 

Using QuickSearch 
Use QuickSearch to locate places, addresses, ZIP Codes, and coordinate positions.  

 

• If the item you are looking for is not recognized, the Advanced dialog area displays 
automatically.  

• To search for other items, such as an area code and exchange, street intersection, or a 
category (such as Park, Interstate, and so forth), use the Advanced search capability 
provided in Street Atlas USA 2005 Plus. 

To Search for a Place, Address, ZIP Code, or Coordinate 
Follow the steps below to use QuickSearch. 

1. Click the Find tab and then click QuickSearch. 
2. Type a name, address, ZIP Code, or coordinate in the Search For text box. 

Notes:  
• Do not enter more than five digits for a ZIP Code search. 
• Address searches should be in the following formats: street address, city, state OR street address, 

ZIP Code. 
3. Click Search. If your search is: 

 Very Successful—The results list displays and, if there is one excellent match, the map centers on 
that place and a MapTag displays if the MapTags check box is selected. 
Note: The only time a MapTag is not placed is when you find and then go to a labeled area that 
has no single map point associated with it (for example, a large park).  

 Successful—The results list displays. Scroll (or browse) through the list of search results until you 
find the one you want to locate. To center an item on the map, double-click it or select it and then 
click Go To. A yellow MapTag displays at the location if the MapTags check box is selected. 
Tip: Single click an item in the results list if you want to highlight it on the map without adding a 
MapTag or centering it in the map view. For more information on viewing results, see Tips on 
Viewing Find Results on page 49. 

 Not Successful—The Advanced dialog area displays. Street Atlas USA 2005 Plus makes its best 
guess about the type of search you were trying and your search word(s) display in the upper-right 
text box. Click Search to proceed. For more information, see Using Advanced Search on page 45. 

 

• Use a comma to separate city and state (Atlanta, Georgia or Montreal, Canada), major point 
of interest and state (Space Needle, WA), parts of an address (444 E Pk Drive, Milford, CT 
or 444 E Pk Dr, 06460), or coordinate points (N 43.8, W 70.2). 
Tip: Major landmarks or points of interest such as the Space Needle, Yellowstone National 
Park, Mount Rushmore, and so forth can be found without using the state as part of the 
search criteria. 

• Street addresses and minor points of interest can be found by using the city and state, 
separated by commas, as in the example: 100 Congress St, Portland, ME. 
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• Click the Search For down arrow to view a drop-down list of previously used search words 
and examples. 

• The Search For drop-down list keeps a history of your search words during a session. It 
remembers your five most recently used search words between sessions. If you want to delete 
your search history, select Clear History from the drop-down list. Click No to delete the 
search history in the QuickSearch drop-down list. Click Yes to delete the search history in 
both the QuickSearch and Advanced subtabs. 

 

Using POI Search 
The new, POI subtab gives you an easy way to find the places of interest you are looking for. With the POI subtab, 
you can search over 4 millions places of interest including Wal-Marts, post offices, hospitals, and much more. 

To Find a Point of Interest 
Use the following steps to find a point of interest with the POI subtab. 

1. Click the Find tab. 
2. Click the POI subtab. The POI dialog area displays. 
3. Type the name of the point of interest you are searching for (for example, Wal-Mart or Sheraton) in the 

Name text box. 
4. Type the category that best fits your POI name (for example, type Hotel if you are searching for a Sheraton, 

type Department Store if you are searching for Wal-Mart) in the Keyword text box. 
OR 
Select an appropriate keyword from the Keyword drop-down list. 

5. Select if you want to search from the current map center or along the active route. 
6. Type the distance you want to search for the specified POI. 
7. Click Search. If your search is: 

 Very Successful—The results list displays and, if there is one excellent match, the map centers on 
that place and a yellow box displays at the location of the POI match. 

 Successful—The results list displays. Scroll (or browse) through the list of search results until you 
find the one you want to locate. To center an item on the map, double-click it or select it and then 
click Go To. 
Tip: Single click an item in the results list if you want to highlight it on the map without adding a 
MapTag or centering it in the map view. For more information on viewing results, see Tips on 
Viewing Find Results on page 49. 

MapTags: Moving, Hiding, and Deleting 
When you search for and then go to a place, street address, coordinate, category item, 
or street intersection, a yellow MapTag displays at that location if the MapTags check 
box is selected. If MapTags are cluttering your view of the map, you can move the 
text area of the MapTag, hide them from view, or delete one, several, or all MapTags. 

 

 

 

• The only time a MapTag is not placed is when you find, and then go to, a labeled area that has 
no single map point associated with it (for example, a large park).  

• MapTags are not saved between sessions. 

To Move a MapTag 
A MapTag cannot be detached from its anchor point. Only the text area can be moved. 
Use the following steps to move the MapTag text area. 

1. Using the Find tab, search for a place, street address, coordinate, category item, or street intersection. 
MapTags are placed at each point located on the map. 

2. Click the Select tool . 
Note: The Select tool is available on both the QuickSearch and Advanced dialog areas. 

3. Drag the selected MapTag text area to the desired position on the map. The anchor point does not move. 
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To Hide MapTags 
The MapTags check box  controls the viewing of existing MapTags. 

• MapTags are visible when the MapTags check box is selected. 
• MapTags are hidden from view when the MapTags check box is cleared. Select the MapTags check box at 

any time to display existing MapTags. 

To Delete MapTags 
You can delete one, several, or all MapTags.  

To delete MapTags, click the Find tab and then click the Select tool . 
Note: The Select tool is available on both the QuickSearch and Advanced dialog areas. 

• To delete one MapTag, click the desired MapTag (using the Select tool), and then click the Delete Tag tool 

.  
OR 
Right-click the MapTag you want to delete and then click Delete MapTag. 

• To delete several MapTags, hold down the SHIFT key on your keyboard while clicking the desired 
MapTags, and then click the Delete Tag tool. 
Note: When deleting multiple MapTags, the MapTags are immediately deleted; there is no confirmation 
message.  

• To delete all MapTags, click the Delete Tag tool  (without choosing the Select tool). A message box 
displays "Delete all MapTags?" Click OK to confirm deletion. Click Cancel to retain all MapTags. 

 

Using Advanced Search  
The Advanced search capability in Street Atlas USA 2005 Plus allows you to perform more detailed searches by 
controlling what you are looking for via the Find field and where you are looking for it via the Within field. 

• The fields available for selection under Within vary based on your Find selection.  
• The fill-in fields (located in the center of the tab) vary based on both your Find and Within selections. 

You can also search for more types of items than you can in QuickSearch, such as street intersection, category, and 
area code and exchange. 

To Use Advanced Search 
Follow the steps below to use the advanced search function. 

1. Click the Find tab and then click Advanced. 
Note: This screen displays automatically if you performed an unsuccessful QuickSearch. The search 
feature makes its best guess about the type of search you are attempting and your search words display in 
the appropriate text boxes. 

2. From the Find drop-down list, select the desired Find type from the list.  
• Name 

Use Name to locate a city, town, landmark, object label, and so forth. The closest match is 
displayed first in the Results list. 

• Street Address 
Use Street Address to locate by street name, highway number, and so forth. Accepts standard 
abbreviations such as Rd (Road), St (Street or Saint), Mt (Mount), Dr (Drive), and Ct (Court). The 
closest match is displayed first in the Results list. 

• Street Intersection 
Use this search to locate the intersection of two specified roads. The closest match is displayed 
first in the Results list. 
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• ZIP Code(s) 
Use at least a partial ZIP Code to locate the covered regions. The results are displayed in a browse 
list. This means you are taken into the ZIP Code database at the closest matching, valid ZIP Code. 
You can browse through results in either direction to the first (or last) item in the database. 

• Name and Category 
Searches for a specific name in a specific category. For example, if you want to find a particular 
restaurant in your town, you would type restaurant in the Keywords text box, type the name of 
the restaurant in the Name text box, and then type your location information in the available text 
boxes. For more information on category searches, see Keywords for Category Searches on page 
47. 
Note: Category keywords must be at least three characters in length. 

• Category 
Searches for a category of items within the specified area.  
Notes:  

• In all category searches, the Keywords field is optional. If the Keywords field is left 
blank, all objects in the selected Within area display in the Results list. 

• Category keywords must be at least three characters in length. 

• Area Code and Exchange 
There are no Within options for Area Code and Exchange search. Use at least a partial Area Code 
and Exchange to locate the covered regions. (This is not an individual phone search.)  
The results are displayed in a browse list. This means you are taken into the Area Code database at 
the closest matching, valid Area Code. You can browse through results in either direction to the 
first (or last) item in the database. 

• Latitude/Longitude 
A single result is returned using a latitude/longitude coordinate search. There are no Within 
options. Coordinates must be in one of the many formats recognized by the program.  

3. From the Within drop-down list, select the desired Within field. Available choices are based on what you 
selected as your Find type. 

• World 
Searches for the specified major name within the United States and Canada. Type the name in the 
Name text box, select a state (if applicable) from the State drop-down list, and select a country 
from the Country drop-down list. Results are listed alphabetically and browsing is available. 
The World field can also be used for ZIP Code(s) searches. 

• City or County 
Searches for the specified name within the ZIP Codes associated with the city/county and state 
specified in the text boxes.  

• ZIP Code 
Searches for the specified name within a ZIP Code. Displays a ZIP Code text field. A search for a 
ZIP+4 Code is treated the same as a five-digit ZIP Code. 

• Current Map City 
Searches for the specified name, within the boundaries of all ZIP Codes associated with the city at 
the current map center. 

• Current Map Rectangle 

Searches for the specified location within the currently visible map area. 
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• Distance from Map Center 
Performs a search in all directions from the center of the map using the specified distance. Also 
called a radius search. The minimum distance which can be used is 50 feet; the maximum distance 
is 100 miles. 

• Current Route 
Searches for objects within the specified distance from your currently active, calculated route. The 
minimum distance which can be used is 500 feet; the maximum distance is 10 miles. Results are 
listed in the sequence they occur along the route, from start point to finish point. 
Note: This search may take longer than other types of searches. 

4. Type information in the text boxes to the right of the Find and Within fields. The text boxes available are 
based on the selected Find and Within fields. 
Tip: A few text boxes are optional and you may get more results by leaving them blank. To see if a text 
box is optional, hold your cursor over the text box label or down arrow and read the ToolTip for that text 
box. 

5. Click Search or press the ENTER key on your keyboard. The Results list displays your search results with 
closest match items at the top of the list. 

6. Scroll (or browse) through the list of search results for your search until you find the one you want to 
locate. To center an item on the map, select it and then click Go To or double-click it. A yellow MapTag 
displays at the location if the MapTags check box is selected. 
Tip: Single click an item in the results list if you want to highlight it on the map without adding a MapTag 
or centering it in the map view. For more information on viewing results, see Tips on Viewing Find Results 
on page 49. 

 

Street Atlas USA 2005 Plus keeps a history of your search words during a session. If you want to 
delete your Advanced search history, click the QuickSearch subtab and select Clear History from the 
Search For drop-down list. Then, click Yes to delete the search history in both the QuickSearch and 
Advanced subtabs. 

 

Keywords for Category Searches 
Street Atlas USA 2005 Plus recognizes hundreds of English words to generate both general and specific searches 
using category keywords.  

Keyword Samples 
The list below are categories which expand to reveal sample keywords. Sample keywords may be listed in more than 
one category for your convenience.  
Boundaries, Map, and Surveying 
Border 
Boundary 
Contour 
Crosshair 
Grid 
Line 
Point 
ZIP Code 

Buildings and Structures 
Airport 
Bridge 
Business 
Landmark 
Library 

Education and Cultural 
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College 
Local Park 
Park 
School 
State Park 
University 

Natural Features 
Beach 
Canyon 
Crater 
Desert 
Forest 
Glacier 
Hill 
Island 
Mountain 
River 
Stream 
Valley 
Water 

Miscellaneous 
Cemetery 
Hiking 
Mine 
Note 
Park 

Object Types 
All of the stock draw symbols (such as blue map pin, red flag, canoe, etc.) 
Draw symbols 

Roads and Trails 
Bridge 
Exit 
Ferry 
Foot Trail 
Highway 
Hiking 
Interstate 
One Way 
Railroad 
Road 
Street 
Trail 
Tunnel 

Travel Amenities 
Airport 
Exit 
Landmark 
Rest Area 
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Notes on Category Searches 
The following list provides notes you may find helpful for performing category searches. 

• Category keyword searches must be at least three characters in length. 
• The Keywords field is optional in all Category searches and if left blank, all objects in the Within area 

display in the Results list. 
• Keywords are not case-sensitive. Using all capital letters or no capital letters does not affect the search. 
• Some generic keywords (water, for example) match many categories and display a dialog box with specific 

categories. Select or clear these categories, depending on what you want to locate. 
• In the Keyword Category Samples below, some keywords are used together. This narrows the search. The 

following two examples provide information on how results may differ using words together and 
separately: 

• Example 1—Using Local Road provides six category results, such as Ferry Crossing Local Road, 
Local or Rural Road (four separate categories), and Railroad Local Line. 

• Example 2—Using Road provides over 100 results from more categories. 
• Partial words are recognized when performing a search.  
• Keywords can be used in any order. You get the same results using Local Road as for Road Local. 
• A keyword may find categories related to the word rather than including the word. For example, a keyword 

such as Refrigerator might find the category Appliances. 
Note: This search may not be valid for this product, but serves as an example. 

• Use the word "or" in the Keywords text box to search for multiple categories. For example, type American 
or Italian to search for either type of restaurant. 

 

Tips on Viewing Find Results 
The Results list displays your results in the QuickSearch or Advanced dialog area after performing a successful 
search in the Find tab. 
The following list provides tips on viewing results. 

• To make it easier to view a long list of search results, click the Increase to Maximum Height button  in 
the upper-right corner of the tab area. 

• To sort results by another column, click the desired column header. An asterisk (*) identifies the sort 
column. Click a second time to reverse the sort order. 
Note: This feature is not available when in browse mode (see last item in this list). 

• To copy the information for the selected item(s), press CTRL+C on your keyboard. You can then paste the 
text into another program, such as a word processing program. 

• Right-click an item in the results list. A shortcut menu displays the following items: 
 Copy to Clipboard—Copies the detailed information for the selected item(s) and is available for 

pasting into another program. 
 Go To—Centers the map on the selected item. 
 Select All—Selects all items in the list and highlights them on the map (up to 350). The Go To 

button name switches to Add Tags. Click Add Tags to add MapTags to all selected items. Or, if 
you right-click again (with all items selected), you can select Copy to Clipboard or Add (to add a 
MapTag, MapNote, or Detailed MapNote). 

 Add—Select to add a MapNote or Detailed MapNote to the selected item(s). 
 Route—Places a start, stop, or finish point at that location on the map (based on your selection). 

The location is then listed in the Start text box, Stop text box, or Finish text box in the Route tab. 
• To locate an item on the map without moving the map, single click an item in the results list. It is 

highlighted on the map, as long as it is in the current map view. This is especially helpful when you are at 
the data zoom level you want but point labels are not displaying. 
Notes:  

 Panning the map or clicking another tab removes the highlights. 
 To select multiple items, press and hold the CTRL key while clicking the desired items (up to 350) 

in the results list. If the items are listed continuously, click the first item in the list and then press 
and hold the SHIFT key while clicking the last item you want. 
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• Column widths can be adjusted. The new size is retained until changed again. The column order cannot be 
rearranged. Different search types result in different column orders. 

• There are two types of results lists: 
 Most searches provide a fixed number of results. If all of the results do not 

fit in the screen area, a scroll bar automatically displays. 
 Name in ZIP Code searches, Name in World searches, and Area 

Code/Exchange searches provide results you can browse. This means the 
entire (appropriate) database displays with the best match highlighted. It is 
possible to continue browsing to the first (or last) item in the database. 

Scroll 
Bar 

 

Browse 
Buttons 

 

Finding Points of Interest (POIs) Near Your Current Location 
The Find tab's GPS Radar subtab allows you to search for points of interest (such as gas stations, restaurants, 
accommodations, exit services, etc.) near your current location (if tracking with a GPS) or near the center of the 
map. You can even hear the nearest search result by enabling the speech button. Once you have found the desired 
point of interest, you can use the GPS Radar subtab to recenter the map on the route to that point of interest and get 
directions to that POI. 

 

• A GPS Radar search finds items that are the shortest driving distance from your current 
location (within just a few miles). Unless you select the Only in Direction of Travel check 
box, some of the search results may be behind you. Since the actual route is calculated, the 
fastest destination for you to drive to is listed first. If you are on a one-way road or freeway, 
GPS Radar takes into account the fact that you need to drive further to get off at an exit. You 
can click each item in the result list to see each option, to highlight the route to each 
destination, and to see a description of each one as well as driving directions. This should help 
you choose the best one for your needs. 

• The time required for a GPS Radar search varies by the distance, density of objects in the area, 
the categories chosen, and whether you are searching only in the direction of travel. You can 
interrupt a GPS Radar search to see a listing of the nearby POIs, but driving directions will not 
be provided.  

To Find POIs Near Your Location 
Use the following steps to find POIs near your locations. 

1. Click the Find tab. The Find dialog area displays. 
2. If you are not tracking with a GPS, type a specified location in the Search For text box and click Search. 
3. Click the GPS Radar subtab. The GPS Radar dialog area displays. 
4. Under Search For, select the point of interest you want to locate within the specified area. 

Note: If you select Custom, you will be asked to enter keywords for the category you are searching for. 
You can perform a specific keyword search (such as bowling or hospital) or a broad keyword search (such 
as businesses, schools, religious institutions, government facilities, military bases, airports, parks, exits, and 
rest areas). 

5. Select the Only in Direction of Travel check box if you do not want GPS Radar to search for points of 
interest that are outside of your direction of travel (for example, points of interest that are behind you). 

6. Verify the speech icon  is enabled if you want to hear the nearest search result. 
7. If you want to repeat your search after a designated amount of time, select the Repeat Search Every check 

box and then select a number for the minute(s) you want Street Atlas USA 2005 Plus to repeat the search 
automatically. 

8. Select a distance (in miles) from the Search Area scroll list to limit your search to a certain driving distance 
from your current location.  

9. Click Search. The search results display in the list box to the right of the Search button. 
10. Click a search result to select it. A yellow, highlighted line displays on the map between your 

current/specified location and the point of interest's location. 
Note: Click Recenter to recenter the map on the selected POI route. Click Insert Stop to insert the selected 
search result into your current route.  
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11. Select Info to view the point of interest's name, category, phone number, and distance from the current 
location. 
OR 
Select Directions to view directions to the selected point of interest from your current/specified location. 
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Phone 
Phone Overview 

 

The Phone tab in Street Atlas USA 2005 Plus comes with over 31 million FREE business phone 
listings. To use the residential search capabilities in the tab, you must purchase DeLorme Phone 
Data. For information on purchasing DeLorme Phone Data, click NetLink, visit www.delorme.com, 
or call Direct Sales at 800-561-5105. 

The Phone tab in Street Atlas USA 2005 Plus allows you to search for residential and/or business phone book 
listings. With the Phone tab in Street Atlas USA 2005 Plus, you can find name, address, and/or phone book listing 
information for a specified data region. You can locate your selections on the map, save them as a text file, or save 
them as an XData database. 
The table below lists each of the text boxes found in the Phone tab and tips for performing successful searches. 
Text Box Tip 
Name Name searches do not require punctuation. 

Type the last name first. 
The Phone tab recognizes partial names. You may get better results (for longer names or 
if you are unsure of the spelling) if you only type a portion of the name. 
Many business names are abbreviated in phone book listings. For best results, try 
additional searches using alternate spellings or abbreviations. 

Street Address Street name descriptors (e.g., street, road, drive) should not be used for address searches. 
However, street name abbreviations (e.g., st, rd, dr) may be used. 

City Long city names may be abbreviated in the Phone data. Try shortening the city name 
until the search finds the city name you recognize, then use that abbreviation. 
City listings may have variances in spelling, such as "Saint Louis" rather than St Louis". 

ZIP Code ZIP Code searches must contain from three to five digits. 
Phone Phone number searches are performed by entering at least three digits (the area code). 
YP (Yellow Pages) Yellow page searches should be singular (for example, type restaurant instead of 

restaurants). 
If you use multiple words, all of the words are required to form a match.  
There are over 34,000 yellow page headings possible. Use keywords you would expect 
to find in the yellow pages. 
Yellow page searches must be at least three characters in length. 

 

Synchronizing Phone Data with the Phone Tab 
If you did not install Phone Data to your hard drive using the installation disc, you will need to synchronize the data 
with the application using the steps below. 

 

The Phone tab in Street Atlas USA 2005 Plus comes with over 31 million FREE business phone 
listings. To use the residential search capabilities in the tab, you must purchase DeLorme Phone 
Data. For information on purchasing DeLorme Phone Data, click NetLink, visit www.delorme.com, 
or call Direct Sales at 800-561-5105. 

To Synchronize Phone Data with the Phone Tab 
Use the following steps to run DeLorme Phone Data from your DVD-ROM drive. 

1. If you are using the FREE business phone listings that came with the product, insert the Street Atlas USA 
2005 installation disc into the DVD-ROM drive. 
OR 
If you are using DeLorme Phone Data, insert the Phone Data disc into your DVD-ROM drive. 

2. Open Street Atlas USA 2005 Plus. 
3. Click the Phone tab. 
4. Click Data. The Browse for Folder dialog box displays. 
5. Browse to your DVD-ROM drive. Click the Phone folder. 
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6. Click OK. The states on the disc in your DVD-ROM drive are available in the State drop-down list in the 
Phone tab. 

Searching for a Phone Book Listing 

 

The Phone tab in Street Atlas USA 2005 Plus comes with over 31 million FREE business phone 
listings. To use the residential search capabilities in the tab, you must purchase DeLorme Phone 
Data. For information on purchasing DeLorme Phone Data, click NetLink, visit www.delorme.com, 
or call Direct Sales at 800-561-5105. 

With the Phone tab in Street Atlas USA 2005 Plus, you can search for a name and address based on a given phone 
number or search for a phone number based upon a specified name and/or address. You can pick and choose your 
selections to add to map, make a dataset, and so forth. 

 

• "Unlisted" phone numbers allow customers to request their phone number be available 
from directory assistance but not published in the phone directories. Customers paying for 
"non-published" service desire complete privacy of their phone number, which means it is 
not published in the phone book and is unavailable from directory assistance. Non-
published numbers are not available in Phone Data. 

• A hyphen (-) before the name in a search result indicates a business listing. 
• An asterisk (*) before the name in a search result indicates the person or business listed has 

registered a preference not to be solicited by telephone (as provided by law). 
• Click Clear at any time to remove all of your search criteria from the Phone text boxes. 
• Select the Any State option to include all states in your search or if you do not know the 

state for your query. 

To Search for a Phone Book Listing 
Use the following steps to search for a phone book listing. 

1. If you have not installed the phone data to your hard disk drive, synchronize the data with the Phone tab. 
2. Click the Phone tab to display the Phone dialog area. 
3. Select the Residential check box to view residential phone book listings. 

AND/OR 
Select the Business check box to view business phone book listings. 

4. Type the name, street address, city, state, and/or ZIP Code to search for the phone number(s) associated 
with that information.  
Note: If you are using Street Atlas USA 2005 Plus with DVD data, a ZIP Code, city/state, or partial phone 
number must be provided in your search. 
OR 
Type the phone number to search for the name, address, city, state, and ZIP Code associated with that 
phone number. 
OR 
Type yellow page keywords in the YP text box to find all of the phone book listings available based on 
your search criteria. If you are using Street Atlas USA 2005 Plus with DVD data, a ZIP Code, city/state, or 
partial phone number must be provided in your search.  
Notes:  
Type a city in the City text box to narrow your yellow page search. Do not enter more than five digits for a 
ZIP Code search. 
Yellow page keywords must be at least three characters in length. 

5. Press the ENTER key on your keyboard or click Search. The search results display in the Search Results 
area on the lower-left corner of the dialog area. Reminder: Unless you have connected DeLorme Phone 
Data to the Phone tab, only business listings will be provided. 
Notes:  
If you do not receive any results from your yellow page search, use an alternative keyword for your search 
attempt. For example, if you are looking for a clothing store, type “clothing” instead of “clothes.” Or, if the 
alternative keyword still does not work, search (by name) for a clothing store and see what category it is 
listed under (the category displays in parenthesis at the end of the result). 
If more than 1000 search results match your search criteria, the More button becomes activated. Click 
More to browse to the next 1000 search results. 
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6. Click one or more search results in the Search Results area and then click Add (or right-click on the search 
results and select Add from the shortcut menu) to add your search result to the Selection area on the lower-
right corner of the dialog area.  
Note: Press the CTRL key on your keyboard to select more than one search result at a time. You can also 
double-click a search result to add it to the Selections area. 
OR 
Click Add All (or right-click on the search results and select Add All from the shortcut menu) to include 
all of your search results to the Selection area. 
Note: The Selection area has a 1000 listing limit (as described in the Street Atlas USA 2005 Plus license 
agreement). 
OR 
Click Clear All (or right-click on the search results and select Clear All from the shortcut menu) to remove 
all of the search results from the Selections area. 

7. Use one of the following options to modify the selections in the Selections area: 
• Click Map (or right-click on your selections and select Map from the shortcut menu) to add your 

phone book listings to the map. You can add all of the phone book listings in the Selections area to 
the map by right-clicking on the selections, selecting Select All from the shortcut menu, and then 
clicking Map. Once a phone selection is on the map, you can view details about the listing by 
right-click its symbol and selecting Info from the shortcut menu. 
Note: Mapped businesses are indicated with a square symbol on the map and mapped residences 
are indicated with a small house symbol on the map. Phone selections (symbol and label) that are 
placed on the map will appear in red if they have been located reliably to a street address. 
Otherwise, the approximate location appears light gray on the map. 

• Click a listing in the Selections area and click Remove (or right-click a listing and select Remove 
from the shortcut menu) to remove the phone book listing from your list of selections. 

• Click Remove All (or right-click on your selections and select Remove All from the shortcut 
menu) to remove all of the phone book listings from the Selection area. All mapped selections will 
be removed from the map. 

• Click To File to save all of the phone book listings in the Selections area in a .txt file. The default 
location for the file is C:\DeLorme Docs\Datasets.  

• Click To XData to copy all of the phone book listings in the Selections area to the XData tab as a 
dataset (using the Import Wizard). 

• Click a previously mapped listing in the Selections area to highlight it on the map.  
• Double-click a listing in the Selections area to center the map on that listing. 

 

You can also copy, search, and sort search results and selections using right-click mouse options. 

 

Finding Phone Book Listings for a Specific Road 

 

The Phone tab in Street Atlas USA 2005 Plus comes with over 31 million FREE business phone 
listings. To use the residential search capabilities in the tab, you must purchase DeLorme Phone 
Data. For information on purchasing DeLorme Phone Data, click NetLink, visit www.delorme.com, 
or call Direct Sales at 800-561-5105. 

 
With Street Atlas USA 2005 Plus, you can right-click a road to view all of the residential and business phone book 
listings on that road. 

 

• "Unlisted" phone numbers allow customers to request their phone number be available from 
directory assistance but not published in the phone directories. Customers paying for "non-
published" service desire complete privacy of their phone number, which means it is not 
published in the phone book and is unavailable from directory assistance. Non-published 
numbers are not available in Phone Data. 

• A hyphen (-) before the name in a search result indicates a business listing. 
• An asterisk (*) before the name in a search result indicates the person or business listed has 
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registered a preference not to be solicited by telephone (as provided by law). 

To Find Phone Information for a Specific Road 
Use the following steps to find available phone information for a specific road. 

1. If you have not installed the phone data to your hard disk drive, synchronize the data with the Phone tab.  
2. To find phone information along the same road as another phone book listing: Search for a phone book 

listing. Right-click a search result and select Search This Address from the shortcut menu. All of the 
phone listings for that road display. 
OR 
To find phone information using the map: Pan the map or click the Find tab and use the QuickSearch 
function to locate the road you want to use for your phone book listing search. Then, right-click the road 
and select Phone Listings from the shortcut menu. All the phone book listings for that road (in that city) 
display in the Search Results area on the lower-right corner of the dialog area. 
Notes: If more than 1000 search results match your search criteria, the More button becomes activated. 
Click More to browse to the next 1000 search results. 

3. Click one or more search results in the Search Results area and then click Add (or right-click on the search 
results and select Add from the shortcut menu) to add your search result to the Selection area on the lower-
right corner of the dialog area.  
Note: Press the CTRL key on your keyboard to select more than one search result at a time. You can also 
double-click a search result to add it to the Selections area. 
OR 
Click Add All (or right-click on the search results and select Add All from the shortcut menu) to include 
all of your search results to the Selection area. 
Note: The Selection area has a 1000 listing limit (as described in the Street Atlas USA 2005 Plus license 
agreement). 
OR 
Click Clear All (or right-click on the search results and select Clear All from the shortcut menu) to remove 
all of the search results from the Selection area. 

4. Use one of the following options to modify the selections in the Selections area: 
• Click Map (or right-click on your selections and select Map from the shortcut menu) to add your 

phone book listings to the map. If only one item is selected, the map centers on the object. You 
can add all of the phone book listings in the Selections area to the map by right-clicking on the 
selections, selecting Select All from the shortcut menu, and then clicking Map. Once a phone 
selection is on the map, you can view details about the listing by right-click its symbol and 
selecting Info from the shortcut menu. 
Note: Mapped businesses are indicated with a square symbol on the map and mapped residences 
are indicated with a small house symbol on the map. Phone selections (symbol and label) that are 
placed on the map will appear in red if they have been located reliably to a street address. 
Otherwise, the approximate location appears light gray on the map. 

• Click a listing in the Selections area and click Remove (or right-click a listing and select Remove 
from the shortcut menu) to remove the phone book listing from your list of selections. 

• Click Remove All (or right-click on your selections and select Remove All from the shortcut 
menu) to remove all of the phone book listings from the Selection area. All mapped selections will 
be removed from the map. 

• Click To File to save all of the phone book listings in the Selections area in a .txt file. The default 
location for the file is C:\DeLorme Docs\Datasets.  

• Click To XData to copy all of the phone book listings in the Selections area to the XData tab as a 
dataset (using the Import Wizard). 

• Click a previously mapped listing in the Selections area to highlight it on the map.  
• Double-click a listing in the Selections area to center the map on that listing. 
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XData 
XData Overview 
Street Atlas USA® 2005 Plus lets you import your data so you can view the location of each record on detailed maps. 
In order to geoplace (locate) your records on the map, the data file must contain either a coordinate (in decimal 
degrees), a city and state, a ZIP Code, or a complete physical address (street address, city, state) for each record. 
Whatever your business needs, Street Atlas USA 2005 Plus gives you powerful database management tools to help 
you plan accordingly.  

With Street Atlas USA 2005 Plus you can: 
• Import most database, spreadsheet, and text file formats for use within the program. 
• Select symbols (or design your own) to represent the location(s) of your record(s). 
• Display or hide databases so you can use them one at a time or together. You can also use your data with 

other program functions. 
• Customize an existing dataset and then save the new dataset by using the Export function. 
• Create a route using your XData records as a start, stop, and/or finish point. 

 

• Supported file formats include: 
• Microsoft Access (.mdb, .mdw, and .mda) 
• Microsoft Excel (.xls) 
• Microsoft Visual FoxPro (.dbf) 
• dBase (.dbf) 
• Text files (.txt, .csv, .tab, and .asc) 

• XData labels, names, and URLs cannot be more than 255 characters. 

Importing Data 
Street Atlas USA® 2005 Plus lets you import your own data and view the location of each record on detailed maps. 
To be able to locate (or geoplace) your records on the map, the file must contain either a coordinate, a ZIP Code, or 
a complete physical address (street address, city, state) for each record.   

 

Supported file formats include Microsoft Access (.mdb, .mdw, and .mda), Microsoft Excel (.xls), 
Microsoft Visual FoxPro (.dbf), dBase (.dbf), and text files (.txt, .csv, .tab, and .asc).  

To Import a Database 
Use the following steps to import a database into the current Map File. 

1. Click the XData tab to open the XData dialog area. Any dataset(s) included in the current Map File 
display(s) under Available Datasets. 
Note: A check mark in a check box indicates that the dataset is being displayed on the map. Clear the check 
box to hide the dataset's symbols on the map. 

2. Click Import to open the Import Wizard. 
3. On the Select Data Source screen, click Data Source to locate and select the desired file from the Open 

dialog box and then click Next. 
Note: If your file is not available in the directory as expected, you may need to change the file type in the 
Files of Type drop-down list. 

4. If your data source is a .csv or .txt file, complete this step. If not, proceed to step 5.  
The Select Schema screen displays. Verify how the data displays in the columns. If it is not displaying 
correctly, under Schema Type, select the option which separates your data into the appropriate columns. If 
your first row is not a header row, clear the First Row is Header check box. Click Next. The Assign Field 
Types screen displays 

Notes: 
• Select Other under Schema Type to use a non-standard file schema definition. You can then 

select any combination of Tab, Space, Comma, and Other. If you select Other under 
Delimiter, type the character(s) that separate your data in the text entry box. 
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• The First Row is Header check box is selected by default. The program attempts to 
automatically assign field names based on the data in the first row. 

5. Select which column you want to display as a label on the map using the available radio buttons. 
Note: You can clear a selection to have no label displayed on the map. 

6. Click the Assignment header for each column and select the appropriate field option from the shortcut 
menu. The Status text box indicates how your data will be geoplaced on the map. 

7. Select how you want to locate your field information (street address or ZIP Code). 
Note: The available Locate By options are based on which fields have been assigned to the columns.  

8. Click Next. The Select Data Symbol screen displays. 
9. Under Match Status, click Exact, Street Name, Area, or ZIP Center and then select the unique symbol 

and text properties you want to display for each match status. Assigning different symbols/text to your 
records based on match status shows a visual representation on the map of which records in your dataset 
were geoplaced exactly, only by street name, only by area, or only by ZIP Center. 
OR 
Under Match Status, select the Use the same symbol/text for all categories check box to identify all of 
your records on the map using the same symbol (without taking match status into consideration). 
Note: Click Edit to use XSym to create a new symbol or edit an existing symbol.  

10. Click Next. The Data Options screen displays. 
11. Type the desired name for the dataset along with any additional identifying comments. The date and time 

of creation are automatically recorded.  
12. Click Finish. A progress bar displays with the status of matched records. When the import process is 

complete, the dialog box automatically closes, the dataset name displays in the Available Datasets list, and 
the symbol you chose displays on the map for every record which was geolocated. 
Note: Datasets have .dds extensions and are saved to C:\DeLorme Docs\Datasets by default. 

 

If you decide to interrupt the import process, you can finish importing the dataset later by selecting the 
dataset from the Available Datasets list in the XData tab and then click Resume. 

Managing Datasets 
Street Atlas USA® 2005 Plus lets you manage your dataset after you have imported/copied it as a dataset. 

To Manage Your Datasets 
Use the following steps to manage your datasets. 

1. Click the XData tab to open the XData dialog box. A list of the datasets available in the current Map File 
displays in the Available Datasets window.  
Note: A check mark in a check box indicates that the dataset is being displayed on the map. Clear the check 
box to hide the dataset's symbols on the map. 

2. Click a dataset to select it and then click the Query subtab. You can then: 
• Edit a record in the dataset by double-clicking inside the cell you want to edit or by right-clicking 

the record (in the Query subtab) and selecting Edit from the shortcut menu.  
• Press the TAB key on your keyboard to advance through the cells in the record. When you are 

finished editing the record, press the ENTER key on your keyboard. 
• Create a route using a record in the dataset by right-clicking the record you want to use as your 

start, stop, or finish route point, clicking Route, and then clicking the desired route option. 
• Add a blank record to the end of the records list by clicking Add. 
• Duplicate a record in the dataset by right-clicking the record and selecting Duplicate Record(s). 

Duplicates of the records will be available at the bottom of the record list. 
• Delete a record in the dataset by selecting the record and clicking Delete or by right-clicking the 

record and selecting Delete Record(s). 
• Update the symbols in the selected dataset by clicking Symbolize and updating the symbol 

properties. 
• Center the map on the selected dataset by double-clicking it or clicking Go To. The map view 

changes to encompass all of the geoplaced records within that dataset. 
Note: To re-geoplace those records, click GeoCode or right-click the records and select GeoCode 
Record(s). 
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• Center the map on a particular record by double-clicking the first column of the desired record or 
by selecting the record and clicking Go To. 

• Delete the selected dataset by clicking Delete. The dataset is deleted from the map, the current 
Map File, and from your computer. 

• View the records within the selected dataset by clicking Query.  

Viewing Dataset Records 
After you have imported your data as a Street Atlas USA® 2005 Plus dataset, you can view information about the 
dataset, view the data records within a dataset, and select a specific record and view its symbol on the map.  

To View Records 
Follow the steps below to view records within a particular dataset. 

1. Click the XData tab to open the XData dialog area. A list of the datasets available in the current Map File 
is displayed in the Available Datasets window.  
Note: A check mark in a check box indicates that the dataset is being displayed on the map. Clear the check 
box to hide the dataset's symbols on the map. 

2. Click a dataset to select it. The name, date, and time that the dataset was created display in the Dataset 
Statistics window. Any additional comments that you added during the import process also display here. 

3. Click Query to open the Query dialog area. The records for the selected dataset display in the records 
window. You can then: 

• View a dataset other than the one currently selected by selecting the desired dataset from the Use 
Dataset drop-down list. The records contained within the dataset display in the table below. The 
Located To column indicates how each record was geoplaced on the map (by Address, ZIP Code, 
Street, Coordinate). 
Note: Click the Expand to Maximum Height button  in the upper-right corner of the dialog 
area to expand the table.  

• Limit which records of the dataset are displayed in the table by selecting one of the options from 
the Table Display drop-down list. Some of the Table Display options provide additional drop-
down lists to choose a more limited query (for example, selecting the Records by Placement 
option provides an additional drop-down list of options so you can choose to display only those 
records placed to specific addresses, only those records placed manually, and so forth). 

Additional Viewing Tips 
The following list provides information on how to view records or obtain information about the dataset symbols on 
the map while in the Query dialog area. 

• To select records and view the corresponding symbol on the map: 
 To select one record, click the desired record. 
 To select multiple records individually, press the CTRL key on your keyboard while clicking each 

of the individual records.  
 To select a block of records, press the SHIFT key while clicking the record at the beginning of the 

block, and then click the record at the end of the block. All of the records are selected. 
• To center the map on the selected record(s), click Go To. 

Note: To re-geoplace records, click GeoCode. 
• To delete (a) record(s) within the dataset, while in the Query dialog area select the record(s) using one of 

the methods described above and then click Delete. Click Yes to confirm the deletion. Deleted records are 
unrecoverable. 

• To view the record of a particular dataset symbol on the map, click Select and then click the desired 
symbol on the map. Only the corresponding records display in the record window. 

• To resize columns, place the pointer near the column border in the header of the desired column. When the 
pointer changes to a double arrow, drag the column in the desired direction to increase or decrease its size.  

• To arrange the records in ascending order according to a particular column, click the header of that column. 
Click the column header again to arrange the records in descending order.  
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Creating a Route with XData Records 
Once you have imported an XData dataset into Street Atlas USA 2005 Plus, you can use the individual records 
within the dataset to create a route. 

To Create a Route with XData Records 
Use the following steps to create a route with XData records. 

1. Import a Database into the XData tab. 
2. Click the Query subtab. 
3. Right-click the record you want to use as a start for your route, click Route, and then click Set as Start. 
4. Optional: Right-click the record you want to use as a stop in your route, click Route, and then click Insert 

as Stop. 
5. Right-click the record you want to use as a finish in your route, click Route, and then click Set as Finish. 

Geocoding or Moving a Record's Location 
Street Atlas USA® 2005 Plus geocodes all the records it can during the import process. This means it places the 
symbol for the record on specific map coordinates (based on address or coordinate information). Once you have 
imported your data, you may want to make changes to the data and manually geocode the record(s) to the new 
location(s). How an item has been located displays in the Located To column of the dataset's records. 

To Move a Record's Location 
Use the following steps to move a record's location. 

1. Click the XData tab. The XData dialog area displays. 
2. Click Query. 
3. Select the dataset you want to view from the Use Dataset drop-down list. 
4. Select Records by Placement from the Table Display drop-down list. 
5. Select All Placed Records from the Record Placement drop-down list. 
6. Scroll right to the Located To column and view how each record in the dataset was placed. Any item listed 

as Not Placed or ZIP Code can be geocoded manually. 
7. Select the record you want to move. 
8. To manually place a record that has not been placed on the map, drag the record from the table to the 

desired location on the map. The Located To field for that record now reads as Manual Placement. 
OR 
Click GeoCode to regeocode a record. 
OR 
Right-click the record(s) and then click GeoCode Record(s). 

Exporting Data 
Street Atlas USA® 2005 Plus lets you to export datasets to another dataset or a text file. It is important to export 
datasets because: 

• If you have modified a dataset after you have imported it, you may want to save the new dataset for use in 
Street Atlas USA 2005 Plus (as a dataset) or as a text file. 

• If you have exported a copied dataset (resulting from conducting a phone book listing search) and then used 
the To XData function within the Phone tab, you can modify and export it to a new dataset or export it as a 
text file. 

To Export Data 
Use the following steps to export data. 

1. Click the XData tab to open the XData dialog area. 
2. Click Query to open the Query dialog box. 
3. Select a dataset from the Use Dataset drop-down list. The records contained within the dataset display in 

the records window. 
4. To limit which records of the dataset are available for export, you can: 

Select one of the options from the Table Display drop-down list. 
OR 
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Select records manually from the existing dataset. To select multiple records individually, press the CTRL 
key on your keyboard while clicking each of the desired records. To select a block of records, press the 
SHIFT key while clicking the record at the beginning of the block, and then click the record at the end of 
the block; all of the records between the two you clicked are now selected. 

5. Click Export. The Export dialog area displays. 
6. Under Export Options, select one of the following options: 

 Export to New Dataset—Exports the file as a .dds file for use within Street Atlas USA 2005 Plus 
as another dataset. 

 Export to Text File—Exports the file as a .txt file for use in other programs. 
7. Under Records to Export, select one of the following options. 

 Entire Dataset—Exports all records in the selected dataset, including records that have not been 
placed. 

 Records in List (#)—Exports the records currently displaying in the Query table. The number of 
records is in parentheses. This may be a subset of the dataset, if you selected one of the Table 
Display options from the drop-down list in the Query dialog area. 

 Only Selected (#)—Exports only those records currently selected in the Query table. The number 
of records is in parentheses. These are the records you selected manually. 

8. To export your dataset as another dataset, click Create Dataset and follow the instructions provided to 
select a data symbol for each match status, type a dataset name, and select the map display option(s). Click 
Finish when prompted. Exported files are available immediately in the Available Datasets list in the 
Datasets dialog area of the XData tab. These files have .dds extensions and are saved in the C:\DeLorme 
Docs\Datasets directory by default.  
OR 
To export your dataset as a text file, make sure the Export to Text File option is selected. Type the desired 
file name in the File text box and click Save. Exported files have a .txt extension and are saved in the 
C:\DeLorme Docs\Datasets directory by default. 
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Print 
Print Overview 
Street Atlas USA 2005 Plus lets you perform the following functions: 

• Print single and multi-page maps. 
• Assemble large, multi-page maps as large as 3 (pages) x 3 (pages). 
• Print your routes and/or route directions. 
• Save your map as a bitmap or JPEG image. 
• Save your route directions as a text file. 
• Add text and/or graphics on your map. 
• Align, snap, or layer text and/or graphic items on your map. 
• Copy a map to the clipboard. 
• E-mail the print area and/or route directions to a friend. 

 

• You can print maps from Street Atlas USA 2005 Plus through any Windows-compatible printer 
driver. Strange characters or incomplete output are usually the result of an incompatible, 
outdated, or improperly configured printer driver. There are also differences between black-and-
white and color printers. 

• Before printing, click the Print tab to open the Print dialog area and then click the Setup button 

. If the options are available, set the graphics mode to use raster graphics and set TrueType 
fonts to print as graphics. Consult your printer manual for additional information. 

• Printouts from Street Atlas USA 2005 Plus contain complex graphic images and it may take 
several minutes to print each page. After clicking Print, the program gives you the option to 
cancel while it is processing the map area. 

Printing a Map 
Street Atlas USA 2005 Plus lets you print a map based on your paper size or screen size. If you choose to print a 
map based your paper size, you can also print a multipage map which can be assembled using the Manually 
Assembling a Multipage Map instructions on page 69. 

To Print a Map 
Use the following steps to print a map. 

1. Locate the area you want to print.  
2. Click the Print tab. The Print dialog area displays. 
3. Click Map. The Map dialog area displays. 
4. Under Map Layout, select Page (the map print area is based on the paper size you have specified in the 

Setup options) or Screen (the map print area is based on the screen size). 
The print area for a Page map displays as a red box on the map (may not be visible) and the overview map 
and the print area for a Screen map displays as a blue box on the overview map. 

5. If you selected Screen in step 4, proceed to step 6. If you selected Page in step 4, the following options are 
available. 

a. Under Map Layout, select a layout option (Single, 2 x 2, or 3 x 3). The print area displays on both 
the Map and the Overview Map. In the example below, 2 x 2 is selected. This means the print area 
encompasses four standard pages at whatever paper size you specified in the Setup options. 
 

 
b. Optional: If you selected 2 x 2 or 3 x 3 in step 5a (and do not want to print all the pages in the 

multipage map) on the Map Layout graphic itself, click the page(s) you do not want to print. The 
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page appears dimmed or gray. 
Note: In the example below, page 4 will not print for the 2 x 2 map. 
 

 
c. Optional: Verify this is the location and photo zoom you want to print. If not, pan the map to the 

desired location and zoom to the desired level.  
Note: Changing the photo zoom will enlarge/reduce the map features and will change the map 
print area. If you increase the photo zoom level, map text, lines, symbols, etc. display larger and 
your map print area is reduced. If you decrease the photo zoom level, map text, lines, symbols, etc. 
display smaller and your map print area is enlarged. The reduction/enlargement percentages for 
your photo zoom level display under the Photo Zoom drop-down list. 

d. Optional: If you want to use other tabs and functions but not lose your current print area, print 
photo zoom, or other settings, select the Lock Print Center check box. Selecting this check box 
locks the print area and changes the tab label to red. 

6. Optional: Add text or graphics to your map. 
7. Optional: Select the Print Preview check box to zoom the map and view the entire print area. Clear the 

check box to return to your previous data zoom level. 
8. To change printers or make choices for paper orientation, paper size, and paper source, click the Setup 

button . The Print Setup dialog displays. 
Note: From the Setup dialog box, click Properties to view additional options. If the options are available, 
set the graphics mode to use raster graphics and set TrueType fonts to print as graphics. Consult your 
printer manual for additional information. The Printing Tips topic contains specific recommendations for 
best printing results. 

9. Click Print to print your map. 

 

If you want to adjust the print area, select the Lock Print Center check box, select the Select tool 

, and then drag the frame to the desired position. 

Adding Text or Graphics to Your Map 
Street Atlas USA 2005 Plus lets you add text (framed or unframed) and graphics (north arrows, scale bars, and 
images) to your map. 
 

 
• You can modify the properties of a text/graphic item by clicking the select tool  and 

selecting the item on the map. 
• You can make the text/graphic items you have added to your map the same size by selecting two 

items, right-clicking, selecting Make Same Size, and selecting Width, Height, or Both from the 
shortcut menu.  

• Once you have added text/graphic items to your map, you can align, snap, or layer them on the 
map. 

To Add Text to Your Map 
Use the following steps to add text to your map. 

1. Click the Print tab and then click Map to view the Print/Map dialog area. 
2. Make your desired Map and Map Layout options. 
3. Under Layout Tools, click and hold the text and graphics button to reveal the hidden text and graphic tools.  

4. Click the Framed Text tool . 
OR 

Click the Unframed Text tool . 
5. Click the location on the map where you want to add your text. A text box displays. 

Note: You can reposition your text (when not in editing mode) by dragging the text box to the desired 
position. 
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6. Type the desired text in the text box. To type more than one line of text, press SHIFT+ENTER on your 
keyboard to advance to another line. Press the ENTER key on your keyboard when finished typing your 
text. 

7. Under Layout Tools, select the font, style, and size for your text using the available drop-down lists. 

8. To underline your text, click the Underline tool . 

9. To change the color of your text, click the Font Color tool . From the Color dialog box, you can: 
• Click to select an alternative color. Click OK when finished. 
• Click Define Custom Colors and create a custom color by assigning red/green/blue or 

hue/sat/lum values. Click Add to Custom Colors and then click OK. 

10. Click the Align Left button  to align the text in your text box to the left. 
OR 

Click the Center button  to align the text in the center of the text box. 
OR 

Click the Align Right button  to align the text in your text box to the right. 

11. Click the Text Box Size button  if you want the size of your text box to grow with the amount of text 
typed. 
Note: The Text Box Size button is a toggle button. If the button is not activated, any text placed on the map 
will be placed in a default-sized text box. The default-sized text box can be resized by selecting the text box 
on the map and dragging any of the white boxes on the corners/sides of text box. 

To Add a North Arrow to Your Map 
Use the following steps to add a North arrow to your map. 

1. Click the Print tab and then click Map to view the Print/Map dialog area. 
2. Make your desired Map and Map Layout options. 
3. Under Layout Tools, click and hold the text and graphics button to reveal the hidden text and graphic tools.  

4. Click the North Arrow tool . All of the North Arrow tool styles display to the right. 
5. Select the desired North Arrow tool style and then click the location on the map where you want to add the 

graphic. 
Note: Once you place the tool on the map, it can be resized by dragging any of the white boxes on the 
corners/sides of the graphic. The tool can be repositioned at any time by dragging the graphic to the desired 
position. 

To Add a Scale Bar to Your Map 
Use the following steps to add a scale bar to your map. 

1. Click the Print tab and then click Map to view the Print/Map dialog area. 
2. Make your desired Map and Map Layout options.  
3. Under Layout Tools, click and hold the text and graphics button to reveal the hidden text and graphic tools.  

4. Click the Scale Bar tool . All of the Scale Bar tool styles display to the right. 
5. Select the check box to the left of the Scale Bar tool style options and then select the desired Scale Bar 

style. 
AND/OR 
Select the Scale check box to display the current scale on the map. 
AND/OR 
Select the Scale Reference Length check box to display the scale reference length on the map. 
AND/OR 
Select the Zoom check box to display the current data zoom level on the map. 

6. Click the location on the map where you want to add the graphic. 
Note: Once you place the tool on the map, it can be resized by dragging any of the white boxes on the 
corners/sides of the graphic. 
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To Add an Image to Your Map 
Use the following steps to add an image to your map. 

1. Click the Print tab and then click Map to view the Print/Map dialog area. 
2. Make your desired Map and Map Layout options.  
3. Under Layout Tools, click and hold the text and graphics button to reveal the hidden text and graphic tools.  

4. Click the Image tool . 
5. Click the location on the map where you want to add your image. The Select Image File dialog box 

displays. 
Note: The image can be repositioned at any time by dragging it to the desired position. 

6. Select an image file (.jpg, .bmp, or .gif) to place on your map and then click Open. The image displays on 
the map and the file name displays in the text box next to the Image tool under Layout Tools. 

Note: You can update the image at any time by clicking the browse button  and browsing to an 
alternative image. 

7. Select the Maintain Aspect Ratio check box to keep the image's width and height ratios while resizing.  
8. Select the Preview Image check box to preview the image on the map. 

Aligning Text and Graphic Items on Your Map 
Once you have added a text or graphic tool to your map, you can use the right-click functionality to align the 
object(s) on a certain location on the map. 

Aligning Multiple Text and Graphic Items on Your Map 
Use the following steps to align multiple text and graphic items on the map. 

1. Click the Print tab. The Print dialog area displays. 
2. Place more than one text and/or graphic item on your map. 
3. While pressing the SHIFT key on your keyboard, click each text/graphic item on the map. A box displays 

around each item. 
OR 
Drag your mouse over the text/graphic items on the map to select multiple items at once. A box displays 
around each item. 

4. Right-click on one of the items and then select Align from the shortcut menu. Then, click: 
• Left to align the left sides of all of the items (placement is based on the left side of the left-most 

item). 
• Right to align the right sides of all of the items (placement is based on the right side of the right-

most item). 
• Top to align the top side of all of the items (placement is based on the top side of the top-most 

item). 
• Bottom to align the bottom side of all of the items (placement is based on the bottom side of the 

bottom-most item). 
• Vertical Center to center the items based on the average of the vertical placement of the items. 
• Horizontal Center to center the items based on the average of the horizontal placement of the 

items. 
• Center to center the items based on the center of the average area that the items cover on the map. 
• Stack Vertically to stack the items vertically on top of each other. 
• Stack Horizontally to position the items side-by-side. 

 

• You can make multiple text and graphic items the same size by pressing the SHIFT key on your 
keyboard and selecting each item. Then, right-click, select Make Same Size, and select Width, 
Height, or Both from the shortcut menu. When you attempt to make multiple items the same 
size, the largest item is always the basis for the size change. Important: In order for an item to 
be made the same size as another item, the item must not be locked (for example, the Maintain 
Aspect Ratio check box should be cleared for images, only text items with default-sized text 
boxes can be resized, etc.). 

• You can delete multiple text/graphic items by selecting the Edit tool, dragging the mouse in a 
down-right direction on the map to encompass the items you want to delete, and then pressing 
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the DELETE key on your keyboard. 
 

Snapping Text and Graphic Items on Your Map 
Once you have added a text or graphic tool to your map, you can snap the item(s) to the desired location by dragging 
the item along the edges of the map or by dragging the item to snap it to the center of the page. 

 

You can disable the auto-snap function by holding down the ALT key on your keyboard while 
dragging the text/graphic items on the map. 

To Snap Text and Graphic Items on Your Map 
Use the following steps to snap text and graphic items on a printed map. 

1. Add text or graphics to your map. 
2. Drag the text/graphic item(s) you have placed on the map to the desired location on the map. If you drag 

the item(s) to the edge of the map print area, the text/graphics will snap to the edge. If you drag the item(s) 
to the center of the edge of the map print area, the text/graphics snap to the center of the edge. You can also 
drag the item(s) to the center of the map print area to snap them at the center of the printed map. 

 

• You can make multiple text and graphic items the same size by pressing the SHIFT key on your 
keyboard and selecting each item. Then, right-click, select Make Same Size, and select Width, 
Height, or Both from the shortcut menu. When you attempt to make multiple items the same 
size, the largest item is always the basis for the size change. 

• You can delete multiple text/graphic items by selecting the Edit tool, dragging the mouse in a 
down-right direction on the map to encompass the items you want to delete, and then pressing 
the DELETE key on your keyboard. 

 

Layering Multiple Text and Graphic Items on a Printed Map 
There may be an occasion where you want to layer text or graphic items on your printed map. In this case, use the 
right-click Bring to Front/Send to Back options so that each can still be displayed.  

To Layer Multiple Text or Graphic Items on a Printed Map 
Use the following steps to layer multiple text or graphic items on the map. 

1. Click the Print tab. The Print dialog area displays. 
2. Place more than one text and/or graphic item on your map, placing the text/graphic items on top of each 

other. 
3. If one of the text/graphic items you want to display is partially underneath another text/graphic item, select 

the item you want to display, right-click, and select Bring to Front. 
Note: You can reverse this step by right-clicking the item and selecting Send to Back. 

 

• You can make multiple text and graphic items the same size by pressing the SHIFT key on your 
keyboard and selecting each item. Then, right-click, select Make Same Size, and select Width, 
Height, or Both from the shortcut menu. When you attempt to make multiple items the same 
size, the largest item is always the basis for the size change. 

• You can delete multiple text/graphic items by selecting the Edit tool, dragging the mouse in a 
down-right direction on the map to encompass the items you want to delete, and then pressing 
the DELETE key on your keyboard. 

 

Copying Your Map to the Clipboard 
Click the copy to clipboard button  to copy your map to the clipboard so that you can paste it into a graphics 
program such as Microsoft® Paint or Adobe® Photoshop. 
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Saving a Map as a Bitmap or JPEG Image 
You can save the current map view as a bitmap (.bmp) or JPEG (.jpg) image in all page layout formats: Single, 2 x 
2, and 3 x 3. If a multipage format is selected, all the active pages are saved as individual bitmaps/JPEGs using the 
specified file name with an incremental (page) number at the end of the name. 

 

Click Cancel to stop the file save at any time. 

To Save a Map as a Bitmap or JPEG 
This process is very similar to printing a map. Use the following steps to save a map as a bitmap image. 

1. Locate the area you want to save as a bitmap image.  
2. Click the Print tab. The Print dialog area displays. 
3. Click Map. The Map dialog area displays. 
4. Under Map Layout, select Page (the map print area is based on the paper size you have specified in the 

Setup options) or Screen (the map print area is based on the screen size). 
The print area for a Page map displays as a red box on the overview map and the print area for a Screen 
map displays as a blue box on the overview map. 

5. If you selected Page in step 5, the following options are available. 
a. Under Map Layout, select a layout option (Single, 2 x 2, or 3 x 3). The print area displays on both 

the Map and the Overview Map. In the example below, 2 x 2 is selected. This means the print area 
encompasses four standard pages at whatever paper size you specified in the Setup options. 

 
b. Optional: If you selected 2 x 2 or 3 x 3 in step 5a (and do not want to save all the pages in the 

multipage map) on the Map Layout graphic itself, click the page(s) you do not want to save. The 
page appears dimmed or gray. 
Note: In the example below, page 4 will not print for the 2 x 2 map. 
 

 
c. Optional: Verify this is the location and photo zoom you want to save. If not, pan the map to the 

desired location and zoom to the desired level.  
Note: Changing the photo zoom will enlarge/reduce the map features and will change the map 
area that you save as a bitmap image. If you increase the photo zoom level, map text, lines, 
symbols, etc. display larger and your map area is reduced. If you decrease the photo zoom level, 
map text, lines, symbols, etc. display smaller and your map area is enlarged. The 
reduction/enlargement percentages for your photo zoom level display under the Photo Zoom drop-
down list. 

d. Optional: If you want to use other tabs and functions but not lose your current print area, print 
photo zoom, or other settings, select the Lock Print Center check box. Selecting this check box 
locks the print area and changes the tab label to red. 

6. Optional: Add text or graphics to your map. 
7. Optional: Select the Print Preview check box to zoom the map and view the entire area that will be saved 

as a bitmap image. Clear the check box to return to your previous data zoom level. 

8. Click the save button . The Save 2D Map Image dialog box displays. 
Note: To cancel saving the file and return to the Print Map dialog area, click Cancel. 

9. Type the desired file name in the File Name text box, select to save the file as a .bmp or .jpg from the Save 
as Type drop-down list, select the desired DPI (optional),  and click Save. The map is saved. 
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E-mailing Your Print Area 
Once you've determined the map you want to print, you can e-mail it as a .jpg file using the e-mail button in the 
Print tab. Multipage maps are saved as individual .jpg files using an incremental page number at the end of the file 
name. 

To E-mail Your Print Area 
Use the following steps to e-mail your map print area. 

1. Locate the area you want to e-mail.  
2. Click the Print tab. The Print dialog area displays. 
3. Click Map. The Map dialog area displays. 
4. Under Print Area, select Page (the map print area is based on the paper size you have specified in the Setup 

options) or Screen (the map print area is based on the screen size). 
The print area for a Page map displays as a red box on the overview map and the print area for a Screen 
map displays as a blue box on the overview map. 

5. If you selected Screen in step 4, proceed to step 6. If you selected Page in step 4, the following options are 
available. 

a. Under Map Layout, select a layout option (Single, 2 x 2, or 3 x 3) from the available drop-down 
list. The e-mail area displays on both the Map and the Overview Map. In the example below, 2 x 2 
is selected. This means the print area encompasses four standard pages at whatever paper size you 
specified in the Setup options. 
 

 
b. Optional: If you selected 2 x 2 or 3 x 3 in step 5a (and do not want to print all the pages in the 

multipage map) on the Map Layout graphic itself, click the page(s) you do not want to print. The 
page appears dimmed or gray. 
Note: In the example below, page 4 will not print for the 2 x 2 map. 
 

 
c. Optional: Verify this is the location and zoom level you want to e-mail. If not, pan the map to the 

desired location and zoom to the desired level.  
d. Optional: If you want to use other tabs and functions but not lose your current print area or other 

settings, select the Lock Print Center check box. Selecting this check box locks the print area and 
changes the tab label to red. 

e. Optional: Select the Print Preview check box to zoom the map and view the entire e-mail print 
area. Clear the check box to return to your previous data zoom level. 

6. Click the e-mail button . Your e-mail application launches with the map(s) as a .jpg file attachment(s). 
7. Send the message according to the protocol of your e-mail application. 

Manually Assembling a Multipage Map 
After you have printed the sheets for your multipage map, you are ready to assemble the map.  
Before you begin, be sure you have a clear work surface large enough to accommodate the final map size. 
You will need the following tools to assemble your map: 

• Pencil 
• Razor knife 
• Straight Edge Ruler (longer than the edge of the longest sheet) 
• Permanent Tape ("invisible" or "magic" type) 
• Removable Tape 
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For convenience, you can use the DeLorme MapPack to display and store your map pages. The 
MapPack holder is available separately from DeLorme. 

To Manually Assemble a Multipage Map 
Use the following steps to manually assemble a multipage map. 

1. Using the straight edge ruler and razor knife, trim each sheet to the thin black line bordering the map. 
Note: For adjacent sheets, trim only one page. This makes piecing the sheets together easier. 

2. For each sheet that needs to be trimmed, mark the edges of the sheet to indicate the areas that need to be 
trimmed.  
The following diagrams of a 2 x 2 and 3 x 3 multipage map provide additional information on where to 
trim the sheets. The arrows indicate the edges to be trimmed. 

2 x 2 Multipage Map 

 
3 x 3 Multipage Map 

 
3. Align two adjacent sheets, placing the trimmed edge on top of the non-trimmed edge. 

Notes: 
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• Piece together the multipage map one seam at a time. This is especially important for a 3 x 3 
multipage map. 

• Build the multipage map from the inside out to minimize any misalignment. 
4. Using two small pieces of removable tape, tack together the aligned sheets. 

 
Note: This is a temporary measure. Steps 6 through 10 describe how to completely secure the sheets. 

5. Repeat steps 3 and 4 until all the sheets are pieced together. 
6. With the multipage temporarily pieced together, use small pieces of removable tape to secure the corners 

and edges of the multipage map. 

 
Note: Place the removable tape on the corners and edges, not along the seams. 

7. For each seam, fix the tape to the work surface (not on the sheet) so the tape is in alignment with the seam. 
8. Spool off enough permanent tape to cover the entire seam. Be careful not to let the tape touch the map until 

you are ready to apply it (in step 9). 
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9. Keeping the length of the tape taut, carefully apply the tape to the seam until both sides are fixed to the 
work surface. 

 
10. Press the tape along the seam to remove any air gaps. 
11. Repeat steps 6 through 10 until all seams are completely pieced together. 

 
12. Using the straight edge ruler, carefully trim the edges of the map at the seams (where the tape is affixed to 

the workspace). 
13. Peel off the removable tape at the corners and the edges. You are now ready to display your multipage map. 

Printing XData Dataset Records 
Street Atlas USA 2005 Plus gives you the ability to print records from datasets imported with the XData tab. For 
information on viewing records from imported datasets, see Viewing Dataset Records on page Error! Bookmark 
not defined.. 

To Print XData Dataset Records 
Use the following steps to print dataset records. 

1. Click the XData tab and then click Query. The Query dialog area displays. 
2. Select a dataset from the Use Dataset drop-down list. Set Table Display or Record Placement options if 

they are available for your dataset. 
3. Click the Print tab and then click XData to display the Print/XData dialog area. The title of the currently 

selected dataset displays in a text box in the Dataset Print Title area.  
4. Click Setup to open the Print Setup dialog box and select a printer, change printer properties, select paper 

size, and select paper orientation. Click OK when finished. 
5. Click Columns to view the Columns display area if the Print dialog area is minimized. 
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6. Under Dataset Print Title, select the Print Title check box to display a title on each printed page. Select the 
First Page Only check box to only display the title on the first printed page. 
Note: Click Font to change the font, style, size, and/or script. 

7. Under Records, select an option to achieve the desired action. 
Note: Various options are available under the Records drop-down box depending on options you chose 
under the Table Display drop-down box in the XData dialog area. You can choose specific options 
available or to print All Records in the dataset. 

Option Action 
Print Column Names Displays column names on each printed page. Clear 

the check box to have no column names display. 
First Page Only Displays column names on the first page only. This 

option is unavailable if the Print Column Names 
check box is cleared. 

Print Column Borders Displays borders around table columns. 
Shade Alternate Records Displays shading in alternate rows in the table. 
 

8. Under Columns, select an option to achieve the desired action. 
Note: Selected check boxes indicate the columns which will print. Clear a column check box if you do not 
want the column to print or click: 

• Select All to select and print all columns.  
• Select None to clear all columns (no columns will print). 
• Reverse Selection to alternate selections. For example if you have selected columns 1, 3, and 5 to 

print and decide you want to print columns 2, 4, and 6 instead. The Reverse Selection option 
selects those columns that were cleared. 

9. When all options are selected, click Print. 

 

For specific recommendations on best printing results, see your printer manual. 

 

Printing a Route and Directions 
Street Atlas USA 2005 Plus gives you the ability to print maps of your route and/or route directions for any route 
you create.  
Additionally, you can save your directions or along the way results in a text file.  

To Print a Route 
Use the following steps to print an existing route. 

1. Click the Print tab and then click Route to display the Route dialog area. 
Note: If you do not have a route on this Map File, the route options are unavailable. 

2. Click the Setup button to open the Print Setup dialog box and select a printer, change printer properties, 
select paper size, and select paper orientation. Click OK when finished. 
Note: If the options are available under Printer Properties, set the graphics mode to use raster graphics and 
set TrueType fonts to print as graphics.  

3. Select the route you want to print from the Name drop-down list. 
Note: If the route you want to print is not available in the Name drop-down list, you may not have the 
correct Map File open. 

4. Under Options, select from one of the following choices: 
• Overview—Provides an optimized map of your route and the route summary (trip distance, trip 

time, start, total stops, and finish). 
• Travel Package—Provides maps of the route with corresponding directions. 
• Turn Details—Prints 2" x 2" maps of each of the turns in your route directions. 
• Directions—Provides action-based directions (turn, merge, bear, depart, arrive, and continue) 

including the time frame for each action.  
Note: Route directions can be saved as a text file. 
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• Along the Way—Prints the search results of a previous Advanced Find search within a current 
route. The search results are listed as they are listed in the Find results. 
Note: The Along the Way option is only available if you have recently performed a find/category 
within current route search in the Advanced Find subtab.  

• Strip Maps—Provides detailed maps in the direction of travel of the route along with directions 
which appear in the map margin. Strip maps are not printed North Up like other printed maps. 
They are printed so that the direction of travel is always at the top of the printed map. 

5. If you selected Travel Package or Strip Maps in step 4, select the miles per page that you want your route to 
cover from the Miles Per Page drop-down list. 
Note: When setting the number of miles per page, keep in mind that the number of miles is not the distance 
of the route. Instead, it equals the width of the strip map and determines the scale of the map. 

6. Optional: To view a preview of your selection, click View. 
7. Click Print. 

 

For specific recommendations on best printing results, see your printer manual. 

Saving Route Directions as Text 
Street Atlas USA 2005 Plus lets you save your directions and along the way results as a text file. 

To Save Your Route Directions 
This process is very similar to printing your route and directions. 
Use the following steps to save your directions.  

1. Click the Print tab and then click Route to display the Route dialog area. 
Note: If you do not have a route in this Map File, the Route Options are unavailable. 

2. Select the route you want to save from the Name drop-down list. 
Note: If the route you want to save is not available in the Name drop-down list, you may not have the 
correct Map File open. 

3. Under Options, select Directions or Along the Way. The number for Total Pages updates. 

4. Click the save button .  
5. In the File Name text box, rename the .txt file by typing the desired name and then click Save.  

Note: Click Cancel to return to the Print Route dialog area without saving the file. 
 

E-mailing Your Route Directions 
You can e-mail your route directions or along the way results as a text file using the e-mail button in the Route 
subtab of the Print tab.  

To E-mail Your Route Directions 
Use the following steps to e-mail your route directions or along the way results. 

1. Create a Route. 
2. Click the Print tab. The Print dialog area displays. 
3. Click the Route subtab. 
4. Select the Directions or Along the Way check box. 

5. Click the e-mail button . Your e-mail application launches with the along the way results or route 
directions as a text file attachment. 

6. Send the message according to the protocol of your e-mail application. 
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Map Files 
Map Files Overview 
Street Atlas USA 2005 Plus lets you save all of the work that you have done as a single Map File so you can open it 
again later. You can create various map views and save each in a different Map File, if desired. In this way, you can 
save separate views of often-viewed areas at your preferred zoom level and other settings. Then, open them as you 
need them using the Map File file tab. 

What is a Map File? 
A Map File consists of the map center coordinates, the current zoom level, the current magnification, preferences, 
and any routes or draw layers you have added to it.  

As you create routes and draw layers, they are added to the currently selected Map File. Map Files are saved by 
default in C:\DeLorme Docs\Map Files.  

Each associated file is saved in its respective folder in the C:\DeLorme Docs directory. For example, a draw layer is 
saved in C:\DeLorme Docs\Draw. For more information about the DeLorme Docs directory, see Street Atlas 2005 
Plus File Directories on page 14. 

Can I Reuse Draw Layers and Routes in Other Map Files? 
After creating routes or adding your own roads, you may not want to do all of the work again in another Map File. 
You can share routes and draw layers between Map Files by using the Add button. 

Can I Send Routes or Draw Layers to Another Street Atlas USA 2005 Plus User? 
Map Files, including their routes and draw layers (such as the one with the roads you added), can be packaged into 
one Transfer File for convenience. The transfer file facilitates e-mailing, copying Map File information to other PCs, 
and copying Map Files between DeLorme programs. 

What is Exchange? 
If you click Exchange, the Exchange wizard displays. The Exchange wizard allows you to exchange the selected 
data file with a GPS device.  

Note: You can also launch the Exchange wizard using the Exchange button on the GPS tab.  

Creating and Deleting Map Files 
With Street Atlas USA 2005 Plus, you can create various map views and save each in a different Map File, if 
desired. 

To Create a New Map File 
Use the following steps to create a new Map File. 

1. Click the Map Files tab to open the Map Files dialog area. 
2. Click File and then click New. 

OR 

Click the new file button . 

3. Click the save button . Map Files have .saf extensions and are saved in the C:\DeLorme Docs\Map 
Files directory by default. 
OR 
Click File and then click Save As to give the Map File a name other than the default. 

To Delete a Map File 
Use the following steps to delete a Map File. 
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1. Open a Map File. 
2. Click File, click Current View, and then click File Info. 
3. Using Windows Explorer, browse to the directory location specified in the Map File dialog area. 
4. Select the desired file. 
5. From the File menu, click Delete. 
6. Click Yes at the Delete File confirmation message. 

Opening a Map File 
With Street Atlas USA 2005 Plus, you can create various map views and save each in a different Map File, if 
desired. You are able to view your Map Files by opening them one at a time. 

To Open a Map File 
Use the following steps to open a Map File. 

1. Click the Map Files tab. 
2. Click File and then click Open.  

OR 

Click the open button . 
3. Double-click the desired Map File. The last saved map view for that Map File displays. 

OR 
Click the Map File to select it and then click Open. The last saved map view for that Map File displays. 
OR 
Click Recent Files to view a list of the most recently saved Map Files. 

Editing a Map File 
As you create new routes and draw objects or layers, they are added to the current Map File. You can also pan and 
zoom the map as needed, and then save all these Map File changes, if desired. 

To Add/Delete Files Contained in a Map File 
Use the following steps to add or delete specific files contained in a particular Map File in Street Atlas USA 2005 
Plus. 

1. Open a Map File. 
2. Click File, click Current View, and then click Contents to view the contents of the Map File.  

• To add a file, click Add and then click Draw Files, Route Files, or XData Datasets. The file is 
added to the current Map File. 
Note: If a file is added to a Map File and then changed later, the file is updated in every Map File 
it has been added to. 

• To remove a file, select that file from the Current Map File tree and then click Remove. 
Note: This does not delete the file, however, it just removes it from the selected Map File. 

3. Click File and then click Save. 
OR 

Click the save button . Map files have .saf extensions and are saved in the C:\DeLorme Docs\Map Files 
directory by default. 

Under the Current Map File tree, you can use the check box next to each file to display or hide it on the 
current map view. 

 

Creating Transfer Files 
A Map File is made up of several different files; for example route, draw, and waypoint files. A Map File and its 
contents can be packaged into a single file, called a transfer file, which facilitates e-mailing or copying.  
This topic describes the steps necessary to create a transfer file with and without hyperlinked file attachments. When 
you create a transfer file with hyperlinked files, you have the option of saving the common directory structure of the 
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hyperlinked files. Saving the directory structure of common files can be helpful when you are sharing and updating 
transfer files. 

 

Transfer files do not transfer map data. 

To Create a Transfer File 
Use the following steps to create a transfer file in Street Atlas USA 2005 Plus. 

1. Click the Map Files tab. 
2. Open the Map File you want to create as a transfer file. 
3. Click File, click Transfer, and then click Create. The Create Transfer File dialog box displays. 
4. In the File Name text box, type the desired file name.  

Note: Transfer files have .dmt extensions and are saved in the C:\DeLorme Docs\Map Files directory by 
default. Change the location now if you want to save your transfer file to another directory. 

5. Click Create. Your file is created and saved in the specified location. 

To Maintain the Directory Structure When Creating a Transfer File with 
Hyperlinked Files 
When you create a transfer file containing hyperlinked files, you can select to maintain part of the directory structure 
for files with at least a common drive location.  
Use the following steps to create a transfer file with hyperlinked files. 

1. Click the Map Files tab. The Map Files options display.  
2. Open the Map File you want to create as a transfer file. 
3. Click File, click Transfer, and then click Create. The following dialog box displays. 
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4. Verify the Include Hyperlink Files for Transfer check box is selected. 
Note: If you do not want to include hyperlink files in your transfer file, clear this check box and proceed to 
step 8. 

5. Under File Options, select Maintain Directory Info to save the directory structure of the hyperlinked files. 
Note: If you do not want to save the directory structure of the hyperlinked files, select Do Not Include 
Directory Info and proceed to step 8. 

6. Type the common base directory location of the hyperlinked files up until the folder location that you want 
to maintain in the available text box. 
OR 

Click the browse button  and browse to the common base directory location. 

 
7. Under Select Files to Be Included, clear the check box(es) next to the files you do not want to include in 

your transfer file.  
8. Click OK. The Create Transfer File dialog box displays. 
9. In the File Name text box, type the desired file name. 
10. Click Create. Your file is created and saved in the specified location. 

Note: When this file is imported and the files are saved, there will be two folders: Print and Projects (each 
containing one file) and a single file (UserGuide.pdf). The default location for imported transfer file attachments is 
C:\DeLorme Docs\Transfer Files.  

Importing Transfer Files 
A Map File is made up of several different files; for example route, draw, and waypoint files. A Map File and its 
contents can be packaged into a single file, called a transfer file, which facilitates e-mailing or copying. You can 
also import transfer files, allowing you to share your Map Files with other Street Atlas USA 2005 Plus users. 
This topic describes the steps necessary to import a transfer file with or without attached hyperlink files. When a 
transfer file with hyperlinked files is created, the user can select to maintain the directory information of common 
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files. By doing this, the recipient of the transfer file can keep a similar directory structure as the creator. This is 
helpful when a transfer file is shared and updated between users. 

 

Transfer files do not transfer map data. 

To Import a Transfer File 
Use the following steps to import a Map File transfer file, including transfer files that have been e-mailed to you by 
other DeLorme users. 

1. Click the Map Files tab. 
2. Click File, click Transfer, and then click Import. The Import Transfer File dialog box displays. 

Note: The C:\DeLorme Docs\Map Files directory displays by default. Browse to another location as 
needed. Transfer files have .dmt extensions  

3. Click the desired file to select it. The name displays in the File Name text box. 
4. Click Import to finish the import process. The imported Map File opens and displays in the map view.  

Note: A new Map File is created and its referenced files are stored in their respective C:\DeLorme Docs 
folders.  

To Import a Transfer File with Hyperlinked Files 
Use the following steps to import a Map File transfer file which includes hyperlinked file attachments. 

1. Click the Map Files tab. 
2. Click File, click Transfer, and then click Import. The Import Transfer File dialog box displays. 

Note: The C:\DeLorme Docs\Map Files directory displays by default. Browse to another location as 
needed. Transfer files have .dmt extensions  

3. Click the desired file to select it. The name displays in the File Name text box. 
4. Click Import. The Browse for Folder dialog box displays. 

 
5. Select the folder where you want to save the hyperlinked files. C:\DeLorme Docs\Transfer Files is the 

default location. 
6. Click OK. The imported Map File opens and displays in the map view. 

E-mailing a Transfer File 
A Map File is made up of several different files; for example route, draw, and waypoint files. A Map File and its 
contents can be packaged into a single file, called a transfer file, which facilitates e-mailing or copying. You can 
also import transfer files, allowing you to share your Map Files with other Street Atlas USA 2005 Plus users. 
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Transfer files do not transfer map data. 

To E-mail a Transfer File 
This procedure creates an attachment file, but does not permanently save any file to C:\DeLorme Docs\Map  Files. 
Use the following steps to e-mail a transfer file. 

1. Click the Map Files tab.  
2. Open the Map File you want to e-mail as a transfer file. 
3. Click File, click Transfer, and then click E-mail. A transfer file is created and your e-mail program opens 

with the transfer file included as an attachment. 
4. Address, add any additional message, and then send the mail according to the protocol of your e-mail 

program. 

Exchanging Objects With a Palm OS® Device Overview 
Using the Exchange Wizard in Street Atlas USA 2005 Plus, you can receive routes, waypoints, and draw files from 
a Palm OS handheld device or send maps, waypoints, routes points, route directions, draw points to a Palm OS 
device. 

 

Once you have sent objects to your Palm OS device, you must perform a Hotsync operation to view 
the files on the device. 

Sending a Handheld Map to a Palm OS® Device 
You can send maps you have cut using the Handheld Export tab to your Palm OS device using the Exchange Wizard 
in Street Atlas USA 2005 Plus. 

To Send a Handheld Map 
Use the following steps to send a handheld map to a Palm OS device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Palm OS. 
3. Select Send to Device. 
4. Select Handheld Map from the Object Type drop-down list. 
5. Click Next. 
6. Under Source, select the map you want to send to your handheld device from the Handheld Map drop-

down list. All of the maps saved in the specified location display in the list. 
Note: If you want to view maps saved in an alternate location, click the browse button and browse to the 
desired location. Then, select the desired map from the Handheld Map drop-down list. 

7. Select the user you want to send the map to from the User drop-down list. 
8. Click Prepare for Sync. A confirmation displays. Click OK to return to the Exchange Wizard. 
9. Repeat steps 6–8 for each map you want to send. 
10. Click Finish. The exported map is available on your handheld device after your next synchronization 

operation. 

Sending Route Information to Your Palm OS® Device 
Using the Exchange Wizard in Street Atlas USA 2005 Plus, you can send route points or route directions to your 
Palm OS device. 

To Send Route Points 
Use the following steps to send route points to your Palm OS device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Palm OS. 
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3. Select Send to Device. 
4. Select Route Points from the Object Type drop-down list. 
5. Click Next. 
6. Select the route file which contains the route points you want to send to your device from the Route drop-

down list. 
7. Click Prepare for Sync. 
8. Repeats steps 6–7 for each route file you want to send to your device. 
9. Click Finish. The route points are available on your handheld device after your next synchronization 

operation. 

To Send Route Directions 
Use the following steps to send route directions to your Palm OS device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Palm OS. 
3. Select Send to Device. 
4. Select Route Directions from the Object Type drop-down list. 
5. Click Next. 
6. Select the route file which contains the route directions you want to send to your device from the Route 

drop-down list. 
7. Select the User Profile the route file will sync to from the User drop-down list. 
8. Click Prepare for Sync. 
9. Repeat steps 6–8 for each route file you wan to send to your device. 
10. Click Finish. The route directions are available on your handheld device after your next synchronization 

operation. 
 

Sending Draw Points to Your Palm OS® Device 
Using the Exchange Wizard in Street Atlas USA 2005 Plus, you can send draw points to your Palm OS device. 

To Send Draw Points 
Use the following steps to send draw points to your Palm OS device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Palm OS. 
3. Select Send to Device. 
4. Select Draw Points from the Object Type drop-down list. 
5. Click Next. 
6. Select the draw file you want to send to your device from the Draw File drop-down list. 
7. Click Prepare for Sync. 
8. Repeat steps 6–7 for every draw file you want to send to your device. 
9. Click Finish. The draw points are available on your handheld device after your next synchronization 

operation. 

Sending Waypoints to Your Palm OS® Device 
You can send waypoints to your Palm OS device using the Exchange Wizard in Street Atlas USA 2005 Plus. 

To Send Waypoints 
Use the following steps to send waypoints to your Palm OS device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Palm OS. 
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3. Select Send to Device. 
4. Select User Map Data - Waypoints from the Object Type drop-down list. 
5. Click Next. 
6. Select the waypoint file you want to send to your device from the Waypoint File drop-down list. 
7. Click Prepare for Sync. 
8. Repeat steps 6–7 for every draw file you want to send to your device. 
9. Click Finish. The waypoints are available on your handheld device after your next synchronization 

operation. 

Receiving a Route From Your Palm OS® Device 
You can receive a route created on your Palm OS device using the Exchange Wizard. Once imported, the file can be 
used in Street Atlas USA 2005 Plus. 

To Receive a Route From Your Palm OS Device 
Use the following steps to receive a route from your Palm OS device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Palm OS. 
3. Select Receive from Device. 
4. Select Route from the Object Type drop-down list. 
5. Select Route from the Save As drop-down list to save your route as a route file. 
6. Click Next. 
7. Select the route file on the device that you want to receive. 
8. Select the route file you want to add the route information to. If you want to create a new route file, select 

New from the Route drop-down list and type the new route name in the available text box. 
9. Click Receive From Device. 
10. Repeats steps 7–9 for each route file you want to receive. 
11. Click Finish. The route information displays in Street Atlas USA 2005 Plus. 

Receiving Waypoints From Your Palm OS® Device 
You can receive waypoints created on your Palm OS device using the Exchange Wizard. Once imported, the file can 
be used in Street Atlas USA 2005 Plus. 

To Receive Waypoints From Your Palm OS Device 
Use the following steps to receive waypoints from your Palm OS device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Palm OS. 
3. Select Receive from Device. 
4. Select Waypoints from the Object Type drop-down list. 
5. From the Save As drop-down list, select to save the waypoints as a Draw File or User Map Data - 

Waypoints. 
6. Click Next. 
7. If you selected to save your waypoints as a Draw File, select the draw file you want to add the waypoint 

information to from the Draw File drop-down list. If you want to create a new draw file, select New from 
the Draw File drop-down list and type the new draw file name in the available text box.  
OR 
If you selected to save your waypoints as User Map Data - Waypoints, select the waypoint file you want to 
add the waypoint information to from the Waypoint File drop-down list. If you want to create a new 
waypoint file, select New from the Waypoint File drop-down list and type the new waypoint file name in 
the available text box. 

8. Click Receive From Device. 
9. Repeats steps 7–8 for each waypoint file you want to receive. 



Map Files 

83 

10. Click Finish. The waypoint information displays in Street Atlas USA 2005 Plus. 

Receiving a GPS Log From Your Palm OS Device 
You can receive GPS logs created on your Palm OS device using the Exchange Wizard. Once imported, the file can 
be used in Street Atlas USA 2005 Plus. 

To Receive GPS Logs From Your Palm OS Device 
Use the following steps to receive GPS logs from your Palm OS device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Palm OS. 
3. Select Receive from Device. 
4. Select GPS Logs from the Object Type drop-down list. 
5. Click Next. 
6. Select the GPS log you want to receive from the GPS Log drop-down list. 
7. Click Receive From Device. 
8. Repeats steps 6–7 for each GPS log file you want to receive. 
9. Click Finish.  

Exchanging Objects with a Pocket PC Device Overview 
Using the Exchange Wizard in Street Atlas USA 2005 Plus, you can receive routes, GPS logs, waypoints, and draw 
files from a Pocket PC device or send maps, routes points, route directions, waypoints, and draw points to a Pocket 
PC device. 
Before you can exchange objects with a Pocket PC device, you must ensure that the Files option is selected in 
Microsoft® ActiveSync. To verify you have the Files option selected in ActiveSync, from the Tools menu click 
Options, click the Sync Options tab, and verify the Files check box is selected. 

Sending a Handheld Map to a Pocket PC Device 
You can send maps you have cut using the Handheld Export tab to your Pocket PC device using the Exchange 
Wizard in Street Atlas USA 2005 Plus. 

To Send a Handheld Map 
Use the following steps to send a handheld map to a Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Send to Device. 
4. Select Handheld Map from the Object Type drop-down list. 
5. Click Next. 
6. Under Source, select the map you want to send to your handheld device from the Handheld Map drop-

down list. All of the maps saved in the specified location display in the list. 
Note: If you want to view maps saved in an alternate location, click the browse button and browse to the 
desired location. Then, select the desired map from the Handheld Map drop-down list. 

7. Click Prepare for Sync. A confirmation displays. Click OK to return to the Exchange Wizard. 
8. Repeat steps 6–7 for each map you want to send. 
9. Click Finish. The exported map is available on your handheld device after your next synchronization 

operation. 

Sending Route Information to Your Pocket PC Device 
Using the Exchange Wizard in Street Atlas USA 2005 Plus, you can send route points or route directions to your 
Pocket PC device. 
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To Send Route Points 
Use the following steps to send route points to your Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Send to Device. 
4. Select Route Points from the Object Type drop-down list. 
5. Click Next. 
6. Select the route file which contains the route points you want to send to your device from the Route drop-

down list. 
7. Click Prepare for Sync. 
8. Repeats steps 6–7 for each route file you want to send to your device. 
9. Click Finish. The route points are available on your handheld device after your next synchronization 

operation. 

To Send Route Directions 
Use the following steps to send route directions to your Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Send to Device. 
4. Select Route Directions from the Object Type drop-down list. 
5. Click Next. 
6. Select the route file which contains the route directions you want to send to your device from the Route 

drop-down list. 
7. Click Prepare for Sync. 
8. Repeat steps 6–7 for each route file you wan to send to your device. 
9. Click Finish. The route directions are available on your handheld device after your next synchronization 

operation. 

Sending Draw Points to Your Pocket PC Device 
You can send draw points to your Pocket PC device using the Exchange Wizard in Street Atlas USA 2005 Plus. 

To Send Draw Points 
Use the following steps to send draw points to your Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Send to Device. 
4. Select Draw Points from the Object Type drop-down list. 
5. Click Next. 
6. Select the draw file you want to send to your device from the Draw File drop-down list. 
7. Click Prepare for Sync. 
8. Repeat steps 6–7 for every draw file you want to send to your device. 
9. Click Finish. The draw points are available on your handheld device after your next synchronization 

operation. 

Sending a GPS Log to Your Pocket PC Device 
You can send GPS logs you have created using Street Atlas USA 2005 Plus to your Pocket PC device using the 
Exchange Wizard.  
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To Send a GPS Log 
Use the following steps to send a GPS log to a Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Send to Device. 
4. Select GPS Log from the Object Type drop-down list. 
5. Click Next. 
6. Under Source, select the GPS log you want to send to your handheld device from the GPS Log drop-down 

list. All of the logs saved in the specified location display in the list. 
Note: If you want to view logs saved in an alternate location, click the browse button and browse to the 
desired location. Then, select the desired log from the GPS Log drop-down list. 

7. Click Prepare for Sync. A confirmation displays. Click OK to return to the Exchange Wizard. 
8. Repeat steps 6–7 for each GPS log you want to send. 
9. Click Finish. The GPS log is available on your handheld device after your next synchronization operation. 

Sending Waypoints to Your Pocket PC Device 
You can send waypoints to your Pocket PC device using the Exchange Wizard in Street Atlas USA 2005 Plus. 

To Send Waypoints 
Use the following steps to send waypoints to your Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Send to Device. 
4. Select User Map Data - Waypoints from the Object Type drop-down list. 
5. Click Next. 
6. Select the waypoint file you want to send to your device from the Waypoint File drop-down list. 
7. Click Prepare for Sync. 
8. Repeat steps 6–7 for every waypoint file you want to send to your device. 
9. Click Finish. The waypoints are available on your handheld device after your next synchronization 

operation. 

Receiving a Route From Your Pocket PC Device 
You can receive a route created on your Pocket PC device using the Exchange Wizard. Once imported, the file can 
be used in Street Atlas USA 2005 Plus. 

To Receive a Route From Your Pocket PC Device 
Use the following steps to receive a route from your Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Receive from Device. 
4. Select Route from the Object Type drop-down list. 
5. Select Route from the Save As drop-down list to save your route as a route file. 
6. Click Next. 
7. Select the route file on the device that you want to receive. 
8. Select the route file you want to add the route information to. If you want to create a new route file, select 

New from the Route drop-down list and type the new route name in the available text box. 
9. Click Receive From Device. 
10. Repeats steps 7–9 for each route file you want to receive. 
11. Click Finish. The route information displays in Street Atlas USA 2005 Plus. 
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Receiving Waypoints From Your Pocket PC Device 
You can receive waypoints created on your Pocket PC receiver using the Exchange Wizard. Once imported, the file 
can be used in Street Atlas USA 2005 Plus. 

To Receive Waypoints From Your Pocket PC Device 
Use the following steps to receive waypoints from your Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Receive from Device. 
4. Select Waypoints from the Object Type drop-down list. 
5. From the Save As drop-down list, select to save the waypoints as a Draw File or User Map Data - 

Waypoints. 
6. Click Next. 
7. If you selected to save your waypoints as a Draw File, select the draw file you want to add the waypoint 

information to from the Draw File drop-down list. If you want to create a new draw file, select New from 
the Draw File drop-down list and type the new draw file name in the available text box.  
OR 
If you selected to save your waypoints as User Map Data - Waypoints, select the waypoint file you want to 
add the waypoint information to from the Waypoint File drop-down list. If you want to create a new 
waypoint file, select New from the Waypoint File drop-down list and type the new waypoint file name in 
the available text box. 

8. Click Receive From Device. 
9. Repeats steps 7–8 for each waypoint file you want to receive. 
10. Click Finish. The waypoint information displays in Street Atlas USA 2005 Plus. 

Receiving a GPS Log From Your Pocket PC Device 
You can receive GPS logs created on your Pocket PC device using the Exchange Wizard. Once imported, the file 
can be used in Street Atlas USA 2005 Plus. 

To Receive GPS Logs From Your Pocket PC Device 
Use the following steps to receive GPS logs from your Pocket PC device. 

1. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

2. Under Device Type, select Pocket PC. 
3. Select Receive from Device. 
4. Select GPS Logs from the Object Type drop-down list. 
5. Click Next. 
6. Select the GPS log you want to receive from the GPS Log drop-down list. 
7. Click Receive From Device. 
8. Repeats steps 6–7 for each GPS log file you want to receive. 
9. Click Finish.  
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Draw 
Draw Overview 
Street Atlas USA 2005 Plus lets you add draw objects, such as routable roads, waypoints, tracks, text, symbols, 
MapNotes, images, lines, arcs, splines, circles, polygons, and rectangles to your map with the tools provided under 
the Draw tab. You can save draw objects in a single draw file or in multiple draw files. Draw files can be viewed 
individually or with other draw files. 

What is a Draw File? 
Imagine a draw file as a sheet of glass laying on top of your map. You can add various objects to the draw file to 
help enhance or pinpoint specific areas on the map, but these objects do not become part of the map. They exist in a 
draw file which overlays the map.  
You can create more than one draw file and overlay one on top of the other while still viewing the map beneath (see 
Editing/Locking Draw Files on page 92).  
When a draw file is cleared or deleted, the objects in the draw file do not display or they are deleted along with the 
draw file. When draw files are created and saved, they are saved within the current map file.  

 

• Draw files created in a particular map file can be displayed only if that map file is currently 
displaying. For example, if DrawLayer27 is created in a map file named Yarmouth Zoom 14 
only, DrawLayer27 does not display if a map file named Old Port is currently displaying. 

• Draw files can be added to multiple map files. 
• Routable roads, tracks, and waypoints are not tied to a map file (they do not change even 

when a map file is changed).  

What Are Draw Objects? 
Draw objects are those objects you add to a draw file with the tools provided in the Draw tab. Draw objects consist 
of line, area, or point objects. Draw objects can be copied, moved, deleted, added to other draw files, and added to 
another map file.  
For more information, see Draw Objects Overview on page 93. 

What are Line Objects? 
Line objects are those objects consisting of line segments and points, such as: 

• Routable Roads 
• Tracks 
• Lines 
• Arcs 
• Splines 

For more information, see Line Objects Overview on page 99. 

What are Area Objects? 
Area objects are those objects consisting of one or more closed line objects, such as: 

• Polygons 
• Rectangles 
• Circles 

For more information, see Area Objects Overview on page 108. 

What are Point Objects? 
Point objects consist of one anchor point attached to either a waypoint, symbol, MapNote, image, or text label. The 
anchor point is the pixel position on the symbol which corresponds to the geographic coordinate of the point 
selected on the map when the symbol is placed. 
For more information, see Point Objects Overview on page 112. 
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Hidden Draw Tools 
The Draw tab provides tools which allow you to add routable roads, waypoints, tracks, lines (straight lines, arcs, and 
splines), shapes (polygons, rectangles, and circles), MapNotes, text labels, images, and symbols to a draw file. Some 
of these tools exist as hidden tools available in pull-out menus. 

To View the Hidden Draw Tools 
Five draw tool options provide pull-out menus with hidden tools. These draw tools each have a small arrow at the 

bottom-right of the draw tool button as shown in this sample . 
Use the following steps to view the hidden draw tools. 

1. Click the Draw tab to open the Draw dialog area. 
2. Click and hold one of the current visible tools below to display and select one of the options. 

Note: Selecting a hidden tool from a pull-out menu changes the default option. 

 

Routable Roads/Waypoints/Tracks Tool 

 

Line/Arc/Spline Tool 

 

Polygon/Rectangle/Circle Tool 

 

Symbol/Image Tool 

 

MapNote/Text Label Tool 

Exporting Draw Files to Text Files 
Street Atlas USA 2005 Plus allows you to export draw files as text files. Draw objects exported to text files contain 
coordinate information for each line, area, or point object. These text files can be opened in other DeLorme 
products. 

 

When draw objects are converted to text files, each object is represented by coordinate positions 
within the text file. 

To Export Draw Files to Text Files 
Use the following steps to export an existing draw file to a text file. 

1. Open the map file containing the draw file you want to export. 
OR 
Create a new draw file for exporting. 

2. Click the Draw tab to open the Draw dialog area. 
3. Click File to open the draw file editing area. A check mark in the check box next to the file name in the file 

list indicates the file displaying on the map. All active files are selected in the Active column. 
4. Select the draw file you wish to export from the file list. 
5. Click Export. The Export Draw File dialog box displays. 
6. Browse to a directory in which to save the file or use the default destination C:\DeLorme Docs\Draw. 
7. Type a name for the file in the File name text box. The default name is DrawExport. 
8. Click Save to save the exported draw file. 
9. Click Done to return to the main Draw tab dialog area. 
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Importing Files to Draw Files 
Street Atlas USA 2005 Plus allows you to import various types of files as draw files. The file items display as draw 
objects within the draw file.  
 
If you import this type 
of file... 

Which results from this source... The following is imported... 

Solus® Mark File Point objects displaying with the current 
symbol selection. 

Text File (.txt) 

Lat/Lon Text File 
 

Point objects and annotation draw objects 
displaying with the current symbol and line 
style selections. 

Address Book (.txt, .csv) Address Book File* Point objects and annotation draw objects 
displaying with the current symbol and line 
style selections. 

Draw Layer Files Topo USA® 2.0 (.ano)  Point objects and annotation draw objects 
displaying with the current symbol and line 
style selections. 

MapDocs (.sa7, .sa8, .sa9, 
.mn5, .mn6, .mn7) 

 Street Atlas USA® 7.0, 8.0, and 
9.0. 

 AAA Map'n'Go® 5.0, 6.0, and 7.0 

Point objects and annotation draw objects 
displaying with the current symbol and line 
style selections. 

GPS Log Files (*.gpl) Any DeLorme product which supports 
GPS tracking. 

Line object displaying with the current line 
preferences. 

* Note: Address book text files must be: 
• Comma or tab delimited. 
• In the format: name, address, city, state, ZIP, phone. 
• Less than 50 records long. 

To Import Files 
Use the following steps to import a file. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Using the chart above, verify the symbol, line style, and/or highlight color selection. These selections 

determine how your imported objects display. 
4. Click File to open the draw file editing area.  
5. Click Import. The Import Draw File dialog box displays. 
6. Browse to the source folder of the desired file. The default directory is C:\DeLorme Docs\Draw. 
7. From the Files of type drop-down list, select the type of file you want to import.  
8. Select the desired file from the Import Draw File dialog box and then click Open. The draw objects of the 

imported file display. A new draw file is automatically created for the imported file. 
9. Click Done to return to the Draw dialog area. 

Formatting a Text File to Import as a Draw File 
Below are the formatting conventions (and examples of each) for creating a text file to be imported as a draw file. 
Draw Object Format Example 
Line BEGIN LINE 

LAT, LON 
LAT, LON 
LAT, LON  
END  

BEGIN LINE 
43.807801,-70.164440 
43.807629,-70.163801 
43.807211,-70.162746 
43.806707,-70.163400 
43.806696,-70.163905 
43.807125,-70.164768 
43.807801,-70.164440 
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Draw Object Format Example 
END 

Spline BEGIN SPLINE 
LAT, LON 
LAT, LON 
LAT, LON 
LAT, LON  
END 

BEGIN SPLINE 
43.807801,-70.164440 
43.807629,-70.163801 
43.807211,-70.162746 
43.806707,-70.163400 
43.806696,-70.163905 
43.807125,-70.164768 
43.807801,-70.164440 
END 

Arc BEGIN ARC 
LAT, LON 
LAT, LON 
LAT, LON 
LAT, LON  
END  

BEGIN ARC 
43.807801,-70.164440 
43.807704,-70.162775 
43.807211,-70.162746 
43.807430,-70.163644 
END 

Polygon 
Rectangle 

BEGIN POLY 
LAT, LON 
LAT, LON 
LAT, LON 
LAT, LON  
END  

BEGIN POLY 
43.808692,-70.165392 
43.808692,-70.162493 
43.806621,-70.162493 
43.806621,-70.165392 
43.808692,-70.165392 
END 

Circle BEGIN CIRCLE 
LAT, LON, Radius 
END  

BEGIN CIRCLE 
43.807662,-70.163935,0.114611 
END 

Symbol BEGIN SYMBOL 
LAT, LON, Name, Symbol Name 
END 

BEGIN SYMBOL 
43.807662,-70.163935,DeLorme, 
Blue Pin 
END 

MapNote BEGIN NOTE 
LAT, LON, Text 
END  

BEGIN NOTE 
43.807662,-70.163935,DeLorme 
END 

Text Label BEGIN TEXT 
LAT, LON, Text 
END  

BEGIN TEXT 
43.807662,-70.163935,DeLorme 
END 

 

Finding a Symbol by Its Name 
Within the Draw tab of Street Atlas USA 2005 Plus, you can attach a name to any symbol you add to your map. For 
more information on adding symbols to the map, see Symbols: Adding, Editing, and Placing on page 114. 
You can use a name as a means to help locate a symbol you have already placed on a map using the QuickSearch 
feature under the Find tab in Street Atlas USA 2005 Plus. For example, if you name a symbol "My House" in Street 
Atlas USA 2005 Plus when you placed it on the map, use the following steps for conducting a search on the unique 
symbol name.  

To Find a Symbol by Its Name 
Use the following steps to find a symbol by its name. 

1. Click the Find tab. 
2. Using QuickSearch, type the symbol name followed by the town and state abbreviation (for example, My 

Office, Yarmouth, ME) in the Search For text box. 
3. Click Search. Street Atlas USA 2005 Plus displays the closet matches in the list view to the right of the 

Search For text box. The symbol name displays in the Name column. 
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4. Double-click the item or select the item and click Go To to locate your selection on the map. The map view 
recenters on the item. A MapTag displays the symbol name at the symbol location. 

Draw Files Overview 
Street Atlas USA 2005 Plus lets you add draw objects, such as routable roads, waypoints, tracks, text, symbols, 
images, MapNotes, lines, arcs, splines, circles, polygons, and rectangles to your map with the tools provided under 
the Draw tab. 
You can save draw objects in a single draw file or in multiple draw files. Draw files can be viewed individually or 
with other files. 
Below are additional draw file facts: 

• A draw file is automatically generated the first time you add a draw object to the map. 
• As draw files are created, they are added to the current map file. 
• Any draw file you create can be added to multiple map files. 
• You can control the creation of new draw files in the draw file editing area. 
• The draw file files are saved in C:\DeLorme Docs\Draw under the default name DrawLayer#.an1, with # 

indicating the number order in which the file was created. You can rename draw files to better identify your 
specific information. 

• You can have multiple draw files displaying at once while working on your map. Work can be done on one 
draw file at a time, while viewing other files beneath it. You can select different draw files to be the active, 
editable file from within the Draw tab. For more information, see Editing/Locking Draw Files on page 92. 

Creating a New Draw File 
Street Atlas USA 2005 Plus creates five different types of draw files: 

• DrawLayer—created when a line, arc, spline, circle, rectangle, polygon, symbol, MapNote, or text label is 
added to the map. 

• RoadLayer—created when a routable road is added to the map. 
• WaypointLayer—created when a waypoint is added to the map. 
• TrackLayer—created when a track is added to the map. 

A draw file is automatically created when you add a draw object to the map and there are no draw files (of that type) 
included in or contained in the current map file.  
You can control the creation of new draw files in the draw file editing area.  

 

Draw files are created in the currently selected map file.  

To Create a New Draw File 
Use the following steps to create a new draw file. 

1. Click the Draw tab to open the Draw dialog area. 
2. Click File to open the draw file editing area. A selected check box next to the draw file's name in the file 

list indicates the file is displaying on the map. 
Note: The draw file editing area is categorized by draw file type (for example, all roadlayer files are 
grouped together in the list, all drawlayer files are grouped together, etc.).  

3. Click New and then click Draw, Road, Waypoint, or Track. The new file is now the active draw file. 
Note: Each draw file type has an active layer. 

4. Optional: If you want to rename the draw file: 
a. Right-click the desired draw file in the draw file editing area and then click Rename. A box 

displays around the file name. 
OR 
Click the desired draw file in the draw file editing area and then click it again. A box displays 
around the file name.  

b. Delete the existing name. 
c. Type the desired name.  
d. Press the ENTER key on your keyboard. 
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5. Optional: If you want to ensure no changes are made to a particular draw file, select the Lock check box for 
that draw file in the draw file editing area. 

6. Click Save. 
7. Click Done to return to the main Draw dialog area. 

Saving a Draw File 
After you have finished adding draw objects to a draw file, you can save them in a draw file that can be viewed or 
edited later. Any time you edit a draw file, click Save to save your changes. 

To Save a New Draw File 
Use the following steps to save a draw file. 

1. Click the Draw tab to open the Draw dialog area. 
2. Add objects to the map as desired.  
3. Click File. 
4. Click Save. Draw files are saved in the C:\DeLorme Docs\Draw directory by default with .an1 extensions. 
5. Click Done to return to the main Draw dialog area. 

 

If you have any unsaved file(s) when you exit Street Atlas USA 2005 Plus, an Exit dialog box 
displays asking if, and what, you want to save. For more information, see Exiting Street Atlas USA 
2005 Plus on page 6. 

Deleting a Draw File 
You can delete a draw file you have just created or one you have saved previously. 

To Delete a Draw File 
Use the following steps to delete a draw file from the current map file. 

1. Open the existing map file which contains the draw file you want to delete. 
2. Click the Draw tab to open the Draw dialog area. 
3. Click File to open the draw file editing area. A check mark in the check box next to the file name in the file 

list indicates the file is displaying on the map.  
Note: The draw file editing area is categorized by draw file type (for example, all roadlayer files are 
grouped together in the list, all drawlayer files are grouped together, etc.). 

4. Select a draw file from the file list and then click Delete to delete the selected file. A Draw message box 
displays asking if you wish to delete the selected file. 

5. Click Yes to delete the file from the current map file. 
OR 
Click No to retain the file. 

6. Click Done to return to the Draw dialog area. 

Editing/Locking Draw Files 
You can edit the current active (editable) draw file. You can also lock a draw file, making it uneditable. 

To Edit a Draw File 
Use the following steps to edit a draw file. 

1. Click the Draw tab. 

2. Click File to open the draw file editing area.  

3. Verify the draw file you want to edit is displaying on the map (a check mark in the check box next to the 
file name in the file list indicates the file is displaying on the map).  

4. Click Done to return to the main Draw dialog area. 

5. Click the Select tool and then click the draw file object on the map that you want to edit. 
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6. Click File and then click Save to save the changes you made to the draw file. To exit the draw file editing 
area, click Done. 

To Lock a Draw File 
Use the following steps to lock a draw file. 

1. Click the Draw tab. 

2. Click File to open the draw file editing area.   

3. Select the Lock check box for each draw file you want to lock. 
Note: Clear the Lock check box to make changes to a draw file. 

4. To exit the draw file editing area, click Done. The Draw dialog area displays. 

Hiding Draw Files 
You can hide any draw files you have created. This removes from view all the draw objects in that file without 
permanently deleting them. 

To Hide a Draw File 
Use the following steps to hide a draw file. 

1. Open the existing map file containing the draw file you want to hide. 
2. Click the Draw tab to open the Draw dialog area. 
3. Click File to open the draw file editing area. 

Note: The draw file editing area is categorized by draw file type (for example, all roadlayer files are 
grouped together in the list, all drawlayer files are grouped together, etc.). 

4. Hide any files in the file list by clearing the check box next to the file name. 
• A draw file with a selected check box displays on the map. 
• A draw file with a cleared check box does not display on the map. 

5. Click Done to return to the Draw dialog area. 

Draw Objects Overview 
Draw objects added to a draw file contain points which give the object its shape or allow you to snap one object to 
another object. Points display and act in different ways within the various draw objects. 

• Points in Routable Roads, Tracks, Lines, Splines, and Polygons 
Draw objects such as routable roads, tracks, lines, splines, and polygons consist of shape points and end 
points.  

• Shape points are the points you place on the map when creating the object. They give the object 
it's shape. When you select a draw object on the map, shape points display along the active object 
as small magenta squares.  
 
The line object below was drawn with the spline tool. 
 

 
  

• End points are the first and last points of individual line segments on a draw object. When you 
select a shape point of a line segment within an active line, spline, or polygon: 
• A small green circle indicates the start end point of the selected line segment.  
• A small red circle indicates the last end point of the selected line segment. 

The same spline with end points indicating a selected spline segment. 
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Notes: 

• When the start or last end point of the line segment within a line draw object is clicked and 
the Show Measurement check box is available (when using the Polygon or Line tool) and 
selected, a text box displays the bearing or angle of that point of the line, the length of the 
line segment (leg), and the total length of the entire line object on the map. 

• When the start or end point of the line segment within a polygon draw object is clicked, a 
text box displays the bearing or angle of that point of the line, the length of the line segment 
(leg), and the total area of the polygon on the map. 

• Points in Rectangles, Circles, and Arcs 
Draw objects such as rectangles, circles, and arcs also contain points, but they are treated differently. 
Rectangles—Contain shape points at the four corners, but the lines between the shape points contain no 
editable end points. When you click one of these shape points, a text box displays the width, height, and 
area of the rectangle on the map. 
Circles—Contain no shape points, but have a central point which does not display until you snap it (see 
Note below) to another object. Clicking the circle displays a central crosshair within the circle and a text 
box containing information on the area and radius of the circle on the map. 
Arcs—Contain three shape points. When you click any of the points, a text box displays the angle or 
bearing of the selected point, the radius of the arc, and the total length of the arc line on the map. 
Only the first and second points you placed on the map when creating the arc are treated as start and end 
points (i.e., show red or green when clicked). The central magenta shape point, or third point you placed, 
determines the shape of the arc. 
Note: For information on snapping a draw object to another draw object, see Snapping Draw Objects on 
page 97. 

• Points in Point Draw Objects 
Point Objects, such as waypoints, symbols, and text, do not have shape or end points. Text label objects 
contain a point at the bottom center of the text label box and are only visible during a snap. 

• Points in MapNotes 
MapNotes do not have shape or end points. They contain a point at the end of the text box anchor point. 
Clicking the MapNote displays a central crosshair at the anchor point. 

 

Copying and Placing Draw Objects 
You can copy any draw object you place on the map. 

To Copy Draw Objects 
Use the following steps to copy draw objects. 

1. Open the existing map file which contains the draw object you want to copy. 
2. Click the Draw tab to open the Draw dialog area. 

3. To copy a single draw object, click the Select tool  and then click the desired draw object on the map. 
A box displays around the active object. 
OR 

To copy multiple draw objects, click the Select tool  and then drag a box over the draw objects you 
want to copy. 
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4. To copy, press the CTRL+C keys on your keyboard.  
5. To paste, press CTRL+V on your keyboard. The newly copied object is placed directly on top of the 

original (copied) object. 
6. To move the copied object, use the table below. 

  
If the draw object is a... Then... 
Line, Arc, Spline, Polygon, 
Rectangle, Circle, or MapNote 

Press and hold the SHIFT key on 
your keyboard and drag the object 
to the desired location. 

Symbol or Text Drag the object to the desired 
location. 

Tips:  
• To undo the move of the pasted draw object, click Undo to undo the last action. If you decide not 

to undo the last action, click Redo. 
• If you undo the first move of the pasted object, the object is placed back on top of the original 

(copied) object. 
• You can copy and move a single object by selecting the draw object you want to copy, pressing 

CTRL on your keyboard, and dragging the draw object to the desired location. 

Copying a Map Line to the Draw File 
You can copy a line directly from the map to a draw file using right-click functionality. Map lines which can be 
copied to draw objects include segments of all types of roads and highways, railroads, powerlines, pipelines, rivers 
or streams, and grid lines. 

To Copy a Map Line 
Use the following steps to copy a map line to the draw file. 

1. Pan the map and zoom to the desired data zoom level. 
OR 
Open the map file which has the desired map view. 

2. Click the Draw tab to open the Draw dialog area. 
3. Right-click the object on the map you want to bring into the draw file and then click Manage Draw/Copy 

to Draw Object. The object is copied into the draw file using the current line style selections. 

Moving Draw Objects 
You can move any draw object you place on the map under Draw from one location to another. 

To Move Draw Objects 
Use the following steps to move draw objects. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click the Select tool  and click the draw object you want to move. A box displays around the active 
object. 
 
Draw objects are moved in different ways: 
  
If the object is a(n)... Then... 
Routable Road, Track, Line, Arc, 
Spline, Polygon, Rectangle, or Circle 

Press and hold the SHIFT key on the keyboard and drag 
the object to the desired location. 
OR 
Press the arrow keys on your keyboard to move the 
object up, down, right, or left. 

Symbol, or Text Press the arrow keys on your keyboard to move the 
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If the object is a(n)... Then... 
object up, down, right, or left. 
OR 
Drag it to the desired location. 

MapNote To move the entire MapNote, press and hold the SHIFT 
key on the keyboard and drag the object to the desired 
location or position your cursor between the MapNote 
text and the anchor and drag the entire MapNote to the 
desired location. 
OR 
To move the MapNote's anchor, drag the MapNote's 
anchor to the desired location. 
OR 
To move the MapNote's text, drag the MapNote's text to 
the desired location.  

Tip: To undo a draw object move, click Undo to undo the last action. If you decide not to undo the last 
action, click Redo. 

Notes: You can also move draw objects or their points by typing a new coordinate or distance and 
bearing/angle number within the corresponding text boxes. 

 Type new coordinates and click Apply to move circles, symbols, text, and MapNotes. The whole 
object moves to the entered location. If you change the distance and bearing numbers, the object 
moves in relationship to the object's last location. 

 Type new coordinates and click Apply to move individual end points (small red circles) in line 
segments in routable roads, lines, splines, polygons, rectangles, and arcs. If you change the distance 
and bearing numbers of the individual points (not recommended for rectangles), the end point's 
distance and bearing/angle change in relationship to the start point of the segment. 

Deleting Draw Objects 
Once you have placed a draw object on a draw file, you can delete the object. You can also delete multiple or all 
draw objects in the active draw file. 

To Delete One Draw Object 
Use the following steps to delete a draw object. 

1. Open the existing map file which contains the draw object you want to delete. 
2. Click the Draw tab to open the Draw dialog area. 
3. Edit an existing draw file. 

4. Click the Select tool  and then click the desired draw object on the map to select it. A box displays 
around the selected object. 

5. Click Delete in the Draw dialog area. 
OR 
Press the DELETE key on your keyboard. 
OR 
Right-click on the object and then click Manage Draw/Delete Draw Object. 
Tip: To bring back the last draw object you deleted, click Undo to undo the last action (you can undo 
approximately 200 events in a single map file). 

To Delete Multiple Draw Objects 
Use the following steps to delete several draw objects. 

1. Click the Draw tab to open the Draw dialog area. 
2. Edit an existing draw file. 
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3. To select multiple draw objects, click the Select tool , click the first draw object on the map to select 
it, and then press and hold the SHIFT key on your keyboard while clicking any additional draw object(s) 
you want to delete. A box displays around each selected object. 
OR 

To select multiple draw objects, click the Select tool , drag a box over the draw objects you want to 
delete. 

4. Click the Delete button in the Draw dialog area. 
OR 
Press the DELETE key on your keyboard. 
OR 
Right-click on the object and then click Manage Draw/Delete Draw Object. 
 
A message box displays asking if you want to delete the draw objects from the current file.  

• If you click Yes, all selected draw objects in the file are deleted.  
Note: You cannot undo this action. 

• If you click No, no objects are cleared from the file. 

To Delete All Draw Objects 
To delete all draw objects from an unsaved draw file, click Clear All in the Draw dialog area. A message box 
displays asking if you want to clear all draw objects from the current file.  

• If you click Yes, all draw objects in the file are cleared.  
Note: You cannot undo this action. 

• If you click No, no objects are cleared from the file. 

Snapping Draw Objects 
You can snap any draw object to the exact coordinates of a point in another draw object. You can also snap the 
central shape point of an arc to another object. 

 

To turn the snapping feature off, press the ALT key on the keyboard while dragging the draw object. 

To Snap a Draw Object to the Coordinates of Another Object 
Use the following steps to snap a draw object to the coordinates of another draw object. 

1. Click the Draw tab to open the Draw dialog area. 
2. Edit an existing draw file. 

3. Click the Select tool  and then click the desired draw object on the map. A box displays around the 
active object. Shape points display as small, magenta squares. 

4. Select an end point from any of the line segments within the draw object. It displays as a red or green 
circle.  

5. Drag the point to: 
• Any other shape point within a line, spline, polygon, arc, or rectangle.  
• The center point of a circle. 
• The anchor of a symbol. 
• The base point of a text label. 
• The text box anchor point of a MapNote. 

When you drag your shape point over a point on the desired draw object, a yellow diamond defines the snap 

point . Release the point you dragged when the snap point displays. The active draw object is then 
snapped to the other object's point coordinate. 
Tip: To undo a draw object snap, click Undo to undo the last action. If you decide not to undo the last 
action, click Redo. 
Note: Do not snap one end point of an arc to the other end point in the same arc. 
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To Snap the Central Shape Point of an Arc to Another Object 
Use the following steps to snap the central shape point of the arc to another object.  

1. Click the Draw tab to open the Draw dialog area. 

2. Click the Select tool  and then click the desired arc on the map. A box displays around the active 
object. Shape points display as small, magenta squares. 

3. While pressing the SHIFT key on the keyboard, drag the center point of the arc line over a point on the 
desired draw object until the snap point (the yellow diamond) displays. 

4. Release the arc. It is snapped to the other object's point coordinate. 

Adding Points to Draw Objects 
You can add points to routable road, line, spline, and polygon draw objects in Street Atlas USA 2005 Plus to change 
the shape of the object. 

To Add Points to Draw Objects 
Use the following steps to add points to add points to routable roads, lines, splines, and polygons. 

1. Open an existing map file or create a new one. 
2. Create a new draw file or edit an existing draw file. 

3. In the Draw tab, click the Select tool , and then click the draw object you want to edit. A box displays 
around the line indicating it is active. The shape points of the draw objects display as small, magenta 
squares. 

4. Click the line between two shape points in the object and drag. A new point is created as well as a new line 
segment within the object. The new segment displays with it's first and last end points, as well as a text box 
indicating the new point's bearing or angle, length of the new segment (leg), and total object's length on the 
map.  
Tip: To undo the addition of the point to the draw object, click Undo to undo the last action. If you decide 
not to undo the last action, click Redo. 

Deleting Points and Line Segments from Draw Objects 
You can delete points from routable road, track, line, spline, and polygon draw objects in Street Atlas USA 2005 
Plus to change the shape of the object. 

To Delete Points and Line Segments from Draw Objects 
Use the following steps to delete points and line segments from draw objects. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click the Select tool  and click the draw object you want to edit. A dotted-line box displays around 
the line indicating it is active. The shape points of the linear objects display as small, magenta squares. 

5. Select the desired shape point. The point displays as either a green or red end point depending upon the line 
segment it is associated with.  

6. Click Delete in the Draw display area. 
OR 
Press the DELETE key on your keyboard. The point is deleted, as well as the line segment within the draw 
object which was associated with that point. 
Tip: To undo the addition of the point to the draw object, click Undo to undo the last action. If you decide 
not to undo the last action, click Redo. 

Labeling a Draw Object 
You can label any draw object created in Street Atlas USA 2005 Plus. Once you label a draw object, you can search 
for it using the QuickSearch function in the Find tab or by typing the draw object label in any of the routing fields in 
the Route tab. 
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To Label a Draw Object 
See the labeling procedures below for each of the draw objects. 
For this Draw Object... Use this labeling procedure... 
Routable Roads Type the name of the street in the text box available in the Draw dialog area. 
Arcs 
Circles 
Lines 
Polygons 
Rectangles 
Splines 
Tracks 
Waypoints 

1. Place the object on the map.  
2. Using the select tool, click the draw object once. A gray box displays 

around the draw object.  
3. Click the draw object again. A text box displays.  
4. Type the label name in the text box and then press the ENTER key on 

your keyboard. 

Images 
MapNotes 
Symbols 
Text Labels 
Waypoints 

1. Place the object on the map. The URL/Label text box displays. 
2. Type the label for your draw object in the Label section of the text box. 

Note: When viewing a hyperlinked draw object on the map, the object will 
display as an active hyperlink. If you want to click on the object without 
opening the hyperlink, press the CTRL key on your keyboard while you click 
the draw object. 

 

Line Objects 

Line Objects Overview 
Street Atlas USA 2005 Plus lets you add line objects to a draw file in your current map file. Line objects are those 
objects consisting of line segments and points. Most of the line object tools are hidden draw tools. Hidden draw 

tools are those which have a small arrow at the bottom-right of the draw tool symbol as shown in this sample . 
Once you have created a line object it can be edited (including reshaping or changing line color or width), copied, 
moved, or deleted at any time. The following table lists the line objects you can add and the suggested uses of each. 
 
Linear Object Tool Used Suggested Use 
Routable Roads 

 
Add routable road lines point-by-point to a road layer, then incorporate 
these roads into a route network when you create a route in the Route tab. 

Tracks 
 

Use the Track tool to add tracks to the map. 
Note: Tracks can be downloaded from a GPS receiver. 

Lines 
 

Use lines to mark boundaries or to add railroads or utility lines. Lines can 
be drawn with varied line styles, weights, and colors including lines which 
reflect actual map line types. 

Arcs 
 

Use arcs to add curved line features to a draw file. Arcs can be drawn with 
varied line styles, weights, and colors, including lines which reflect actual 
map line types. 

Splines 
 

Use splines to add trails or any other map feature which contains curves. 
Splines can be drawn with varied line colors, weights, and styles including 
lines which reflect actual map line types. 

 

Routable Roads: Drawing, Editing, and Placing 
The Routable Roads tool of Street Atlas USA 2005 Plus lets you add a new road to a road layer in the currently 
selected map file. Any new roads you add can then be incorporated into a route when you create a route. 

 

• You must be at data zoom level 11-0 or greater when adding roads with the Routable Roads 
tool. 

• Five draw tool options provide pull-out menus with hidden tools.  
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To Draw Routable Roads 
Use the following steps to add routable roads to a road layer. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new road layer or edit an existing road layer. 
4. Click and hold the Routable Roads/Waypoints/Tracks tool to view its hidden options. Select the Routable 

Roads tool . The mouse pointer displays the line symbol. 
5. Type the name of the road you want to add in the Road Name text box. 

Note: Name each routable road you add so you can locate it using the find feature. 
6. Hover the mouse pointer over existing roads to display the yellow diamond symbol . The yellow 

diamond symbol indicates where on an existing road the point for your new road will connect (connection 
point). 
Notes: 

• It is necessary for the new road to be connected to an existing non-limited access road for routing 
on the new road to occur. 

• Each time you intersect an existing road, hover the mouse over the road to display the yellow 
diamond symbol and click to create a connection point before continuing to draw. If you draw the 
line over the road without creating a connection point, routing along the intersection cannot 
occur. 

7. Once you have located the connection point for your new road, click the map to place the first point. Click 
point-to-point or drag to add the new road to the road layer. The road displays as a local road feature. The 
following information is available as you add each point in your road if the Show Measurement option is 
selected. 

• The coordinates of each point display in the corresponding text boxes. 
• The distance and bearing/angle of each new point from its previous point display in the 

corresponding text boxes. 
8. To finish the line draw for the new road, enter the last point on the map screen and click Done. The new 

road displays on the map with the name you typed in the Road Name text box. 
Note: You may also finish the line draw by pressing the ENTER key on your keyboard or double-clicking 
while entering the last point of the line. 

 

If you did not type a name in the Road Name text box before drawing your road, you can label the 
road at any time. For information on adding or editing the text on a routable road, see To Edit a 
Routable Road Line below. 

 

To Edit a Routable Road Line 
Once you have added a routable road to a road layer, you can edit the shape of the road or the text label on the road. 
Use the following steps to edit the shape of a routable road. 

1. Open the map file containing the road layer with the routable road you want to edit. 
2. Click the Draw tab to open the Draw dialog area. 
3. If the routable road you want to edit is not in the active draw file, click File and select the desired draw file 

from the draw file dialog area. Then, click Done. The Draw dialog area displays. 

4. Click the Select tool  and then click the routable road line you want to edit. 
• A box displays around the selected line. 
• The shape points used to create the line display as small, magenta squares. 

5. Perform any of the following edits to the routable road: 
• Edit any label on the routable road line by selecting the line twice, then typing the label in the text 

box which displays next to the line. 
OR 
Select the routable road line and edit the label in the Road Name text box in the Draw tab dialog 
area. 

• Reshape the line by dragging any of the points in the line to a new location. When you select a 
shape point of a line segment within an active line: 
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• A small green circle indicates the start end point of the selected line segment.  
• A small red circle indicates the last end point of the selected line segment. 

• Select the Coordinate or the Distance and Bearing/Angle option and edit their numbers. Click 
Apply to initiate the changes. 
Notes: 

• You can display either bearing or distance by clicking the drop-down arrow next to the 
Bearing or Angle text located below the distance text in the Distance and Bearing/Angle 
option. 

• You can also delete points and line segments from or add points to a line. For more 
information on points, deleting points and line segments, and adding points, see the 
following topics: 

• Draw Objects Overview on page 93 
• Deleting Points and Line Segments from Draw Objects on page 98 
• Adding Points to Draw Objects on page 98 

6. Click Done to finish your edit. 
OR 
Press the ENTER key on your keyboard. 
OR 
Click outside the object's active box on the map. 

To Place a Routable Road at a Specific Location 
You can also place a routable road line at a specific coordinate location. Use the following steps to place your 
routable road. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 
3. Click and hold the Routable Roads/Waypoints/Tracks tool to view its hidden options. Select the Routable 

Roads tool . 
4. Select the Coordinate option, or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option, and enter the appropriate coordinates or numbers into the corresponding text boxes to 
the right of the text style options box. 

5. Click Apply and repeat the procedure for the second point. The routable road line displays on the map at 
those coordinates, distance, and bearing or angle. 
OR 
After placing the first point coordinate, move your pointer to the map screen and place the other points by 
hand by clicking on the screen. 

6. You can then place additional points, lines, or other draw objects on the map in reference to the first line by 
entering a specific distance and bearing into the corresponding text boxes and clicking Apply. 

 

• While in Draw mode, you can use the Compass Rose or the white hands along the map edges 
to scroll the map. 

• To delete all routable roads from a draw file, click the Routable Roads tool  and then 
click Clear All. 

 

Editing a Track 
Once you have downloaded a track from a GPS receiver, you can edit the track on the map using the track tool 

. 

To Edit a Track 
Use the following steps to edit a track. 

1. Open the map file containing the draw file with the track you want to edit. 
2. Click the Draw tab to open the Draw dialog area. 
3. If the track you want to edit is not in the active draw file, click File and select the desired draw file from the 

draw file dialog area. Then, click Done. The Draw dialog area displays. 
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4. Click the Select tool  and then click the track you want to edit. 
• A box displays around the selected track. 
• The shape points used to create the line display as small, magenta squares. 

5. Change any of the track style, color, or weight options of the existing track. 
OR 
Change the track to a map line feature by clicking Map and then selecting the desired map track option. 

• Edit any label on a track by clicking the Select tool, selecting the line twice, then typing the label 
in the text box which displays next to the track. 

• Reshape the track by dragging any of the points in the line to a new location. When you select a 
shape point of a line segment within an active line: 

• A small green circle indicates the start end point of the selected track segment.  
• A small red circle indicates the last end point of the selected track segment. 

• Select the Coordinate or the Distance and Bearing/Angle option and edit their numbers. Click 
Apply to initiate the changes. 
Notes: 

• You can display either bearing or distance by clicking the drop-down arrow next to the 
Bearing or Angle text located below the distance text in the Distance and Bearing/Angle 
option. 

• You can also delete points and line segments from or add points to a track. For more 
information on points, deleting points and line segments, and adding points, see the 
following topics: 

• Draw Objects Overview on page 93 
• Deleting Points and Line Segments from Draw Objects on page 98 
• Adding Points to Draw Objects on page 98 

6. Click Done to finish your edit. 
OR 
Press the ENTER key on your keyboard. 
OR 
Click outside the object's active box on the map. 

Lines: Drawing, Editing, and Placing 
Street Atlas USA 2005 Plus lets you add custom lines to a draw file. You can adjust the line style, color, weight, 
and/or display it with map line features. 

To Draw a Line 
Draw a line point-by-point with each click of the mouse or drag to create a free-hand line on the map. 
Use the following steps to draw a line. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Line/Arc/Spline tool to view its hidden options. Select the Line tool . 
5. Select a line style from the Style drop-down list. 
6. Click the line color button (next to the Style drop-down list) to select a line color. 
7. If available, select a line width from the Width drop-down list. 

Note: The Width option is not available for all line styles. 
8. If available, select the Highlight check box to make your line appear translucent on the map. 

Note: The Highlight option is not available for all line styles. 
9. Select the Show Measurement check box to display information about the points on the map as you draw 

the line. As you add each point, a text box displays next to your pointer indicating the bearing or angle, leg 
(line segment) length, and total length of the whole line on the map.  
Note: Labels display when end points are clicked if the Show Measurement check box is selected. 
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10. Click the map to designate the start and end points of each line segment. 
OR 
Drag your cursor on the map. The line displays as a squiggly line. 

• The coordinates of each point display in the corresponding text boxes to the right of the line 
options.  

• The distance and bearing/angle of each new point from its previous point display in the 
corresponding text boxes. 

8. To finish the line, click the last point on the map screen and then click Done. 
OR 
Click the last point on the map screen and press the ENTER key on your keyboard. 
OR 
Double-click the last point of the line. 

9. To label your line, select the line twice, then type the label in the text box which displays next to the line. 

To Edit a Line 
Use the following steps to edit a line. 

1. Open the map file containing the draw file with the line you want to edit. 
2. Click the Draw tab to open the Draw dialog area. 
3. If the line you want to edit is not in the active draw file, click File and select the desired draw file from the 

draw file dialog area. Then, click Done. The Draw dialog area displays. 

4. Click the Select tool  and then click the line you want to edit. 
• A box displays around the selected line. 
• The shape points used to create the line display as small, magenta squares. 

Note: You can also edit multiple lines at once by dragging a box around the lines you want to edit. Any 
changes made in steps 5 will be made to all of the lines included in the box. 

5. Change any of the line style, color, or width (if available) options of the existing line. 
OR 
You can: 

• Edit any label on a line by selecting the line twice, then typing the label in the text box which 
displays next to the line. 

• Reshape the line by dragging any of the points in the line to a new location. When you select a 
shape point of a line segment within an active line: 

• A small green circle indicates the start end point of the selected line segment.  
• A small red circle indicates the last end point of the selected line segment. 

• Select the Coordinate option or the Distance and Bearing/Angle option and edit their numbers. 
Click Apply to initiate the changes. 
Notes: 

• You can display either bearing or distance by clicking the drop-down arrow next to the 
Bearing or Angle text located below the distance text in the Distance and Bearing/Angle 
option. 

• You can also delete points and line segments from or add points to a line. For more 
information on points, deleting points and line segments, and adding points, see the 
following topics: 

• Draw Objects Overview on page 93 
• Deleting Points and Line Segments from Draw Objects on page 98 
• Adding Points to Draw Objects on page 98 

6. Click Done to finish your edit. 
OR 
Press the ENTER key on your keyboard. 
OR 
Click outside the object's active box on the map. 

To Place a Line at a Specific Location 
Use the following steps to place a line. 



Street Atlas USA 2005 Plus User Guide 

104 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 

3. Click and hold the Line/Arc/Spline tool to view its hidden options. Select the Line tool . 
4. Determine the line, style, width (if available) and color for your line. 
5. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option, and enter the appropriate coordinates or numbers into the corresponding text boxes to 
the right of the text style options box. 

6. Click Apply and repeat the procedure for the second point. The line displays on the map at those 
coordinates, distance, and bearing or angle. 
OR 
After placing the first point coordinate, move your pointer to the map screen and place the other points by 
hand by clicking on the screen. 

7. You can then place additional points, lines, or other draw objects on the map in reference to the first line by 
entering a specific distance and bearing into the corresponding text boxes and clicking Apply. 

Arcs: Drawing, Editing, and Placing 
Street Atlas USA 2005 Plus lets you add arcs to a draw file. You can adjust the line style, color, weight, and or 
display it with map line features. 

To Draw an Arc 
An arc is created by entering only three points on the map. The first and second points determine the distance of the 
first arc base from the last arc base. The third point, placed between the first two, determines the radius of the arc 
and fixes the arc in place. 
Use the following steps to draw an arc. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Line/Arc/Spline tool to view its hidden options. Select the Arc tool . 
5. Select an arc style from the Style drop-down list. 
6. Click the arc color button (next to the Style drop-down list) to select a color for your arc. 
7. If available, select an arc width from the Width drop-down list. 

Note: The Width option is not available for all arc styles. 
8. If available, select the Highlight check box to make your arc appear translucent on the map. 

Note: The Highlight option is not available for all arc styles. 
9. Select the Show Measurement check box to display information about the points on the map as you draw 

the arc. 
• As you add the first and second points, a text box displays next to your pointer indicating the 

bearing or angle and total distance of the line between the two points on the map.  
• As you add the third point, a text box displays next to your pointer indicating the bearing or angle, 

radius of the arc, and total length of the entire arc line on the map. 
10. Click the map to designate the start and end points of the arc. 

Note: The coordinates of each point display in the corresponding text boxes to the right of the line options. 
11. To finish the arc line draw, click the last point on the map screen and click Done. 

OR 
Click the last point on the map screen and press the ENTER key on your keyboard. 
OR 
Double-click the last point of the arc line. 

To Edit an Arc 
Use the following steps to edit an arc. 

1. Open the map file containing the draw file with the arc you want to edit. 
2. Click the Draw tab to open the Draw dialog area. 
3. If the arc you want to edit is not in the active draw file, click File and select the desired draw file from the 

draw file dialog area. Then, click Done. The Draw dialog area displays. 
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4. Click the Select tool  and then click the arc line on the map. A box displays around the active line. 
The shape points used to create the line display as small, magenta squares, and the central radius lines 
appear as thin, black dashed lines meeting at a central crosshair. 
Note: You can also edit multiple arcs at once by dragging a box around the arcs you want to edit. Any 
changes made in steps 5 will be made to all of the arcs included in the box. 

5. Change any of the line style, color, or width (if available) options of the existing line. 
OR 
You can: 

 Change the radius, bearing or angle, and length of the arc on the map by dragging one of the end 
points. 

• A small green circle indicates the start end point of the arc line. 
• A small red circle indicates the last end point of the arc line. 

 Change the radius and length of the arc on the map by dragging the central magenta shape point at 
the top of the arc. 
Notes:  

• If you want to decrease the radius and length of the arc by moving one of the base 
endpoints toward the other, you must first slide the central shape point toward the base 
endpoint which is not being moved. Then move the desired endpoint towards the stable 
endpoint. 

• For more information on points, see Draw Objects Overview on page 93. 
 Select the Coordinate option or the Distance and Bearing/Angle option and edit their numbers. 

Click Apply to initiate the changes. 
Note: The Distance and Bearing/Angle text options are available for the two base points of the arc 
only. When the central shape point of the arc is selected, the text options change from Distance 
and Bearing/Angle to Radius and Direction. These settings can also be edited. 

6. Click Done to finish your edit. 
OR 
Press the ENTER key on your keyboard. 
OR 
Click outside the object's active box on the map. 

To Place an Arc at a Specific Location 
Use the following steps to place an arc. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 

3. Click and hold the Line/Arc/Spline tool to view its hidden options. Select the Arc tool . 
4. Determine the line, style, width, and color for your arc. 
5. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option and enter the appropriate coordinates or numbers into the corresponding text boxes to the 
right of the text style options box. 
Note: Enter new numbers into Distance and Bearing/Angle text boxes for the two base points of the arc 
only. When the central shape point of the arc is selected, the text options change from Distance and 
Bearing/Angle to Radius and Direction. Enter the appropriate radius number and direction to change the 
radius for this point. 

6. Click Apply and repeat the procedure for the second point. The arc displays on the map at those 
coordinates, distance, and bearing or angle. 

7. You can then place additional points, arcs, or other draw objects on the map in reference to the first arc by 
entering a specific distance and bearing into the corresponding text boxes and clicking Apply. 

Splines: Drawing, Editing, and Placing 
Street Atlas USA 2005 Plus lets you add custom curved lines to a draw file to represent more curved map features or 
boundaries. You can adjust the line style, color, weight, and or display it with map line features. 
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To Draw a Spline 
As you draw a spline, points are entered in much the same way as those entered when creating a line. The difference 
between a line and a spline is that when you enter each point, the line segment between the points curves instead of 
staying straight. 
Use the following steps to draw a spline. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Line/Arc/Spline tool to view its hidden options. Select the Spline tool . 
5. Select a spline style from the Style drop-down list. 
6. Click the spline color button (next to the Style drop-down list) to select a line color. 
7. If available, select a spline width from the Width drop-down list. 

Note: The Width option is not available for all spline styles. 
8. If available, select the Highlight check box to make your spline appear translucent on the map. 

Note: The Highlight option is not available for all spline styles. 
9. Select the Show Measurement check box to display information about the points on the map as you draw 

the spline. As you add each point, a text box displays next to your pointer indicating the bearing or angle, 
leg (line segment) length, and total length of the whole spline on the map.  

10. Click the map to enter the start and end points of each line segment.  
 The coordinates of each point display in the corresponding text boxes to the right of the line 

options. 
 The distance and bearing/angle of each new point from its previous point display in the 

corresponding text boxes. 
11. To finish the spline draw, click the last point on the map screen and click Done. 

OR 
Click the last point on the map screen and press the ENTER key on your keyboard. 
OR 
Double-click the last point of the spline. 

To Edit a Spline 
Use the following steps to edit a spline. 

1. Open the map file containing the draw file with the spline you want to edit. 
2. Click the Draw tab to open the Draw dialog area. 
3. If the spline you want to edit is not in the active draw file, click File and select the desired draw file from 

the draw file dialog area. Then, click Done. The Draw dialog area displays. 

4. Click the Select tool  and then click the spline on the map. A box displays around the active spline 
and the shape points used to create the spline display as small, magenta squares. 
Note: You can also edit multiple splines at once by dragging a box around the splines you want to edit. Any 
changes made in steps 5 will be made to all of the splines included in the box. 

5. Change any of the line style, color, or width (if available) options of the existing spline. 
OR 
You can: 

 Reshape the spline by dragging any of the points in the spline to a new location. Moving or 
deleting points on a spline reshapes the curve of the feature. When you select a shape point of a 
line segment within an active spline: 

• A small green circle indicates the start end point of the selected line segment.  
• A small red circle indicates the last end point of the selected line segment. 

 Select the Coordinate option or the Distance and Bearing/Angle option and edit their numbers. 
Click Apply to initiate the changes. 
Notes:  

• You can display either bearing or distance by clicking the drop-down arrow next to the 
Bearing or Angle text located below the distance text in the Distance and Bearing/Angle 
option. 
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• You can also delete points and line segments from or add points to a spline. For more 
information on points, deleting points and line segments, and adding points, see the 
following topics: 

• Draw Objects Overview on page 93 
• Deleting Points and Line Segments from Draw Objects on page 98 
• Adding Points to Draw Objects on page 98 

6. Click Done to finish your edit. 
OR 
Press the ENTER key on your keyboard. 
OR 
Click outside the object's active box on the map. 

To Place a Spline at a Specific Location 
Use the following steps to place a spline. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 

3. Click and hold the Line/Arc/Spline tool to view its hidden options. Select the Spline tool . 
4. Determine the line, style, width (if available), and color for your spline. 
5. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option, and enter the appropriate coordinates or numbers into the corresponding text boxes to 
the right of the text style options box. 

6. Click Apply and repeat the procedure for the second point. The spline displays on the map at those 
coordinates, distance, and bearing or angle. 
OR 
After placing the first point coordinate, move your pointer to the map screen and place the other points by 
hand by clicking on the screen. 

7. You can then place additional points, splines, or other draw objects on the map in reference to the first 
spline by entering a specific distance and bearing into the corresponding text boxes and clicking Apply. 

Joining and Breaking Linear Objects 
With Street Atlas USA 2005 Plus, you can join two or more routable roads, tracks, lines, arcs, or splines into a 
single entity. You can also break routable roads, tracks, lines, or splines. 

 

You cannot break arcs. 

To Join 
Use the following steps to join linear objects. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click the Select tool , press and hold the SHIFT key on the keyboard, and select any lines, arcs, or 
splines you want to join.  
OR 

Click the Select tool  and drag a box around the linear objects you want to join. 
Notes: When joining the preceding types of line objects, you can mix and match lines, arcs, and splines. 
The result is always a line. However, when you join multiple splines, the resulting joined object is a spline. 

5. Press CTRL+N on the keyboard. The selected lines are joined. 
Note: Any other objects selected during the multi-select process are ignored. 

To Break 
Use the following steps to break linear objects. 

1. Click the Draw tab to open the Draw dialog area. 
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2. Create a new draw file or edit an existing draw file. 

3. Click the Select tool  and select the line object you want to break. 
• A box displays around the active line. 
• The shape points used to create the line display as small, magenta squares. 

4. Click the shape point where you want to break the line and press CTRL+B on your keyboard. The line is 
broken into two segments at the designated point and each line can be edited separately. 
Note: It is important that you perform steps 3 and 4 consecutively. If you pan the map, use another tab, etc. 
between steps, you may need to repeat the steps again to break your linear object. 

Area Objects 

Area Objects Overview 
Street Atlas USA 2005 Plus lets you add area draw objects to a draw file in your current map file. Area objects are 
those objects consisting of one or more closed line objects. Most of the area draw object tools are hidden draw tools. 
Hidden draw tools are those which have a small arrow at the bottom-right of the draw tool symbol as shown in this 

sample . 
Once you have created an area draw object it can be edited (including reshaping or changing line color or weight), 
copied, moved, or deleted at any time. The following table lists the area objects you can add and the suggested uses 
of each. 
 
Area Object Tool Used Suggested Use 
Polygons 

 
Use polygons to designate water bodies, land boundaries, or any other 
irregular map feature. Obtain the area of the polygon by adding a detailed 
MapNote using the right-click function. 

Rectangles 
 

Use rectangles to designate land boundaries or any other rectangular map 
feature. Obtain the area of the rectangle by adding a detailed MapNote 
using the right-click function. 

Circles 
 

Use circles to designate circular map features. Obtain the area of the circle 
by adding a detailed MapNote using the right-click function. 

 

Circles: Drawing, Editing, and Placing 
Street Atlas USA 2005 Plus lets you add circles to a draw file. 

To Draw a Circle 
Use the following steps to draw a circle. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Polygon/Rectangle/Circle tool to view its hidden options. Select the Circle tool . 
5. From the Fill drop-down list, select the fill style you want to apply to the circle. 
6. Click the fill color button (to the right of the Fill drop-down list) to select the color for your fill style. 
7. Select an outline style for your circle from the Outline drop-down list. 
8. Click the outline color button to select a color for the outline of your circle. 
9. Select the width for your circle outline from the Width drop-down list. 
10. Select the Show Measurement check box to display area and radius information on the map as you draw 

the circle. 
11. Click the location for the circle's center on the map and drag away from center to set the radius for the 

circle. Release as soon as the desired radius is achieved.  
The radius of the circle and the coordinates of the circle's center display in the corresponding text boxes to 
the right of the circle fill option area. 
Note: Labels display when end points are clicked if the Show Measurement check box is selected. 
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12. Click the Select tool  and then click the desired circle on the map. A box displays around the circle 
indicating that it is active and a small crosshair indicates the center of the circle.  

13. Click the circle again. A text box displays. Type the desired label in the text box and press the ENTER key 
on your keyboard. 

 

Obtain the area of the circle by adding a detailed MapNote using the right-click function. 

 

To Edit a Circle 
Use the following steps to edit a circle. 

1. Open the map file containing the draw file with the circle you want to edit. 
2. Click the Draw tab to open the Draw dialog area. 
3. If the circle you want to edit is not in the active draw file, click File and select the desired draw file from 

the draw file dialog area. Then, click Done. The Draw dialog area displays. 

4. Click the Select tool  and then click the desired circle on the map. A box displays around the circle 
indicating that it is active and a small crosshair indicates the center of the circle.  
OR 

To edit multiple circles, click the Select tool  and then drag a box around the circles that you want to 
edit. 

5. Change the circle fill, outline, and/or width option. 
OR 
If you selected a single circle, drag one of the magenta squares around the circle to change the circle's size. 
The center of the circle remains in its original location. 

6. Press the ENTER key on your keyboard to finish your edit. 
OR 
Click outside the object's active box on the map. 

To Place a Circle at a Specific Location 
Use the following steps to place a circle. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 

3. Click and hold the Polygon/Rectangle/Circle tool to view its hidden options. Select the Circle tool . 
4. Select the desired circle fill, outline, and/or width options. 
5. Enter the desired coordinates for the circle's center into the corresponding text boxes. 
6. Enter the desired radius for the circle into the radius text box. 
7. Click Apply. The circle displays on the map at those coordinates with the desired radius. 

Rectangles: Drawing, Editing, and Placing 
Street Atlas USA 2005 Plus lets you add filled rectangles to a draw file. 

To Draw a Rectangle 
Use the following steps to draw a rectangle. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 
4. Click and hold the Polygon/Rectangle/Circle tool to view its hidden options. Select the Rectangle tool 

. 
5. From the Fill drop-down list, select the fill style you want to apply to the rectangle. 
6. Click the fill color button (to the right of the Fill drop-down list) to select the color for your fill style. 
7. Select an outline style for your rectangle from the Outline drop-down list. 
8. Click the outline color button to select a color for the outline of your rectangle. 
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9. Select the width for your rectangle outline from the Width drop-down list. 
10. Select Show Measurement to display information on the width, height, and area on the map as you draw 

the rectangle. 
Note: Labels display when end points are clicked if the Show Measurement check box is selected. 

11. Click the location for the rectangle's upper-left corner on the map and drag away from the corner to set the 
width, height, and area for the rectangle. Release as soon as the desired size is achieved.  

• The coordinates of the upper-left corner point displays in the corresponding text boxes to the right 
of the fill options.  

• The distance and bearing/angle of the final corner point from the first corner point displays in the 
corresponding text boxes to the right of the fill options. 

 

Obtain the area of the rectangle by adding a detailed MapNote using the right-click function. 

 

To Edit a Rectangle 
Use the following steps to edit a rectangle. 

1. Open the map file containing the draw file with the rectangle you want to edit. 
2. Click the Draw tab to open the Draw dialog area. 
3. If the rectangle you want to edit is not in the active draw file, click File and select the desired draw file 

from the draw file dialog area. Then, click Done. The Draw dialog area displays.. 

4. Click the Select tool  and then click the desired rectangle on the map. A dotted-line box displays 
around the rectangle indicating that it is active and the corner points display as small, magenta boxes. 
OR 

To edit multiple rectangles, click the Select tool  and then drag a box around the rectangles that you 
want to edit. 

5. Change the rectangle fill, outline, and/or width option. 
OR 
If you selected to edit a single rectangle, click on one of the corner points of the rectangle and drag to 
change it's width, height, and area on the map. 

6. Click Done to finish your edit. 
OR 
Press the ENTER key on your keyboard to finish your edit. 
OR 
Click outside the object's active box on the map. 

To Place a Rectangle at a Specific Location 
Use the following steps to place a rectangle. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 
3. Click and hold the Polygon/Rectangle/Circle tool to view its hidden options. Select the Rectangle tool 

. 
4. Select the desired rectangle fill, outline, and/or width options. 
5. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option. Enter the appropriate coordinates or numbers for the rectangle's upper-left corner point 
into the corresponding text boxes to the right of the fill options box. 

6. Click Apply and move your pointer to the map screen. A black line box appears on the screen outlining the 
width, height, and area of the desired rectangle. Click to lock the rectangle dimensions on the map. The 
completed rectangle displays on the map. 
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Polygons: Drawing, Editing, and Placing 
Street Atlas USA 2005 Plus lets you add polygons to a draw file. 

To Draw a Polygon 
Use the following steps to draw a polygon. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Polygon/Rectangle/Circle tool to view its hidden options. Select the Polygon tool . 
5. From the Fill drop-down list, select the fill style you want to apply to the polygon. 
6. Click the fill color button (to the right of the Fill drop-down list) to select the color for your fill style. 
7. Select an outline style for your polygon from the Outline drop-down list. 
8. Click the outline color button to select a color for the outline of your polygon. 
9. Select the width for your polygon outline from the Width drop-down list. 
10. Select the Show Measurement check box to display information on the bearing or angle, leg (line 

segment) length between points, and area on the map as you draw the polygon. 
Note: Labels display when end points are clicked if the Show Measurement check box is selected. 

11. Click the map to enter each point of the polygon.  
 The coordinates of each point display in the corresponding text boxes to the right of the fill 

options.  
 The distance and bearing/angle of each new point from its previous point display in the 

corresponding text boxes. 
8. To finish the polygon, click the last point on the map screen and click Done 

OR 
Click the last point on the map screen and press the ENTER key on your keyboard. 
OR 
Double-click the last point of the line. 

 

Obtain the area of the polygon by adding a detailed MapNote using the right-click function. 

 

To Edit a Polygon 
Use the following steps to edit a polygon. 

1. Open the map file containing the draw file with the polygon you want to edit. 
2. Click the Draw tab to open the Draw dialog area. 
3. If the polygon you want to edit is not in the active draw file, click File and select the desired draw file from 

the draw file dialog area. Then, click Done. The Draw dialog area displays. 

4. Click the Select tool  and then click the desired polygon on the map. A box displays around the 
polygon indicating that it is active. Shape points display as small, magenta boxes. 
OR 

To edit multiple polygons, click the Select tool  and then drag a box around the polygons that you 
want to edit. 

5. Change the polygon fill, width, and/or outline option. 
OR 
If you selected to edit a single polygon, click on one of the shape points of the polygon and drag to change 
its bearing or angle, the leg length, and polygon area on the map. 

 Reshape the polygon by dragging any of the points in the polygon to a new location. When you 
select a shape point of a line segment within an active polygon: 

• A small green circle indicates the start end point of the selected line segment.  
• A small red circle indicates the last end point of the selected line segment. 
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 Select the Coordinate option or the Distance and Bearing/Angle option and edit their numbers. 
Click Apply to initiate the changes. 
Notes:  

• You can display either bearing or distance by clicking the drop-down arrow next to the 
Bearing or Angle text located below the distance text in the Distance and Bearing/Angle 
option. 

• You can also delete points and line segments from or add points to a polygon. For more 
information on points, deleting points and line segments, and adding points, see the 
following topics: 

• Draw Objects Overview on page 93 
• Deleting Points and Line Segments from Draw Objects on page 98 
• Adding Points to Draw Objects on page 98 

6. Click Done to finish your edit. 
OR 
Press the ENTER key on your keyboard to finish your edit. 
OR 
Click outside the object's active box on the map to finish your edit. 

To Place a Polygon at a Specific Location 
Use the following steps to place a polygon. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 

3. Click and hold the Polygon/Rectangle/Circle tool to view its hidden options. Select the Polygon tool . 
4. Select the desired polygon fill, width, and/or outline options. 
5. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option, and enter the appropriate coordinates or numbers for the first polygon point into the 
corresponding text boxes to the right of the fill options box. 

6. Click Apply and repeat the procedure for the other points. The polygon displays on the map at those 
coordinates. 

7. You can then place additional points, polygons, or other draw objects on the map in reference to a polygon 
point. Enter a specific distance and bearing into the corresponding text boxes and click Apply. 

Point Objects Overview 
Street Atlas USA 2005 Plus lets you add point draw objects to a draw file in your current map file. Point objects 
consist of one anchor point attached to either a symbol, MapNote, image, or text label. The anchor point is the pixel 
position on the symbol which corresponds to the geographic coordinate of the point selected on the map when the 
symbol is placed.  
The point object tools are within one of the hidden draw tools. Hidden draw tools are those which have a small 

arrow at the bottom-right of the draw tool symbol as shown in this sample . 
Once you have added a point object to a draw file, it can be edited (name only), copied, moved, or deleted at any 
time. The following table lists the point objects you can add and the suggested uses of each. 
Point Object Tool Used Suggested Use 
Waypoints 

 
Use the waypoints tool to label waypoints on a map. Waypoints can be 
uploaded to a GPS receiver or downloaded from a GPS receiver. 

Symbols 
 

Use symbols to identify certain areas on the map such as houses, 
monuments, or points of interest. 

MapNotes 
 

Use MapNotes to point to and label a specific area on the map. 

Text Labels 
 

Use text labels to name features or give details about features on the map. 
Note: Text labels do not offer border or fill colors. To make your object 
name more noticeable, change the font size or font color. 

Images 
 

Use the image tool to add, edit, or place .bmp, .jpg, and .gif images on the 
map. 
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XSym lets you create and edit your own custom symbols which can then be added to maps within 
DeLorme mapping applications. For more information on XSym, see Help topics under Custom 
Symbols. 

 

Waypoints: Adding, Editing, and Placing 
Street Atlas USA 2005 Plus lets you add waypoints to your map which can later be uploaded to a GPS device, 
Pocket PC device, or Palm OS device. 

 

• Any draw file you create can be added to multiple map files. 
• Five draw tool options provide pull-out menus with hidden tools.  
• You can search for a waypoint by its name using the QuickSearch function in the Find tab or 

by typing the name in the start, finish, stop, or via text boxes when creating a route in the 
Route tab. 

To Add a Waypoint 
Use the following steps to add a waypoint. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 
4. Click and hold the Routable Roads/Waypoints/Tracks tool to view its hidden options. Select the Waypoints 

tool . The pointer displays a flag symbol and the Symbol Selection area displays. 
5. Select the desired waypoint symbol from the Symbols options. You may also select a different font, style, 

size, and color for the waypoint name. 
6. Click the location for the waypoint on the map and type the name or phrase into the text box which displays 

next to the waypoint. 
Note: Press the ESC key on your keyboard to cancel the text edit.  

 The coordinates of each point display in the corresponding text boxes to the right of the font 
options.  

 The distance and bearing/angle of each new point from its previous point display in the 
corresponding text boxes. 

7. Press the ENTER key on your keyboard or click the map outside of the waypoint's active area when you are 
finished editing the waypoint. 

Tips: 
• When editing, moving, or deleting a waypoint, click Undo to undo the last action. If you decide not 

to undo the last action, click Redo. 
• You can display either bearing or distance by clicking the drop-down arrow next to the Bearing or 

Angle text located below the distance text in the Distance and Bearing/Angle option. 

To Edit the Name of a Waypoint 
Use the following steps to edit the text label for an existing waypoint in Street Atlas USA 2005 Plus. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click the Select tool . 
5. Click the desired waypoint on the map. A box displays around the waypoint indicating it is selected. 
6. Click the waypoint again to activate the text box. Type a new name or change the name's font, style, size, 

or color. You can also choose another symbol to represent your data. 
7. Press the ENTER key on your keyboard or click the map outside of the waypoint's active area when you are 

finished editing the waypoint. 
Tip: When editing, moving, or deleting a waypoint, click Undo to undo the last action. If you decide not to 
undo the last action, click Redo. 
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To Place a Waypoint at a Specific Location 
Use the following steps to place a waypoint at a specific location on a map in Street Atlas USA 2005 Plus. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 
4. Click and hold the Routable Roads/Waypoints/Tracks tool to view its hidden options. Select the Waypoints 

tool . The pointer displays a flag symbol and the Symbol Selection area displays. 
5. Select the desired waypoint symbol from the Symbols options. You may also select a different font, style, 

size and color for the waypoint name. 
6. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option, and enter the appropriate coordinates or numbers into the corresponding text boxes to 
the right of the font options. (See Note below.) 

7. Click Apply. The waypoint displays on the map at those coordinates or distance and bearing/angle 
locations.  
Note: To use the Distance and Bearing/Angle option with a waypoint, you  must first have a waypoint 
placed on the map. The distance and bearing/angle numbers are entered in relationship to the LAST 
waypoint you added to the map. 

Tips: 
 While in Draw mode, you can use the Compass Rose, map edges, or Overview Map to scroll the 

map. 
 When editing, moving, or deleting a waypoint, click Undo to undo the last action. If you decide not 

to undo the last action, click Redo. 

Symbols: Adding, Editing, and Placing 
Street Atlas USA 2005 Plus lets you incorporate both symbols and text in a draw file under the Draw tab. Choose a 
symbol to represent a place (e.g., flag, map pin, square, etc.) and then label it with text. The text entered becomes the 
symbol's name which can be used to locate the symbol in the Find tab. For more information, see Finding a Symbol 
by Its Name on page 90. 

 

• You can search for a symbol by its label name using the QuickSearch function in the Find tab or 
by typing the label name in the start, finish, stop, or via text boxes when creating a route in the 
Route tab. 

• When viewing a hyperlinked symbol on the map, the symbol will display as an active hyperlink. 
If you want to click on the symbol without opening the hyperlink, press the CTRL key on your 
keyboard while you click the symbol. 

 

To Add a Symbol 
Use the following steps to add a symbol. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Symbol/Image tool to view its hidden options. Select the Symbol tool . The 
pointer displays a flag symbol and the Symbol Selection area displays. 

5. Under Symbols, select the desired symbol set from the available drop-down list. Then, select the desired 
symbol. You may also select a different font, style, size, and color for the symbol name. 
OR 
Under Symbols, click Edit and design a symbol to be placed on the map. For more information on creating 
custom symbols, see Help topics under Custom Symbols. 

6. If you want to reduce the size of your symbol to a point symbol at and above a certain zoom level, select 
the zoom level you want to reduce it to from the Reduce Size at Zoom drop-down list.  

7. Click the desired location for the symbol. The URL/Label text box displays. 
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Click the hyperlink button  and browse to the document you want to hyperlink your symbol to 
(optional). The address displays in the URL field. Then, type the name or phrase into the Label field. 
Note: Press the ESC key on your keyboard to cancel the text edit.  

 The coordinates of each point display in the corresponding text boxes to the right of the line 
options.  

 The distance and bearing/angle of each new point from its previous point display in the 
corresponding text boxes. 

7. Press the ENTER key on your keyboard or click the map outside of the symbol's active area when you are 
finished editing the symbol. 

Tips: 
• When editing, moving, or deleting a symbol, click Undo to undo the last action. If you decide not to 

undo the last action, click Redo. 
• You can display either bearing or distance by clicking the drop-down arrow next to the Bearing or 

Angle text located below the distance text in the Distance and Bearing/Angle option. 

To Edit the Name of a Symbol 
Use the following steps to edit the text label for an existing symbol in Street Atlas USA 2005 Plus. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click the Select tool  and click the symbol again.  
Note: You can also edit multiple symbols at once by dragging a box around the symbols you want to edit. 
Any changes made in steps 5 will be made to all of the symbols included in the box. 

5. Click the hyperlink button  to change the URL address, type a new name or phrase into the Label field, 
or change the name's font, style, size, or color. You can also choose another symbol to represent your data. 

7. Press the ENTER key on your keyboard or click the map outside of the symbol's active area when you are 
finished editing the symbol. 
Tip: When editing, moving, or deleting a symbol, click Undo to undo the last action. If you decide not to 
undo the last action, click Redo. 

To Place a Symbol at a Specific Location 
Use the following steps to place a symbol at a specific location on a map in Street Atlas USA 2005 Plus. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Symbol/Image tool to view its hidden options. Select the Symbol tool . The 
pointer displays a flag symbol and the Symbol Selection area displays. 

5. Select the desired symbol from the Symbol Selection. You may also select a different font, style, size and 
color for the symbol name. 

6. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 
Coordinate option, and enter the appropriate coordinates or numbers into the corresponding text boxes to 
the right of the Symbols group box. (See Note below.) 

7. Click Apply. The symbol displays on the map at those coordinates or distance and bearing/angle locations. 
Note: To use the Distance and Bearing/Angle option with a symbol, you must first have a symbol placed on 
the map. The distance and bearing/angle numbers are entered in relationship to the LAST symbol you 
added to the map. 

Tips: 
 To view statistical information for a symbol, right-click a symbol and click Info from the shortcut 

menu. The symbol URL, label, coordinate information, as well as demographic information display 
in the Info tab. 

 While in Draw mode, you can use the Compass Rose, map edges, or Overview Map to scroll the 
map. 
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 When editing, moving, or deleting a symbol, click Undo to undo the last action. If you decide not to 
undo the last action, click Redo. 

MapNotes: Adding, Editing, and Placing 
You can add your own MapNotes to a map in Street Atlas USA 2005 Plus. MapNotes have a white background that 
make them highly visible on the map. They can contain multiple lines of text and can be moved off of the labeled 
area without losing their visual links with the points. You can use MapNotes for directions or explanations. 
Street Atlas USA 2005 Plus supports all standard Windows® fonts as well as a variety of styles, sizes, and colors. 
Click the Font, Style, Size, and Color drop-down lists to select a text style option. 

 

• When you use right-click functionality to add a MapNote, it is light blue unless it is a blank 
MapNote. 

• Five draw tool options provide pull-out menus with hidden tools.  
• You can search for a MapNote by its label name using the QuickSearch function in the Find 

tab or by typing the label name in the start, finish, stop, or via text boxes when creating a 
route in the Route tab. 

• When viewing a hyperlinked MapNote on the map, the MapNote will display as an active 
hyperlink. If you want to click on the MapNote without opening the hyperlink, press the 
CTRL key on your keyboard while you click the MapNote. 

To Add a MapNote to the Map 
A MapNote consists of a text box with an anchor point which points to a specific location on the map. 
Use the following steps to add a MapNote. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the MapNote/Text Label tool to view its hidden options. Select the MapNote tool . 
5. Select the desired font, style, size, and color from the text style options. A sample of how your text will 

display appears to the left of the options. 
6. If you want to reduce the size of your MapNote to a point symbol at and above a certain zoom level, select 

the zoom level you want to reduce it to from the Reduce Size at Zoom drop-down list.  
7. Click the desired location for your MapNote on the map. The URL/Label text box displays. 

 
Click the hyperlink button  and browse to the document you want to hyperlink your MapNote to 
(optional). The address displays in the URL field. Then, type the name or phrase into the Label field.  The 
coordinates or distance and bearing/angle numbers of the location display in the corresponding Coordinate 
or Distance and Bearing/Angle text boxes.  
Note: Press SHIFT+ENTER or CTRL+ENTER to type additional lines of text in the Label field. 

8. Press the ENTER key on your keyboard or click the map outside of the MapNote active area when you are 
finished. 
Tip: If you add another MapNote to the map, its distance and bearing from the previous MapNote display 
in the corresponding text boxes. 

To Edit a MapNote 
Use the following steps to edit a MapNote. 

1. Click the Draw tab to open the Draw dialog area. 
2. Edit an existing draw file. 

3. Click the Select tool  and then click twice on the desired MapNote on the map. The URL/Label text 
box of the MapNote becomes active. 
Note: You can also edit multiple MapNotes at once by dragging a box around the MapNotes you want to 
edit. Any changes made in steps 4 will be made to all of the MapNotes included in the box. 

4. Select the desired font, style, size, and color from the text style options if you wish to change the look of 
the label text. A sample of how your text display appears to the left of the options and the text updates in 
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the text box on the map screen. 
OR 
Click within the Label text box on the map screen and type to edit the current text. 
Note: Press SHIFT+ENTER or CTRL+ENTER to type additional lines of text in the Label field. 
OR 

Click the hyperlink button  and edit the URL. 
5. Press the ENTER key on your keyboard or click the map outside of the text label active area when you are 

finished. 

To Place a MapNote at a Specific Location 
Use the following steps to place a MapNote. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 

3. Click and hold the MapNote/Text Label tool to view its hidden options. Select the MapNote tool . 
4. Select the desired font, style, size, and color from the text style options. A sample of how your text display 

appears to the left of the options. 
5. Select the Coordinate option, or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option, and type the appropriate coordinates or numbers into the corresponding text boxes to the 
right of the text style options box (see Notes below). 

6. Click Apply. The MapNote displays on the map at those coordinates, distance, and bearing or angle. 
7. Enter the desired text and press the ENTER key on your keyboard or click the map outside of the text label 

active area when you are finished. 

 

• To use the Distance and Bearing/Angle option with a text label, you must first have another 
text label placed on the map. The distance and bearing/angle numbers are entered in 
relationship to the LAST text label you added to the map. 

• You can display either bearing or distance by clicking the drop-down arrow next to the 
Bearing or Angle text located below the distance text in the Distance and Bearing/Angle 
option. 

• While in Draw mode, you can use the Compass Rose or the arrows along the map edges to 
scroll the map. 

• To view statistical information for a MapNote, right-click a MapNote and click Info from 
the shortcut menu. The MapNote URL, label, coordinate information, as well as 
demographic information display in the Info tab. 

Text Labels: Adding, Editing, and Placing 
You can add your own text labels to maps in Street Atlas USA 2005 Plus. Text labels allow you to create labels for 
map features or points of interest. Street Atlas USA 2005 Plus supports all standard Windows® fonts as well as a 
variety of styles, sizes, and colors. Click the Font, Style, Size, and Color drop-down lists to select a text style 
option. 

 

• The Text Label tool is part of one of five draw tool options which provide pull-out menus with 
hidden tools.  

• You can search for a symbol by its label name using the QuickSearch function in the Find tab or 
by typing the label name in the start, finish, stop, or via text boxes when creating a route in the 
Route tab. 

• When viewing a hyperlinked text label on the map, the text label will display as an active 
hyperlink. If you want to click on the text label without opening the hyperlink, press the CTRL 
key on your keyboard while you click the text label. 

To Add a Text Label to the Map 
Use the following steps to add a text label.  

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 



Street Atlas USA 2005 Plus User Guide 

118 

4. Click and hold the MapNote/Text Label tool to view its hidden options. Select the Text Label tool . 
5. Select the desired font, style, size, and color from the text style options. A sample of how your text will 

display appears to the left of the options. 
6. If you want to reduce the size of your text label to a point symbol at and above a certain zoom level, select 

the zoom level you want to reduce it to from the Reduce Size at Zoom drop-down list.  
7. Click the desired location for the text label on the map. The URL/Label text box displays. 

 
Click the hyperlink button  and browse to the document you want to hyperlink your text label to 
(optional). The address displays in the URL field. Then, type the name or phrase into the Label field. The 
coordinates or distance and bearing/angle numbers of the location display in the corresponding Coordinate 
or Distance and Bearing/Angle text boxes.  

8. Press the ENTER key on your keyboard or click the map outside of the text label active area when you are 
finished. 
Note: If you add another text label to the map, its distance and bearing or angle from the previous text label 
displays in the corresponding text boxes. 

To Edit a Text Label 
Use the following steps to edit a text label. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 

3. Click the Select tool  and then click twice on the desired text label on the map. The URL/Label text 
box becomes active. 
Note: You can also edit multiple text labels at once by dragging a box around the text labels you want to 
edit. Any changes made in steps 4 will be made to all of the text labels included in the box. 

4. Select the desired font, style, size, and color from the text style options if you wish to change the look of 
the label text. A sample of how your text will display appears to the left of the options and the text updates 
in the text box on the map screen. 
OR 
Click within the Label field on the map screen and type to edit the current text. 
OR 

Click the hyperlink button  and edit the URL. 
5. Press the ENTER key on your keyboard or click the map outside of the text label active area when you are 

finished. 

To Place a Text Label at a Specific Location 
Use the following steps to place a text label. 

1. Click the Draw tab to open the Draw dialog area. 
2. Create a new draw file or edit an existing draw file. 

3. Click and hold the MapNote/Text Label tool to view its hidden options. Select the Text Label tool . 
4. Select the desired font, style, size, and color from the text style options. A sample of how your text display 

appears to the left of the options. 
5. Select the Coordinate option, or use the Distance and Bearing/Angle option in conjunction with the 

Coordinate option, and type the appropriate coordinates or numbers into the corresponding text boxes to the 
right of the text style options box. (See Notes below.) 

6. Click Apply. The text label and its text box display on the map at those coordinates, distance, and bearing 
or angle. 

7. Enter the desired text and press the ENTER key on your keyboard or click the map outside of the text label 
active area when you are finished. 

 

• To view statistical information for a text label, right-click a text label and click Info from 
the shortcut menu. The text label URL, label, coordinate information, as well as 
demographic information display in the Info tab. 
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• To use the Distance and Bearing/Angle option with a text label, you must first have 
another text label placed on the map. The distance and bearing/angle numbers are entered in 
relationship to the LAST text label you added to the map. 

• While in Draw mode, you can use the Compass Rose or the arrows along the map edges to 
scroll the map. 

Images: Adding, Editing, and Placing 
With Street Atlas USA 2005 Plus, you can add, edit, or place .bmp, .jpg, and .gif images to your map using the 
Image tool in the Draw tab. 

 

• Five draw tool options provide pull-out menus with hidden tools.  
• You can search for an image by its label name using the QuickSearch function in the Find tab or 

by typing the label name in the start, finish, stop, or via text boxes when creating a route in the 
Route tab. 

• If an image is larger than 1/5 of the screen height or width (resolution), the image size is reduced 
to 320 x 200 pixels. 

• When viewing a hyperlinked image on the map, the image will display as an active hyperlink. If 
you want to click on the image without opening the hyperlink, press the CTRL key on your 
keyboard while you click the image. 

To Add an Image to Your Map 
Use the following steps to add an image to your map. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Symbol/Image tool to view its hidden options. Select the Image tool .  
5. Under Images, select an existing image. 

OR 
Click Add, browse to an image, and click Open to add a new image to your Images selection. 
Note: You can delete an image from the Images selection by selecting the image and then clicking Delete. 

6. If you want to reduce the size of your image to a point symbol at and above a certain zoom level, select the 
zoom level you want to reduce it to from the Reduce Size at Zoom drop-down list.  

7. Click the location on the map where you want to add the image. The URL/Label text box displays. 

 
Click the hyperlink button  and browse to the document you want to hyperlink your image to 
(optional). The address displays in the URL field. Then, type the name or phrase into the Label field. 
Note: Press the ESC key on your keyboard to cancel the text edit.  

• The coordinates of each point display in the corresponding text boxes to the right of the line 
options.  

• The distance and bearing/angle of each new point from its previous point display in the 
corresponding text boxes. 

7. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 
Coordinate option and enter the appropriate coordinates or numbers into the corresponding text boxes. 
Then, click Apply. 
Note: Enter new numbers into Distance and Bearing/Angle text boxes for the two base points of the arc 
only. When the central shape point of the arc is selected, the text options change from Distance and 
Bearing/Angle to Radius and Direction. Enter the appropriate radius number and direction to change the 
radius for this point. 

To Edit an Image's Hyperlink Information 
Use the following steps to edit the text label for an existing image in Street Atlas USA 2005 Plus. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
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3. Create a new draw file or edit an existing draw file. 

4. Click the Select tool . 
5. Click the image twice.  

6. Click the hyperlink button  to change the URL address, type a new name or phrase into the Label field, 
or change the name's font, style, size, or color. 
Note: You can edit multiple labels font, style, size, or color by dragging a box around the images whose 
labels you want to edit and then making the desired changes. 

7. Press the ENTER key on your keyboard or click the map outside of the image's active area when you are 
finished editing the image. 
Tip: When editing, moving, or deleting an image, click Undo to undo the last action. If you decide not to 
undo the last action, click Redo. 

To Place an Image at a Specific Location 
Use the following steps to place an image at a specific location on a map in Street Atlas USA 2005 Plus. 

1. Open an existing map file or create a new one. 
2. Click the Draw tab to open the Draw dialog area. 
3. Create a new draw file or edit an existing draw file. 

4. Click and hold the Symbol/Image tool to view its hidden options. Select the Image tool .  
5. Under Images, select an existing image. 

OR 
Click Add, browse to an image, and click Open to add a new image to your Images selection. 
Note: You can delete an image from the Images selection by selecting the image and then clicking Delete. 

6. Select the Coordinate option or use the Distance and Bearing/Angle option in conjunction with the 
Coordinate option, and enter the appropriate coordinates or numbers into the corresponding text boxes to 
the right of the Images group box. (See Note below.) 

7. Click Apply. The image displays on the map at those coordinates or distance and bearing/angle locations. 
Note: To use the Distance and Bearing/Angle option with an image, you must first have an image placed on 
the map. The distance and bearing/angle numbers are entered in relationship to the LAST image you added 
to the map. 

Tips: 
 To view statistical information for an image, right-click an image and click Info from the shortcut 

menu. The image URL, label, coordinate information, as well as demographic information display 
in the Info tab. 

 While in Draw mode, you can use the Compass Rose, map edges, or Overview Map to scroll the 
map. 

 When editing, moving, or deleting an image, click Undo to undo the last action. If you decide not to 
undo the last action, click Redo. 

Custom Symbols Overview 
DeLorme XSym lets you create and edit your own symbols which can then be added to maps within DeLorme 
mapping programs. The symbols created are 24 x 24 pixels. New and edited symbols are saved within a symbol set 
(.dim file) and can contain up to 250 symbols. Symbol set files are located on C:\DeLorme Docs\Symbols. 

The DeLorme XSym Dialog Box 
The XSym dialog box provides all the tools you need to create and edit symbols for your DeLorme mapping 
program. Click an area on the diagram below to view information on the various parts of the dialog box. 
Tip: To close the pop-up information box which displays when you click the diagram, click on another part of the 
diagram. 

Creating a New Symbol 
With DeLorme XSym you can add a new symbol to an existing or new symbol set (.dim) file. You can assign a new 
category name for the symbol to aid in locating it under the Find tab in the DeLorme mapping program.  
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To Create a New Symbol 
Use the following steps to create a new symbol. 

1. Click the Draw tab. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select the symbol set you want to add your new symbol to from the available drop-down 

list. 
Note: Select New to create a new symbol set. 

4. Under Symbols, click Edit to display the DeLorme XSym dialog box. 
5. Under Symbols in Set, click New to clear the Symbol Editing Grid. 
6. Use the tools in the Draw Tool Box, as well as the tools under Transparency and Anchor, to create the new 

symbol. 
• To undo the last action, click the Undo button  in the Edit Symbol area. 
• To repeat the last action, click the Redo button  in the Edit Symbol area. 

7. To assign a symbol name to the current symbol, type a name or phrase in the Symbol Name text box under 
Edit Symbol. 
Note: Once a name is assigned to a symbol in a symbol set, each occurrence of that symbol placed on the 
map retains the new symbol name in addition to the default symbol name of "symbol". 

8. Click OK when finished. 

 

As you create a symbol, an image preview displays to the upper-left of the Symbol Editing Grid. 
Edits can be made to the symbol in either the Image Preview or the Symbol Editing Grid. Any edits 
done in one view are mirrored in the other view. 

 

Editing a Symbol 
With DeLorme XSym, you can edit an existing symbol in a symbol set (.dim) file and save the change or save it as a 
new symbol to be added to another symbol set. You can assign a new category name for the symbol to aid in 
locating it under the Find tab in the DeLorme mapping program.  

To Edit a Symbol 
Use the following steps to edit a symbol. 

1. Click the Draw tab. The Draw dialog area displays. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select the symbol set which contains the symbol you want to edit. 
4. Click Edit. The DeLorme XSym dialog box displays. 
5. Select the symbol you want to edit from the symbol selection of the default symbol set or from another 

symbol set you have created. The symbol displays in the Symbol Editing Grid. 
6. Use the tools in the Draw Tool Box, as well as those under Transparency and Anchor, to edit the symbol. 

• To undo the last action, click the Undo button  under Edit Symbol. 
• To repeat the last action, click the Redo button  under Edit Symbol. 

7. To assign a symbol name to the current symbol, type a name or phrase in the Symbol Name text box (under 
Edit Symbol). 
Note: Once a name is assigned to a symbol in a symbol set, each occurrence of that symbol placed on the 
map retains the new symbol name in addition to the default symbol name of "symbol". 

8. Click OK when finished. 

 

As you create a symbol, an image preview displays to the upper-left of the Symbol Editing Grid. Edits 
can be made to the symbol in either the Image Preview or the Symbol Editing Grid. Any edits done in 
one view are mirrored in the other view. 
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Finding a Custom Symbol 
The symbol name you assign to a symbol in XSym is different than the label you attach to the symbol on the map 
using the symbol draw tool in Street Atlas USA 2005 Plus. You can use the symbol name as a means to help locate a 
custom symbol you have already placed on a map using the Advanced feature under the Find tab in Street Atlas 
USA 2005 Plus. 

To Find a Custom Symbol 
Use the following steps to find a symbol by its symbol name. 

1. Click the Find tab and then click Advanced. 
2. Select Category from the Find drop-down list 
3. Select the applicable option from the Within drop-down list. 
4. Type the symbol name in the Keywords text box. 
5. Click Search.  
6. Click OK. Street Atlas USA 2005 Plus displays the closet matches in the list view to the right of the Search 

For text box. The Symbol Name displays in the Map Feature Type column just before the symbol's feature 
type (draw object). 

7. Double-click the item or select the item and click Go To to locate your selection on the map. The map view 
centers on the item. If you have assigned a name for the symbol under the Draw tab, a MapTag displays the 
name at the symbol location. 
If you did not assign a name for the symbol, a MapTag displays the Symbol Name at the symbol location. 

Notes: If you do not assign a symbol name to a symbol in XSym, you may locate it with the generic keyword 
of "symbol" or by the name or phrase given the symbol in the Draw tab.  
If you have assigned a Symbol Name to a custom symbol in XSym, and have placed the symbol on the map, 
the Symbol Name displays in the demographic information area when you right-click the symbol and select 
Info.  

Importing a Bitmap 
You can import a bitmap into DeLorme XSym to use as a symbol, but any bitmap you import must be 24 x 24 pixels 
or less. You can assign a new category name for the symbol to aid in locating it under the Find tab in the DeLorme 
mapping program.  

To Import a Bitmap 
Use the following steps to import a bitmap to use as a symbol. 

1. Click the Draw tab. The Draw dialog area displays. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, click Edit. The DeLorme XSym dialog box displays. 
4. Under Symbols in Set, click New to clear the Symbol Editing Grid. 
5. Click Import to display the Open Bitmap File dialog box. Browse to the location of the desired bitmap and 

click Open. The imported bitmap displays in the Symbol Editing Grid. (See important Notes below.) 
6. Use the tools in the Draw Tool Box, as well as those under Transparency and Anchor, to edit the symbol. 

• To undo the last action, click the Undo button  in the Edit Symbol area. 
• To repeat the last action, click the Redo button  in the Edit Symbol area. 

7. To assign a symbol name to the current symbol, type a name or phrase in the Symbol Name text box in the 
Edit Symbol area. 
Note: Once a name is assigned to a symbol in a symbol set, each occurrence of that symbol placed on the 
map retains the new symbol name in addition to the default symbol name of "symbol". 

8. Click OK when finished. 

 

• If you attempt to import a bitmap larger than 24 x 24 pixels into XSym, a message box warns 
you the selected bitmap is larger than 24 x 24 pixels and the image is reduced.  

• If the bitmap is less than 24 x 24 pixels, the remaining area is filled to the edge of the 
Symbol Editing Grid with one of the symbol pixel colors. 

• As you create a symbol, an image preview displays to the upper-left of the Symbol Editing 
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Grid. Edits can be made to the symbol in either the Image Preview or the Symbol Editing 
Grid. Any edits done in one view are mirrored in the other view. 

 

Copying and Pasting 
You can copy and paste portions of a symbol or whole symbols to create new symbols or edit existing ones. 

To Copy and Paste in XSym 
Use the following steps to copy a symbol or portions of a symbol to edit an existing symbol or to create a new 
symbol. 

1. Click the Draw tab. The Draw dialog area displays. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select the symbol set which contains the symbol you want to edit. 
4. Click Edit. The DeLorme XSym dialog box displays. 
5. Under Symbols in Set, select a symbol from the symbol selection. 
6. In the Draw Tool Box, click the Select tool. 

7. Select the area of the symbol you want to copy or select the whole symbol, and click the Copy button  
under Edit Symbol. 

8. Click the Paste button  under Edit Symbol. The copied image is pasted into the current symbol in the 
Symbol Editing Grid. Drag the pasted piece into the desired place within the current symbol. 
OR 
To create a new symbol with the copied image, click New under Symbols in Set to clear the Symbol 
Editing Grid, and then click the Paste button to add the pasted image into the grid. 
Note: You can assign a new symbol name for the symbol to aid in locating it under the Find tab in the 
DeLorme mapping program. To assign a symbol name to the current symbol, type a name or phrase in the 
Symbol Name text box under Edit Symbol. 

9. Click OK when finished. 

 

• To undo an action, click the Undo button  in the Edit Symbol area. 
• To repeat an action, click the Redo button  in the Edit Symbol area. 

 

Pasting a Bitmap into XSym 
You can copy a bitmap or part of a bitmap to the Clipboard and paste the image into DeLorme XSym to use as a 
symbol. Ideally, the pasted bitmap should be 24 x 24 pixels in size. You can assign a new symbol name for the 
symbol to aid in locating it under the Find tab in the DeLorme mapping program.  

To Paste a Bitmap into XSym 
Use the following steps to paste a bitmap into XSym. 

1. Click the Draw tab. The Draw dialog area displays. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select the symbol set which contains the symbol you want to edit. 
4. Click Edit. The DeLorme XSym dialog box displays. 
5. Under Symbols in Set, click New to clear the Symbol Editing Grid. 
6. Open a bitmap in another image editing program, and select the bitmap or a part of the bitmap you want to 

copy. Press CTRL+C on your keyboard to copy the selection to the Clipboard. 

7. Click the Paste button  under Edit Symbol. The copied image is pasted into the current symbol in the 
Symbol Editing Grid. (See important Notes below.) 
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8. Use the tools in the Draw Tool Box, as well as those under Transparency and Anchor, to edit the symbol. 
• To undo the last action, click the Undo button  under Edit Symbol. 
• To repeat the last action, click the Redo button  under Edit Symbol. 

9. To assign a symbol name to the current symbol, type a name or phrase in the Symbol Name text box in the 
Edit Symbol area. 

10. Click OK when finished. 

 

• If you attempt to paste a bitmap image larger than 24 x 24 pixels into XSym, the image will 
be reduced. 

• If the bitmap is less than 24 x 24 pixels, the remaining area is filled to the edge of the 
Symbol Editing Grid with one of the symbol pixel colors. 

• As you create a symbol, an image preview displays to the upper-left of the Symbol Editing 
Grid. Edits can be made to the symbol in either the Image Preview or the Symbol Editing 
Grid. Any edits done in one view are mirrored in the other view. 

 

Dragging a Bitmap into XSym 
You can drag a bitmap into DeLorme XSym to use as a symbol. Using drag to bring in an image is much like 
importing a bitmap into XSym. Ideally, the new bitmap should be 24 x 24 pixels in size. You can assign a new 
symbol name for the symbol to aid in locating it under the Find tab in the DeLorme mapping program.  

To Drag a Bitmap into XSym 
Use the following steps to drag a bitmap into XSym. 

1. Click the Draw tab. The Draw dialog area displays. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select the symbol set which contains the symbol you want to edit. 
4. Click Edit. The DeLorme XSym dialog box displays. 
5. Under Symbols in Set, click New to clear the Symbol Editing Grid. 
6. Using Explorer or My Computer, locate the bitmap (.bmp) file. 
7. Drag the file into XSym. The bitmap image displays in the Symbol Editing Grid. (See important Notes 

below.) 
8. Use the tools in the Draw Tool Box, as well as those under Transparency and Anchor, to edit the symbol. 

• To undo the last action, click the Undo button  under Edit Symbol. 
• To repeat the last action, click the Redo button  under Edit Symbol. 

9. To assign a symbol name to the current symbol, type a name or phrase in the Symbol Name text box under 
Edit Symbol. 

10. Click OK when finished. 

 

• If you attempt to drag a bitmap larger than 24 x 24 pixels into XSym, a message box warns 
you the selected bitmap is larger than 24 x 24 pixels and the image is reduced.  

• If the bitmap is less than 24 x 24 pixels, the remaining area is filled to the edge of the 
Symbol Editing Grid with one of the symbol pixel colors. 

• As you create a symbol, an image preview displays to the upper-left of the Symbol Editing 
Grid. Edits can be made to the symbol in either the Image Preview or the Symbol Editing 
Grid. Any edits done in one view are mirrored in the other view. 

 

Removing a Symbol 
You can remove a symbol from the default symbol set or from any other symbol set you have created. 

To Remove a Symbol 
Use the following steps to remove a symbol from a symbol set. 

1. Click the Draw tab. The Draw dialog area displays. 
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2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select the symbol set which contains the symbol you want to edit. 
4. Click Edit. The DeLorme XSym dialog box displays. 
5. Select the symbol you wish to remove from the symbol selection. The symbol displays in the Symbol 

Editing Grid. 
6. Click Remove. The symbol disappears from the symbol selection under Symbols in Set and the next 

symbol within the selection displays in the Symbol Editing Grid. 
7. Click OK when finished. 

Symbol Editing Tools Overview 
DeLorme XSym provides the tools you need to create and edit symbols. Tools available in the XSym dialog box for 
editing symbols are: 

• The eight draw tools in the Draw Tool Box. 
• The Transparency tool under Transparency. 
• The Anchor Position tool under Anchor. 

Draw Tool Box 
DeLorme XSym provides a Draw Tool Box which lets you create and edit symbols within the Symbol Editing Grid 
independently of the DeLorme mapping program. The tools provided help you to create unique symbols to add to 
your map. 
The following are the tools available in the Draw Tool Box. 

 
Pencil—Draw "freehand" lines within the grid. 

 
Line—Draw lines by clicking and dragging to the desired end point within the grid. 

 
Ellipse—Create an ellipse by clicking and dragging until the desired size or shape of the ellipse is 
achieved. 

 
Filled Ellipse—Create a filled ellipse by clicking and dragging until the desired size or shape of the 
filled ellipse is achieved. 

 
Rectangle—Create a rectangle by clicking and dragging until the desired size of the rectangle is 
achieved. 

 
Filled Rectangle—Create a filled rectangle by clicking and dragging until the desired size of the 
filled rectangle is achieved. 

 
Fill—Use the fill tool to fill an area of the grid with a color chosen from the color palette. 

 
Select—Use select to choose an area of the symbol to be copied from the Symbol Editing Grid and 
then pasted into the same symbol or another symbol in the grid. 

 

Using the Transparency Option 
The Transparency option in DeLorme XSym lets you display a selected color as transparent in the final symbol 
image you place on a map within a DeLorme mapping program. For example, you may want to view the symbol 
object without the square of the surrounding background color. You would then select the background color to 
appear transparent. 

To Make Part of a Symbol Transparent 
Use the following steps to make part a symbol transparent. 

1. Click the Draw tab. The Draw dialog area displays. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select the symbol set which contains the symbol you want to edit. 
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4. Click Edit. The DeLorme XSym dialog box displays. 
5. Select the symbol you want to edit from the Symbol Selection. The symbol displays in the Symbol Editing 

Grid. 
6. Select the Transparent option under Transparency. 

7. Click the Select Color tool . The pointer changes to a dropper tool. 
8. Select the desired color on the symbol you wish to appear transparent. The Transparent Color display box 

updates with the selected color, and the Image Preview displays the chosen color area as transparent. 
9. To display all colors, select the Opaque option under Transparency. The Image Preview reflects this 

change. 
10. Click OK when finished. 

 

Be sure the color in the symbol you wish to appear transparent is not repeated in another part of the 
symbol you want to display as opaque. Select a new color from the color palette and fill the area on 
the symbol you want to display as transparent with the new color. Use the Select Color tool to 
select the new color in the symbol grid. 

 

Anchor Position 
Being aware of Cursor Position is important for choosing the anchor position of a symbol. The anchor is the pixel 
position on the symbol which corresponds to the geographic coordinate of the point selected on the map when the 
symbol is placed. Any newly created symbol, whether imported, pasted or dragged into the XSym Symbol Editing 
Grid has a default position of center anchor. 
XSym lets you change the anchor position of your symbol. 

To Select the Anchor Position 
Use the following steps to select the anchor position of a symbol. 

1. Once your symbol is created, click the Anchor Position  button. When you pass your pointer over the 
Symbol Editing Grid, it changes to a small cross hair (plus sign). 

2. Click the desired pixel grid within the symbol to position your anchor. The anchor location pixel coordinate 
numbers display after the position text to the right of the Anchor Position button. The large cross hair in the 
Symbol Editing Grid moves from its default anchor position to the new anchor position. 

To Center the Anchor Position 
Click Center Anchor to place the anchor point in the exact center of the Symbol Editing Grid. 

Cursor Position 
Any symbol created in XSym is 24 x 24 pixels square. Each of these pixels is represented in the Symbol Editing 
Grid. When you move your cursor over the Symbol Editing Grid, the cursor position by pixel number displays to the 
right of the Cursor Position text next to the Image Preview (as shown below). 
Image Preview and Cursor Position 

 
As you move the cursor over the grid, the numbers update according to where you are in the 24 x 24 grid. The first 
number in the above sample, 16, refers to the number of pixels across (the X coordinate) from the upper left corner 
of the grid, beginning with zero. The second number, 14, refers to the number of pixels down (the Y coordinate) 
from the upper-left corner of the grid, beginning with zero. 

Symbol Set Overview 
When you create a symbol in DeLorme XSym it is saved within a symbol set (.dim file) which can contain up to 250 
symbols. You can edit any of the stock symbols or any new symbols. 
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Creating a New Symbol Set 
Symbols created in DeLorme XSym are saved within a symbol set (.dim file) which can contain up to 250 symbols.  

To Create a New Symbol Set 
Use the following steps to create a new symbol set. 

1. Click the Draw tab. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select <New...> from the available drop-down list. The DeLorme XSym dialog box 

displays. 
4. Under Symbol Set Name, type the name for your new symbol set. 

Note: The default name for a new symbol set is CustomSymbolSet. 
5. Import a bitmap into your new symbol set. 

OR 
Create a new symbol to add to your new symbol set. 

Opening a Symbol Set 
Open an existing symbol set (.dim) to add new symbols or edit existing ones. 

To Open a Symbol Set 
Use the following steps to open a symbol set. 

1. Click the Draw tab. The Draw dialog area displays. 
2. Click and hold the Symbol/MapNote/Text Label/Image tool to view its hidden options. Select the Symbol 

tool . 
3. Under Symbols, select the desired symbol set from the available drop-down list. The DeLorme XSym 

dialog box displays. The symbol selection for the new symbol set displays under Symbols in Set and the 
Symbol Editing Grid updates with the first symbol of the new symbol set. 
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GPS 
GPS Overview 
Street Atlas USA 2005 Plus allows you to take advantage of the Global Positioning System (GPS) through an 
interface with most GPS receivers, such as the DeLorme Earthmate® or GpsTripmate®.  
Using Street Atlas USA 2005 Plus, a laptop computer, and your GPS receiver, you can: 

• Display a "bread crumb trail" to track your progress as you travel. 
• Send and receive route information, draw files, waypoints, and tracks to/from your GPS device using the 

Exchange Wizard. 
 

 
Safety Warnings 

• Bring a passenger along to serve as GPS operator while you are driving a vehicle.  
• Street Atlas USA 2005 Plus should not be used in automatic navigation, guidance 

systems, or for any purpose requiring precise measurement of distance or direction.  

What is GPS? 
The Global Positioning System (GPS) applies modern technology to the ancient basics of navigation. The U.S. 
Department of Defense has developed and launched a series of positioning satellites in an orbiting "constellation." 
These satellites are used as reference points much the same way stars have been used in conventional navigation.  
Using these satellites, a GPS receiver can determine your position anywhere on the globe. GPS provides accurate 
information about coordinate position, elevation, speed, and direction of travel. Many people have discovered the 
benefits of GPS for tracking vehicles, recording routes, and much more. 

How Does GPS Work? 
The GPS "constellation" consists of 24 satellites, each carrying several atomic clocks to ensure the most accurate 
time possible. The satellites broadcast low-power radio waves containing the satellite's identity code and the exact 
time (to the nanosecond) that the message was sent. 
When a GPS receiver picks up a satellite signal, it identifies the satellite and compares the signal time with its own 
clock. The time difference represents the time it has taken for that radio wave to travel from the satellite to the 
receiver. Since radio waves travel at the speed of light, the time difference can be used to calculate the distance from 
the satellite to the GPS receiver. 
The satellite's identity code provides the location of the satellite, and the distance to the receiver creates a sphere of 
possible locations for the GPS receiver. Without more information, the receiver only knows that it is located 
somewhere on that sphere. 
Two additional satellites are necessary to narrow down the receiver's possible position. Each of these satellites sends 
a similar radio message containing time and identity information. The GPS receiver checks the orbital location of 
each satellite and uses the elapsed time to create two additional spheres of possible locations. These three spheres 
intersect at two points; however, one of these points is eliminated because it is far away from the earth's surface. 
Therefore, the second point is assumed to be correct. The data from these three satellites provides the receiver with a 
two-dimensional location. 
Data acquired from a fourth satellite pinpoints the receiver's exact location. This additional positioning information 
allows the GPS receiver to calculate its elevation, which is particularly important for GPS users in mountainous 
locations. 

GPS Position Accuracy 
The accuracy of the data your GPS receiver provides is dependent upon many factors, including the quality of your 
equipment. A low-quality clock within the receiver decreases the accuracy of your location. The atmosphere, the 
ionosphere, and the number of channels your receiver can handle all affect the accuracy of your system. Consult 
your GPS hardware manuals for information on how your receiver adjusts for errors.  
Any buildings, natural structures, or heavy foliage that obstruct the GPS antenna's view of the sky prevent satellite 
signals from reaching the receiver and therefore decreases the accuracy of your position. 
Your accuracy will also depend on your level of clearance with the U.S. Department of Defense. There are two 
available radio signals that receivers can use: the Standard Positioning Service (SPS) for civilians and the Precise 
Positioning Service (PPS) for military and authorized personnel. 
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Getting Started With Your GPS Connection 
Before you can begin GPS tracking, you must connect your GPS receiver to your laptop. Select the correct GPS 
receiver and change location, time, and preference settings, as needed. 
Before beginning your GPS setup with Street Atlas USA 2005 Plus, read the user manual for your GPS receiver. 
Also, ensure you have the appropriate cable and any necessary adapters to connect your GPS receiver to the 
communications port of your laptop computer. 

To View Your Current GPS Settings 
Use the steps below to view your current GPS settings. 

1. Connect your GPS receiver to your computer, set the receiver to the mode specified in your user manual, 
and then turn the receiver on (if necessary). 

2. Open Street Atlas USA 2005 Plus, click the GPS tab, and then click Settings. 
Under Current Settings, you can view the following items: 

 Device—Displays the current, active GPS device (or the last selected device). 
 Coordinates—Displays the coordinates of the last acquired location by the GPS device in the 

coordinate format defined on the Units dialog area in the Map Display tab. 
Note: When the product is first used, the coordinates displayed are for DeLorme, in Yarmouth, 
Maine. 

 Date and Time—Displays the system date and time, unless you have manually adjusted the date 
and/or time manually. 

Initializing GPS 
The initializing process can take several minutes before the program detects the correct communications (COM) port 
and updates the current settings. 

To Initialize Your GPS Receiver 
Use the following procedure to initialize your GPS receiver for use with Street Atlas USA 2005 Plus. 

1. Click the GPS tab and then click Settings to open the GPS Settings dialog area. 
2. Click Clear Trail to delete any GPS points from the current map display. 
3. Under GPS Options, select any or all of the following check boxes: 

 Start GPS Log—When selected, automatically generates a GPS log. 
 Use High-Contrast Colors—When selected, automatically enables high-contrast map colors. 
 Magnify Map—When selected, automatically magnifies the map view to the specified 

magnification (125%, 150%, 175%, or 200%). 
 Recenter Map on GPS—When selected, automatically centers the map on the GPS when you pan 

the map. 
 Rotate Map in GPS Direction—When selected, automatically rotates the map while the GPS is 

on and moving or when playing back a GPS log. The direction of travel is indicated at the top of 
the screen. 

 Show GPS Bread-Crumb Trail—When selected, automatically displays your GPS progress on 
the map as a "bread-crumb" trail up to the maximum specified number of points (5000 points is 
approximately one hour and 20 minutes worth of points). 

 Enable GPS Voice Navigation—When selected, provides spoken directions when tracking a 
route with a GPS receiver.  

 Recalculate When Off Route—When selected, automatically recalculates the route by the 
designated threshold distance when the GPS is off of the route. 

 Start GPS with the Program—When selected, starts GPS tracking automatically each time 
Street Atlas USA 2005 is opened. 

 Automatically Detect GPS—When selected, automatically sets up your GPS connection. 
Suggestion: If your GPS receiver has a USB cable, select Automatically Detect GPS to ensure 
the correct COM port is detected for your device and that a connection can be made. 

 Enable WAAS Use—This option is only available when Earthmate is the selected device (see 
step 3A). When selected, enables WAAS use. This option is selected by default. 
Note: This option only applies to the new USB Earthmate GPS receiver. 



GPS 

131 

 Enable LED on GPS Device—This option is only available when Earthmate is the selected 
device (see step 3A). When selected, turns on the LED on the Earthmate. When the check box is 
cleared, the LED on the Earthmate does not display. This option is selected by default. 
Note: This option only applies to the new USB Earthmate GPS receiver. 

OR 
Use the following procedures to manually configure your GPS connection.  

A. Select the correct GPS device: 

Use the steps below to select the correct GPS receiver and settings in Street Atlas USA 
2005 Plus. 

i. Connect your GPS receiver to your computer, set the receiver to the mode 
specified in your user manual, and then turn the receiver on (if necessary). 

ii. Open Street Atlas USA 2005 Plus, click the GPS tab, and then click Settings.  
iii. Under Edit Settings, click Device to display the Device options. 
iv. From the Device drop-down list, select the type of GPS receiver you are using. 

If your device is not listed, select Generic NMEA.  
Note: The Settings text box automatically displays the default settings for the 
selected device. 

v. From the Port drop-down list, select the communications port that you are using 
to attach the GPS receiver to your computer (see your computer manual for 
further information). 

vi. Click Done to save your selected options. The Settings dialog area displays. 

B. Manually change the location coordinates: 

Each time you track via GPS, the initialization process uses the coordinates from the last 
initialized location. 
Use the following steps to change these coordinates to those of your choice. 

i. Connect your GPS receiver to your computer, set the receiver to the mode 
specified in your owner manual, and then turn the receiver on (if necessary). 

ii. Open Street Atlas USA 2005 Plus. Click the GPS tab and then click Settings.  
iii. Under Edit Settings, click Location to display the location options. 
iv. Click the point on the map you wish to use as your starting point. The map 

centers on that point and coordinates update automatically. 
OR 
Type the desired coordinates in the Coordinate text boxes. 
Note: Coordinates display in the units specified under Units in the Map Display 
tab. 

v. Click Done to save your changes. The Settings dialog area displays. 
Note: Clicking Cancel displays the Settings dialog area. No changes are saved. 

C. Update the date/time options: 

Street Atlas USA 2005 Plus lets you use the date and time on your computer or you can 
change the date and time settings used by the GPS device to those of your choice. 
Use the following steps to change the date and/or time settings. 

i. Connect your GPS receiver to your computer, set the receiver to the mode 
specified in your user manual, and then turn the receiver on (if necessary). 

ii. Open Street Atlas USA 2005 Plus. Click the GPS tab and then click Settings.  
iii. Under Edit Settings, click Date/Time to display the Date/Time options. 
iv. To use the date and time on your computer, select the Use Current System 

Date/Time check box. 
OR 
To use the time and date of your choice, clear the Use Current System 
Date/Time check box, and then: 

• To manually set the time, select the desired time zone from the Zone 
drop-down box, and if daylight saving time is currently in effect where 
you are, select the DST check box. Type the desired time in the T text 
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box. 
Note: Time is displayed in 24-hour format, with Midnight as 00:00:00. 

• To manually set the date, type the desired date in the D text box. 
Note: Date format is MM/DD/YY. 

v. Click Done to save changes. The Settings dialog area displays. 

4. Click Start GPS. Your GPS receiver begins acquiring satellite data and the GPS Status dialog area 
displays. 

 

• The GPS Status dialog area displays on your screen so that you can view the status of your 
GPS connection while your GPS receiver acquires data from the satellites. Once your GPS 
receiver acquires a fix on your location, Street Atlas USA 2005 Plus indicates your position 
on the map as a yellow or green dot that changes to an arrow as you travel. 

• While your receiver is acquiring data, many red dots display on your map (except with 
Magellan receivers). You may have to zoom in to see them clearly. These red dots are 
positioned at the readings taken by the GPS receiver as it is acquiring data. 

• Magellan receivers do not display any data until you are moving. 
• If you have the HotSync® manager loaded in the startup (the default configuration), it 

reserves the COM port. If that is the one where the GPS receiver is attached, you must exit 
HotSync manager to get the GPS receiver to initialize. This can be done by right-clicking 
the HotSync icon on the taskbar and selecting the Exit option from the shortcut menu. If 
you have two COM ports, verify the correct COM port is selected for use with Street Atlas 
USA 2005 Plus. 

• Any questions or problems regarding the operation of your GPS receiver should be directed 
to its manufacturer. 

 

GPS Settings for Third-Party Devices 
A third-party GPS receiver is one which is manufactured by a company other than DeLorme, such as GARMIN, 
Magellan, Brunton, Lowrance, Trimble, and so forth.  

To Use Recommended Settings for Your Third-Party Receiver 
The table below provides information on several GPS receivers. Locate your receiver in the farthest-left column, and 
read across for information on settings for Tracking, Waypoints, your DeLorme mapping product, and any 
additional information. 
GPS Receiver Tracking Waypoints DeLorme Product 

Settings 
Other Information 

Garmin® GPS III, 
GPS III+, GPS II, 
GPS II+,  

*Garmin Garmin/Host Garmin/Garmin 

Street Pilot, 
ColorPilot, Street 
Pilot III 

*Garmin Garmin/Slave Garmin/Garmin 

Garmin eTrex® 
series, Geko™, 
Rino®, 12Map 

NMEA/NMEA Garmin/Garmin Garmin NMEA 
(w/wpt)  

Garmin eMap, 
GPS76 series, 
GPSV series 

NMEA/NMEA Garmin/Garmin Garmin NMEA 
(w/wpt) 

Stores routes and 
tracks by name. 
Can simulate 
bearing and speed 
in program (image 
does not update in 
simulate mode). 
Make sure baud 
rate on program 
matches device. 
Tracks 
(breadcrumb trail), 
by default. Use the 
save date as the 
name. Routes use 
the name specified 
by the creating 
program. 

Garmin 45XL, NMEA/NMEA Garmin/Garmin Garmin NMEA Stores routes by 



GPS 

133 

GPS Receiver Tracking Waypoints DeLorme Product 
Settings 

Other Information 

GPS12, 12XL (w/wpt) number. 
Magellan™ Tracker, 
ColorTrack, Meridian, 
SporTrak, Map 315, 
Map 320, Map 330 

NMEA v2.1 GSA (default is usually off)** Magellan (w/wpt)  Note: Best baud 
rate is 4800. 
Transfers above 
this are not reliable. 
Stores routes by 
number. Most 
devices store only 
one track log. Can 
simulate movement 
and bearing in 
program. Make 
sure baud rate on 
program matches 
device. Make sure 
Map datum is set to 
WGS84. Make sure 
simulate mode is 
OFF for active 
tracking.  

Lowrance 
GlobalNav 100, 
212, 300 

NMEA Out NMEA Out Eagle/Lowrance  Make sure Star 
DGPS and 
Magellan DGPS are 
not active. Make 
sure all options in 
Configure NMEA 
are selected and 
NMEA 0183 2.0 is 
selected.  

Trimble 
Scoutmaster™ 

NMEA 0183 v2.0 Not Supported Trimble  To initialize, 
choose LOC 
option. To change 
NMEA settings, 
choose Setup (4th 
option). Refer to 
manual for more 
information.  

Brunton NMEA 0183 v2.0 NMEA 0183 v2.0 Brunton Only supported on 
newer DeLorme 
software. 

 
*Can track using Garmin mode; however, the almanac status and the skyview do not populate unless using 
Garmin/NMEA mode. Thus, if in doubt, use NMEA OUT mode. 
**For earlier versions of the Magellan O/S, use NMEA B. 

Tracking and Monitoring Overview 
To Start GPS Tracking 
Use the following steps to track your movement along your route on your computer screen in Street Atlas USA 2005 
Plus as you travel. 

1. Click the GPS tab and then click Settings. 
2. Click Start GPS. The GPS Status dialog area displays.  
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One of the following tracking indicator arrows displays along your route on your computer screen. You 
must be traveling at speeds of 3 mph or more for an arrow indicator to display. 

If the signal is strong, your location displays as a green arrow (dark green for WAAS-enabled 
devices) on the map as you move. 
If you are receiving signals from three satellites (a 2-D fix), your location displays as a yellow 
arrow. 
If your GPS device is not receiving data, the arrow is red. Reposition your receiver, ensuring a 
clear pathway to the sky. 

 

 

• A trail of dots of the appropriate color (green or yellow) indicating the route traveled 
display on the map. 

• Magellan receivers do not display any data until you are moving. 
 

To Stop GPS Tracking 
Use the following steps to stop GPS tracking. 

1. On the GPS tab, click Settings. 
2. Click Stop GPS to stop tracking your route on the screen. 

Monitoring Your GPS Status 
Once you have initialized and begun tracking, you can continue to monitor the status of your GPS connection, your 
speed, heading, elevation, position according to your preferred coordinate format, and satellite data.  

 

Status information accuracy is affected by speed (3 mph or more) and your GPS status. 3-D status 
provides the most accurate information. 

To Monitor Your GPS Status 
The Status dialog area displays automatically when you click the Start GPS button in the GPS Settings dialog area. 
You can perform other functions and then return at any time. To return to monitoring your GPS status, click the GPS 
tab and then click Status. The GPS Status options display. 

Speed and Heading 

 

Speed—Displays the speed you are traveling 
based on the selected Units preference. 
Heading—Displays as degrees T (True North) or 
M (Magnetic North) based on the bearing selected 
on the Units dialog area in the Map Display tab. 

Bearing 

 

Compass—The Compass needle turns to represent the current bearing while tracking. 

Coordinates/Elevation 

 

Coordinates—The coordinate fields display based on the selected Units preference. 
Elevation—Displays the current elevation if the GPS status is 3-D and is based on the 
selected Units preference. Elevation can be displayed with a 2-D status; your position is 
indicated accurately on your screen as you travel unless you are in an area where your 
elevation varies greatly.  
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GPS Status 

 

No GPS—A red circle with a slash indicates the GPS receiver is not yet detected by your 
computer. This status usually displays when initialization first begins. 
Acquiring—A red blinking circle indicates the GPS receiver is not yet receiving 
sufficient satellite data to determine your position. This status displays while the GPS 
receiver is acquiring satellite data and can take several minutes.  
2-D—A yellow circle indicates the GPS connection is successful, but there is insufficient 
satellite data to determine your GPS position. This usually indicates insufficient data for 
an accurate location due to 1) only three satellites being used or 2) poor signals from the 
satellites. Move your receiver to another location until you get better reception. 
3-D—A green circle indicates the GPS receiver is receiving sufficient satellite data to 
determine your location. When the status reads 3-D, your current coordinates, elevation, 
and heading are displayed, along with the speed you are currently traveling. 
Note: If you are tracking with a WAAS-enabled device, a 3-D fix displays as "3-D 
DGPS." 

Satellite Info 
Under the GPS status icon, click Sat. Info to view the current satellite status.  
Note: Satellite Info is a toggle button, which switches to Status. Click Status to return to the original Status dialog 
area. 
 

Dilution of Precision 

 

The Dilution of Precision area lists your Position Dilution of Precision, your Horizontal 
Dilution of Precision, and your Vertical Dilution of Precision.  

Satellite Listing 

 

The Satellite Listing window displays the satellites that are currently visible in the 
sky. The columns list the satellite number, elevation, azimuth, and signal-to-noise 
ratio. 
Note: Satellite Listing information is only available for DeLorme receivers and 
NMEA-compatible receivers. 

Almanac 

 

When using a DeLorme GPS receiver, the Almanac window displays the satellite 
number and its current status. 
N—Indicates the satellite is being used for navigation. 
E—Indicates ephemeris data is available for the satellite. 
T—Indicates the satellite is currently being tracked by your GPS receiver. 
D—Indicates differential data is available for that satellite.  
Notes: 

• Differential data is available on WAAS-enabled devices. 
• Almanac information is only available for DeLorme receivers. 
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Skyview 

 

The Skyview diagram indicates visible satellites, their number (assigned by the 
Department of Defense), and their position in the sky relative to your current position. 
Each satellite is color coded, based on the quality of data it is transmitting. 
Gray—Indicates the satellite's position in the sky. 
Red—Indicates your GPS receiver is tracking the satellite, but it is not receiving data 
from it. 
Yellow—(DeLorme GPS receivers only) Indicates your receiver is tracking the satellite, 
ephemeris data is available, but the satellite is not being used for navigation.  
Green—Indicates your GPS receiver is tracking the satellite, ephemeris data is available, 
and the satellite is being used for navigation.  
Dark Green—(WAAS-enabled receivers only) Indicates your receiver is tracking the 
satellite, ephemeris data is available, the satellite is being used for navigation, and the 
satellite has DGPS and WAAS corrections available. 
Blue—(WAAS-enabled receivers only) Indicates a WAAS satellite used for corrections. 

 

Tracking Your Route Directions 
When tracking in Street Atlas USA 2005 Plus, you can follow along a road route you have created. As you travel, 
Street Atlas USA 2005 Plus highlights the current leg (segment) of your route.  

 

• To automatically recalculate your route when off track, select the Auto check box next to the 
Back on Track button in the New/Edit tab area. If you do not want the program to automatically 
recalculate your route when off track, just click Back on Track.  

• The Turns option is only available during GPS tracking. 
• You can only track route directions for a road route. 

To Track a Route 
Use the following steps to track a route. 

1. Initialize your GPS receiver and begin tracking. 
Note: This is not necessary if you have selected the Auto Start GPS check box on the Settings dialog area 
in the GPS tab. 

2. Click the Route tab and then click Directions. The Route Directions dialog area displays.  
3. From the route list on the left, double-click the desired route to center it on the map.  
4. Click the Expand to Maximum Height button  in the upper-right corner of the dialog box to expand the 

list view.  
Note: To change a column header name and the information that displays in its list, click the column 
header. A shortcut menu displays all available options, with the currently selected item in bold. Select the 
desired column header. 

5. To view next turn information, click Show Turns. The Show Turns dialog area displays the following: 
• A turn graphic indicating the direction of your next turn 
• Distance (in the format chosen in Units on the Map Display tab) 
• Time and distance until next turn 
• The estimated time of arrival (ETA) of your next stop 
• The ETA of your finish 

6. Click the Show More Turns button  to view information for the turn after the following turn. 
7. Click Show Directions to return to the Directions dialog area.  

Automatic Pan 
When using Street Atlas USA 2005 Plus with a GPS receiver to track a route, your map automatically pans and 
redraws as you travel, always indicating your position on the map when Center on GPS is activated. 
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To Pan the Map Automatically 
The following procedure demonstrates how the check box and button work together to automatically pan 
the map. 

1. Click the GPS tab and then click Settings.  
2. Under GPS Options, clear the Auto Recenter on GPS check box. If you pan the map manually during GPS 

tracking, Center on GPS displays in the Control Panel.  
OR 
Select the Auto Recenter on GPS check box. If you pan the map manually during GPS tracking, the map 
will automatically re-center itself on your location after 5 seconds.  

3. Click Start GPS. 

 

• The Center on GPS button displays (and is activated by default) on the Control Panel when 
the Auto Recenter on GPS option is selected.  

• If you deactivate the Center on GPS button, you can continue to manually pan the map or 
use the search function in the Find tab. 

• When you are done with other tasks, click Center on GPS to resume tracking.  
• The Automatic Pan feature also works while playing back a log file. 

Logging 
Once you begin tracking with your GPS receiver, Street Atlas USA 2005 Plus lets you log, or record, your route as 
you travel.  

 

Use the steps in this topic if you have not selected the Auto GPS Logging check box under GPS 
Options.  

 

To Log Your Route 
Use the following steps to log your route. 

1. Click the GPS tab and then click GPS Log. The GPS Log dialog area displays.  
2. Click Clear Trail on the GPS Log dialog area to clear all GPS points from the map display. 
3. Click New and type the desired file name into the Log drop-down text box. 

OR 
Select a log from the Log drop-down list. 
Note: Log files have .gpl extensions and are saved in the C:\DeLorme Docs\GPSLogs directory by default. 

4. Click the Record button  to begin logging.  

5. Click the Stop button  when you want to stop logging. 

 

To delete a log file, select the desired file from the Log drop-down list and then click Delete. 

 

Playing Back a Log File 
After you have logged a route with Street Atlas USA 2005 Plus your GPS receiver, you can play it back and review 
your entire journey on-screen.  

 

• You cannot play back a log file if you are currently tracking with a GPS receiver. On the 
GPS tab, click Settings and then click Stop GPS to stop tracking. 

• Zooming in on the map allows you to see the log file in greater detail. 

To Play Back a Log File 
Use the following steps to play back and review a log file. 

1. Click the GPS tab and then click GPS Log. The GPS Log dialog area opens. 
2. Click Clear Trail on the GPS Log dialog box to clear any existing GPS points from the map display. 
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3. Select the desired log file from the Log drop-down list. Log files have .gpl extensions and are saved in the 
C:\DeLorme Docs\GPSLogs directory by default. 

4. Click the Play button  to begin playing back your log.  
Note: Playing back a log file defaults to 1x, which occurs in real time and takes the same amount of time as 
the original trip did (i.e., if your trip took six hours, the on-screen tracking process also takes six hours). 

You can also: 
• From the Playback Speed drop-down list, select the desired option (2x, 5x, 10x, 25x, or 50x) to 

increase the tracking speed accordingly. 

• Click the Pause button  to pause the tracking of the log file. The Pause button turns blue to 
indicate the file is paused. Click the Play button to continue playing back the file. 

• Click the Stop button  to stop the play back. If you click the Play button again, the file starts 
over. 

• Click and hold the Rewind button  to rewind the log file the desired distance. 

• Click and hold the Forward button  to fast forward the log file the desired distance. 

Exchanging Objects With a GPS Device Overview 
If you have a compatible GPS device, a Palm OS® handheld device, or a Pocket PC handheld device, you can 
upload/download route points, route directions, draw files, draw points, GPS logs, waypoints, and track files to 
Street Atlas USA 2005 Plus. 

Sending Route Information to a GPS Device 
If you have a compatible GPS device, you can send route points or route directions to your GPS device using the 
Exchange Wizard in Street Atlas USA 2005 Plus. 

To Send Route Points 
Use the following steps to send route points to your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Send to Device. 
6. Select Route Points from the Object drop-down list. 
7. Click Next. 
8. Select the route file which contains the route points you want to send to your device from the Route drop-

down list. 
9. To avoid overwriting existing waypoints on your device, type a starting point for the new points and select 

the Prefix a Number to the Waypoint Name check box. 
Note: Not all devices support starting points. See your device manual for more information. 

10. Click Send to Device. 
11. Repeat steps 8–10 for every route file you want to send to your device. 
12. Click Finish. 

To Send Route Directions 
Use the following steps to send route directions to your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 
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3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Send to Device. 
6. Select Route Directions from the Object drop-down list. 
7. Click Next. 
8. Select the route file which contains the route directions you want to send to your device from the Route 

drop-down list. 
9. Designate a route name and/or a route number for the file on the device (device dependent). 
10. To avoid overwriting existing waypoints on your device, type a starting point for the new points and select 

the Prefix a Number to the Waypoint Name check box. 
Note: Not all devices support starting points. See your device manual for more information. 

11. Click Send to Device. 
12. Repeat steps 8–11 for each route file you wan to send to your device. 
13. Click Finish.  

Sending a Draw File to Your GPS Device 
If you have a compatible GPS device, you can send draw files to your GPS device using the Exchange Wizard in 
Street Atlas USA 2005 Plus. 

To Send a Draw File to Your GPS Device 
Use the following steps to send a draw file to your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Send to Device. 
6. Select Draw File from the Object drop-down list. 
7. Click Next. 
8. Select the draw file you want to send to your device from the Draw File drop-down list. 
9. To avoid overwriting existing waypoints on your device, type a starting point for the new points and select 

the Prefix a Number to the Waypoint Name check box. 
Note: Not all devices support starting points. See your device manual for more information. 

10. Click Send to Device. 
11. Repeat steps 8–10 for every route file you want to send to your device. 
12. Click Finish. 

Sending Waypoints to Your GPS Device 
If you have a compatible GPS device, you can send waypoints to your GPS device using the Exchange Wizard in 
Street Atlas USA 2005 Plus. 

To Send Waypoints 
Use the following steps to send waypoints to your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 
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4. Under Device Type, select GPS. 
5. Select Send to Device. 
6. Select User Map Data - Waypoints from the Object drop-down list. 
7. Click Next. 
8. Select the waypoint file you want to send to your device from the Waypoint File drop-down list. 
9. To avoid overwriting existing waypoints on your device, type a starting point for the new points and select 

the Prefix a Number to the Waypoint Name check box. 
Note: Not all devices support starting points. See your device manual for more information. 

10. Click Send to Device. 
11. Repeat steps 8–10 for every route file you want to send to your device. 
12. Click Finish. 

Sending Tracks to Your GPS Device 
If you have a compatible GPS device, you can send tracks to your GPS device using the Exchange Wizard in Street 
Atlas USA 2005 Plus. 

To Send Tracks 
Use the following steps to send tracks to your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Send to Device. 
6. Select User Map Data - Track from the Object drop-down list. 
7. Click Next. 
8. Select the track file you want to send to your device from the Track File drop-down list. 
9. Designate a track name or a track number for the file on the device (optional). 
10. Click Send to Device. 
11. Repeat steps 8–10 for every route file you want to send to your device. 
12. Click Finish.  

Receiving a Route From Your GPS Device 
If you have a compatible GPS device, you can receive a route created on your GPS device using the Exchange 
Wizard. Once imported, the file can be used in Street Atlas USA 2005 Plus. 

To Receive a Route 
Use the following steps to receive a route from your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Receive from Device. 
6. Select Route from the Object drop-down list. 
7. Select Route from the Save As drop-down list. 
8. Click Next. 
9. Select the route name or route number on the device that you want to receive. 
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10. Select the route file you want to add the route information to. If you want to create a new route file, select 
New from the Route drop-down list and type the new route name in the available text box. 

11. Click Receive from Device. 
12. Repeat steps 9–11 for every route file you want to receive from your device. 
13. Click Finish. 

Receiving a Track From Your GPS Device 
If you have a compatible GPS device, you can receive a track created on your GPS device and save it as a draw file, 
road, or track using the Exchange Wizard in Street Atlas USA 2005 Plus. 

 

When you open a track you've imported from your GPS device in Street Atlas USA 2005 Plus, you 
may notice that the track does not join existing roads. Use the select tool in the Draw tab to snap the 
end node of the track to a road. For more information, see Snapping Draw Objects on page 97. 

To Receive a Track as a Draw File 
Use the following steps to receive a track from your GPS device and save it as a draw file. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Receive from Device. 
6. Select Track from the Object drop-down list. 
7. Select Draw File from the Save As drop-down list. 
8. Click Next. 
9. Select the track name or track number on the device that you want to receive. 

Note: Not all devices support downloading individual track logs. See your device manual for more 
information. 

10. Select the draw file you want to add the track information to. If you want to create a new draw file, select 
New from the Draw File drop-down list and type the new draw file name in the New Draw File text box. 

11. Optional: Type a label for your track in the Draw Label text box. 
12. Click Receive from Device. 
13. Repeat steps 9–12 for every track file you want to receive from your device. 
14. Click Finish. 

To Receive a Track as a Road 
Use the following steps to receive a track from your GPS device and save it as a road. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Receive from Device. 
6. Select Track from the Object drop-down list. 
7. Select User Map Data - Road from the Save As drop-down list. 
8. Click Next. 
9. Select the track name or track number on the device that you want to receive. 

Note: Not all devices support downloading individual track logs. See your device manual for more 
information. 
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10. Select the road file you want to add the track information to. If you want to create a new road file, select 
New from the Road File drop-down list and type the new road file name in the New Road File text box. 

11. Optional: Type a label for your track in the Road Label text box. 
12. Click Receive from Device. 
13. Repeat steps 9–12 for every track file you want to receive from your device. 
14. Click Finish. 

To Receive a Track 
Use the following steps to receive a track from your GPS device and save it as a track. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Receive from Device. 
6. Select Track from the Object drop-down list. 
7. Select User Map Data - Track from the Save As drop-down list. 
8. Click Next. 
9. Select the track name or track number on the device that you want to receive. 

Note: Not all devices support downloading individual track logs. See your device manual for more 
information. 

10. Select the track file you want to add the track information to. If you want to create a new track file, select 
New from the Track File drop-down list and type the new track file name in the New Track File text box. 

11. Optional: Type a label for your track in the Track Label text box. 
12. Click Receive from Device. 
13. Repeat steps 9–12 for every track file you want to receive from your device. 
14. Click Finish. 

Receiving Waypoints From Your GPS Device 
If you have a compatible GPS device, you can receive waypoints created on your GPS device and save them as a 
draw file or as a waypoint file using the Exchange Wizard in Street Atlas USA 2005 Plus. 

To Receive Waypoints as a Draw File 
Use the following steps to receive waypoints as a draw file from your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Receive from Device. 
6. Select Waypoints from the Object drop-down list. 
7. Select Draw File from the Save As drop-down list. 
8. Click Next. 
9. Select the draw file you want to add the waypoint information to from the Draw File drop-down list. If you 

want to create a new draw file, select New from the Draw File drop-down list and type the new draw file 
name in the available text box.  

10. Click Receive From Device. 
11. Repeats steps 9–10 for each waypoint file you want to receive. 
12. Click Finish. 
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To Receive Waypoints as a Waypoint File 
Use the following steps to receive waypoints from your GPS device. 

1. Connect your GPS receiver to your computer. 
2. If you are using a third-party GPS receiver, you may have to use specific settings. For example, if you are 

using a GARMIN GPS receiver, set your GARMIN receiver interface to GRMN/GRMN. For more 
information, see your owner manual or GPS Settings for Third-Party Devices on page 132. 

3. Click the GPS tab, click Settings, and then click Exchange. The Exchange Wizard displays. 
OR 
Click the Map Files tab and then click Exchange. The Exchange Wizard displays. 

4. Under Device Type, select GPS. 
5. Select Receive from Device. 
6. Select Waypoints from the Object drop-down list. 
7. Select User Map Data - Waypoints from the Save As drop-down list. 
8. Click Next. 
9. Select the waypoint file you want to add the waypoint information to from the Waypoint File drop-down 

list. If you want to create a new Waypoint file, select New from the Waypoint File drop-down list and type 
the new waypoint file name in the New Waypoint File text box.  

10. Click Receive From Device. 
11. Repeats steps 9–10 for each waypoint file you want to receive. 
12. Click Finish. 
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Route 
Route Overview 
The Route tab in Street Atlas USA 2005 Plus allows you to perform the following functions: 

• Create road routes by adding start and finish points to your map. 
• Add or insert vias and stops to your routes. 
• Schedule end of day and fuel breaks along a route by using the Plan Trip subtab. 
• Save multiple routes and display them in multiple Map Files. 
• Delete routes that are no longer needed. 
• Edit routes by:  

 Changing the name. 
 Reordering the waypoints. 
 Adding, inserting, moving, or deleting stops and vias. 
 Reversing the order of the route, and so forth.  

• View route directions for the currently selected route as point-to-point bearings. 

Creating a Route 
Use the Route tab in Street Atlas USA 2005 Plus to create a route, view route directions, edit a route, display routes 
on a map, and so forth. 

To Create a Route 
Use the following steps to create a route. 

1. Click the Route tab and then click New/Edit. The New/Edit Route dialog area displays. 
2. Click File, click New, and then type the name for your route in the Name text box. 

3. Click the Start tool  and then click the point on the map where you want to begin your route. 
OR 
Type your start location in the Start drop-down text box. If you type an address, it must be in one of the 
following formats: street address, city, state OR street address, ZIP Code. 
OR 
Right-click the map location where you want to begin your route. A shortcut menu displays. Point to 
Create Route and then click Set as Start. 

4. Click the Finish tool  and then click the spot on the map where you want to end your route. 
OR 
Type your finish location in the Finish drop-down text box. If you type an address, it must be in one of the 
following formats: street address, city, state OR street address, ZIP Code. 
OR 
Right-click the map location where you want to end your route. A shortcut menu displays. Point to Create 
Route and then click Set as Finish. 

5. Select a route type (Road-Shortest or Road-Quickest) from the available drop-down list. 
6. If you do not have the Auto Calc check box selected, click Calculate. 

OR 
If you do not have the Auto Calc check box selected, right-click the route, point to Manage Route, and 
then click Calculate Road Quickest or Calculate Road Shortest from the shortcut menu. 
Note: If Street Atlas USA 2005 Plus is unable to find an exact match for the item that you typed, a dialog 
box displays with a list of the closest matches. Scroll through the list of search results until you find the one 
you want to locate, click the item to select it, and then click OK.  

7. Click Directions to view the route directions. 
AND/OR 
Click Advanced to display the advanced routing options. 
AND/OR 
Click Plan Trip to assign end of day or fuel breaks to your route. 
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AND/OR 
Click Back on Track to add your current GPS position as a stop to the current route. 

Adding and Inserting Stops and Vias 
When routing in your Street Atlas USA 2005 Plus, you have the option of adding/inserting stops or vias in the route. 
A stop is a location in the middle of a route where you want to stop and then proceed from. A via is a road on the 
map that you want to specifically use when routing. Street Atlas USA 2005 Plus lets you use stops and vias to route 
you through a particular place or along a particular road.  

 

When using a road as a stop or via, be sure to zoom in so that the correct road is selected. The selected 
road segment becomes highlighted when clicked. 

To Add a Stop or Via To Your Route 
The Add Stop/Via function adds stops/vias in the order they are added to the route. Use the following steps to add a 
stop or via to your route. 

1. Create a route. 
2. In the New/Edit dialog area in the Route tab: 

 If adding a stop, verify the button next to the Stop tool  is labeled Add. If it is not labeled Add, 
click the arrow next to the button and select Add from the shortcut menu. 

 If adding a via, verify the button next to the Via tool  is labeled Add. If it is not labeled Add, 
click the arrow next to the button and select Add from the shortcut menu. 

3. To add a stop, click the Stop tool  and then click the spot on the map where you want to stop on your 
route. 

To add a via, click the Via tool , and then click the spot on the map where you want to route through. 
OR 
Type the stop location in the Stop (or Via) text box. If you type an address, it must be in one of the 
following formats: street address, city, state OR street address, ZIP Code. 
OR 
Right-click on the map area you want to add a stop to your route. A shortcut menu displays. Point to 
Create Route and then click Add Stop or Add Via. 

4. If you have not selected the Auto Calc check box, click Calculate to recalculate your route to include the 
stop or via. 
OR 
If you do not have the Auto Calc check box selected, right-click the route, point to Manage Route, and 
then click Calculate Road Quickest or Calculate Road Shortest from the shortcut menu. 
Note: If Street Atlas USA 2005 Plus is unable to find an exact match for the item that you entered, a dialog 
box displays with a list of the closest matches. Scroll through the list of search results until you find the one 
you want to locate, click the item to select it, and click OK.  

5. Click Directions to view the route directions. 
AND/OR 
Click Advanced to display the advanced routing options. 
AND/OR 
Click Plan Trip to assign end of day or fuel breaks to your route. 
AND/OR 
Click Back on Track to add your current GPS position as a stop to the current route. 

To Insert a Stop or Via Into Your Route 
The Insert Stop/Via function arranges stops/vias geographically in the route. Use the following steps to insert a stop 
or via to your route. 

1. Create a route. 
2. In the New/Edit dialog area in the Route tab: 

 If inserting a stop, verify the button next to the Stop tool  is labeled Insert. If it is not labeled 
Insert, click the arrow next to the button and select Insert from the shortcut menu. 
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 If inserting a via, verify the button next to the Via tool  is labeled Insert. If it is not labeled 
Insert, click the arrow next to the button and select Insert from the shortcut menu. 

3. To insert a stop, click the Stop tool  and then click the spot on the map where you want to stop on your 
route. 

To insert a via, click the Via tool , and then click the spot on the map where you want to route through. 
OR 
Type the stop location in the Stop (or Via) text box. If you type an address, it must be in one of the 
following formats: street address, city, state OR street address, ZIP Code. 
OR 
Right-click on the map area you want to insert a stop/via to your route. A shortcut menu displays. Point to 
Create Route and then click Insert Stop or Insert Via. 

4. If you have not selected the Auto Calc check box, click Calculate to recalculate your route to include the 
stop or via. 
OR 
If you do not have the Auto Calc check box selected, right-click the route, point to Manage Route, and 
then click Calculate Road Quickest or Calculate Road Shortest from the shortcut menu. 
Note: If Street Atlas USA 2005 Plus is unable to find an exact match for the item that you entered, a dialog 
box displays with a list of the closest matches. Scroll through the list of search results until you find the one 
you want to locate, click the item to select it, and click OK.  

5. Click Directions to view the route directions. 
AND/OR 
Click Advanced to display the advanced routing options. 
AND/OR 
Click Plan Trip to assign end of day or fuel breaks to your route. 
AND/OR 
Click Back on Track to add your current GPS position as a stop to the current route. 

Changing the Properties of a Stop Along Your Route 
You can change the properties of a stop along your route in Street Atlas USA 2005 Plus by using the Stop Time 
function in the Advanced sub-tab under Route. 

To Change the Properties of a Stop 
Use the following steps to change the properties of a stop. 

1. Click the Route tab and then click Advanced. 
2. Click a stop from the waypoint list and then click Stop Prefs. The Stop Time Preferences dialog box 

displays. 
3. To designate the stop as an end of day stop, select the End of Day check box, click Apply, and then click 

Done.  
AND/OR 
To designate the stop as a fuel break, select the Fuel check box, click Apply, select the Duration check 
box, select the duration of the fuel break using the Hrs and Mins drop-down lists, and then click Done. 
Note: It is not necessary to allocate a fuel stop duration. 

Viewing Route Directions 
After you have created a route, you can view the accompanying route directions. 

To View the Route Directions 
Use the following steps to view the route directions. 

1. Click the Route tab and then click Directions to open the Route Directions dialog area. The list of routes 
you have created display in the route list on the left. A check mark indicates the route is displaying on the 
map. 
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2. Click a route to select it and then click Go To to center it on the map. 
OR 
Double-click a route to center it on the map. 

3. The route directions for the selected route are displayed in the window on the right. Click the Increase to 
Maximum Height button  in the upper-right corner of the tab area to expand the list view.  

Note: You can click the header of a column to access a shortcut menu that allows you to select which type of 
information you want to display in each column. 

4. Click a leg to select it and then click Go To to center the map on the leg. 
OR 
Double-click a leg to center the map on the leg. 

 

When tracking with a GPS receiver, you can click the GPS Track option to follow along with the 
route directions in real time as you travel. Click Show Turns to display the current distance and time 
to your finish. 

 

Editing a Route 
Street Atlas USA 2005 Plus allows you to modify existing routes by: 

• Adding, removing, and rearranging stops and vias. 
• Adjusting your route preferences based on road type. 
• Customizing your route based on your driving style and speed. 

 

Zoom in to set accurate points for your route. 

To Edit a Route 
To edit a route, click the Route tab and then click Advanced. The Advanced dialog area displays. Select the desired 
route from the Name drop-down list box. The route becomes active. The following list describes the edit functions 
available. 

• To change the route name, select the name in the Name text box, type the new route name, and then press 
the ENTER key on your keyboard. 

• To change your start or finish point, click the corresponding tool, the Start tool  or the Finish tool , 
and then click the new spot on the map.  
OR 
Select the Start or Finish point on the map and drag it to the desired location on the map. 
Note: If you try to add a start or finish point to an existing route, you are prompted "Would you like to 
move your Start/Finish location or create a new route" Click New if you want to begin creating a new 
route. Click Move to move the Start/Finish point to the last location clicked. 

• To add/insert a stop or via to your route, click the corresponding tool, the Stop tool  or the Via tool , 
and then click the spot on the map where you want to add/insert your stop/via.  

• To rearrange stops and vias, click the desired waypoint to select it and then click the Move Up  or 

Move Down  tools to relocate it in the route.  
• To delete a stop or via, select the desired stop or via and then click the delete button.  
• To change a stop to a via, select the desired stop and click Make Via. To change a via to a stop, select the 

desired via and then click Make Stop. 
• Click Reverse Rte to reverse the order of all of the waypoints in the route. 
• Click Calculate, if you do not have the Auto Calc check box selected in the New/Edit subtab. 
• Click Comments to add an alternate name to your start, finish, stop, or via. 

Note: Press CTRL+ENTER to type additional lines of text. 
• Click Stop Prefs to make a stop in your route a fuel or end of day stop. For more information, see Setting 

Your End of Day and Fuel Break Preferences on page 151. 
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Setting Your Routing Preferences 
Once you have mastered basic routing, you can customize your routing preferences and create more complex routes.  
The routing preferences allow you to tell Street Atlas USA 2005 Plus whether you would like to favor or avoid 
various road types when calculating your route. You can also set your speed preferences to reflect your particular 
driving style. 

To Set Your Routing Preferences 
Use the following steps to set your routing preferences. 

1. Click the Route tab and then click Advanced to open the Advanced Routing dialog area. 
2. Click Route Prefs to display the Route Preferences dialog area.  
3. From the Road Type drop-down list, select the road type for which you want to set preferences. 
4. From the Level drop-down list, select Preferred, Standard, or Avoid. Preferred tells it to favor this type of 

road whenever possible, Standard is the default level, and Avoid tells Street Atlas USA 2005 Plus to avoid 
this type of road whenever possible. 
Note: An avoided road may be used if there is no other road type available. 

5. In the Speed text box, type your average driving speed for this road type. 
Note: Street Atlas USA 2005 Plus uses these speeds to compute the travel time for a route. 

6. In the Urban Speed text box, type your average driving speed for this road type within urban area.  
Note: Street Atlas USA 2005 Plus uses these speeds to compute the travel time for a route. The Urban 
Speed text box is only available for road routes. 

7. Repeat steps 3–6 for each road type. 
• When you are finished setting your road preferences, click Review to display all your settings.  
• Click Use Defaults to restore all road types to the Standard preference level. 

8. Under Route Features, select one or all of the following check boxes: 
• Automatic Calculation—Automatically recalculates your route each time you make a change to it. 
• Show Location MapNotes—Displays Location MapNotes with their coordinate information for each 

point in your route. 
• Show Comments MapNotes—Displays comments about your route. 
• Show Summary MapNotes—Displays time and distance information for each waypoint and the finish 

point of your route. 
• GPS Voice Navigation—Provides spoken route directions when you are tracking with a GPS receiver. 

After initializing, the computer speaks the directions for the next turn in your route. It repeats the 
instructions approximately 60 seconds prior to arriving at the turn. 

• Display Waypoint Labels—Displays start/stop/via/finish labels on the map when the route is created. 
• Display Route Vias—Shows or hides your route vias on the map. 
• Include State Borders—Shows or hides state borders in your route directions. 

9. Click Done when you are finished setting your preferences. 

Editing Roads 
Street Atlas USA 2005 Plus allows users to change the characteristics of any road on their map to: 

• Two Way 
• One Way N or E 
• No Left Turn N or E 
• No Right Turn N or E 
• No Way 
• One Way S or W 
• No Left Turn S or W 
• No Right Turn S or W 

To Edit a Road 
Use the following steps to edit a road. 

1. Click the Route tab and then click Advanced to open the Advanced Routing dialog area. 
2. Click Edit Roads. 
3. Select the Display Road Edits check box to show existing road edits on the map. 
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4. Click the Select tool  and select the road on the map you wish to edit. 
5. Select a direction. 

• If you select Two Way, you can also select a No Left Turn option, a No Right Turn option, or a One 
Way option. 

• If you select a One Way option, you can select a No Left Turn option or a No Right Turn option. 
• If you select No Way, no other options can be selected. 
Note: Click Default to change the road properties to the default settings. Click Clear All Edits to remove 
all road options and return all road properties to their default settings. 

6. Click Done. 

Labeling a Waypoint with a MapNote 
With the right-click option in Street Atlas USA 2005 Plus, you can add any of the following MapNotes to a start, 
finish, stop, or via on your route: 

• MapNote—Displays an uneditable MapNote with the name of the waypoint location. 
• Detailed MapNote—Displays an uneditable MapNote with the name, feature name, feature category, and 

ZIP Code of the waypoint location. 
• Where Am I MapNote—Displays an uneditable MapNote with the city, county, state, and ZIP Code for 

the waypoint location. 
• Coordinate MapNote—Displays an uneditable MapNote with the coordinates for the waypoint location. 
• Blank MapNote—Displays a blank, editable MapNote. 

To Label a Waypoint 
Use the following steps to label a waypoint. 

1. Position your cursor over the start, finish, stop, or via you want to label. 
2. Right-click to display the shortcut menu. 
3. Point to Add MapNote and then click the MapNote of your choice. The MapNote displays on your map. 

Note: To edit a MapNote, right-click the MapNote, point to Manage Draw, and then click Edit Draw 
Object Text.  

Saving a Route 
Street Atlas USA 2005 Plus retains the route in memory as you create it. You are prompted to save your route when 
you create a new Map File or exit Street Atlas USA 2005 Plus.  

• Creating a New Map File—When you click File/New on the Files dialog area on the Map Files tab, you are 
asked if you want to save changes to the most recently used Map File. A separate dialog box asks if you 
want to save changes to an unsaved route. 

• Exiting Street Atlas USA 2005—The Save Changes dialog box asks if you want to save your changes. 
You can also save the route using the Route tab.  

 

Routes have .anr extensions and are saved in the C:\DeLorme Docs\Navigation directory by default. 

To Save a Route Using the Route Tab 
Use the following steps to save a route using the Route tab. 

1. Create a route. 
2. Click the Route tab and then click New/Edit. The New/Edit dialog area displays. 
3. Click File and then click Save.  

Deleting a Route 
Street Atlas USA 2005 Plus allows you to delete routes permanently. 

To Delete a Route 
Use the following steps to delete a route. 

1. Click the Route tab and then click New/Edit. The New/Edit Route dialog area displays.  
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2. Select the desired route from the Name drop-down list. 
3. Click File and then click Delete.  

OR 
Right-click the route, point to Manage Route, and then click Delete Route. 

Displaying and Centering Routes on the Map 
Street Atlas USA 2005 Plus automatically displays all the routes you create. The active route displays as a gold line 
outlined in red. Inactive route(s) display as dashed, orange lines outlined in green. 
However, you can choose to display only certain routes without deleting them from the map. 

To Display a Route on the Map 
Use the following steps to display a hidden route on the map. 

1. Click the Route tab and then click Directions. The Route Directions dialog area displays.  
2. In the route list on the left, select the check box of the route you want to display and then click Go To. The 

route displays on the map. 

To Clear (Hide) a Route from the Map 
Use the following steps to hide a route from view on the map.  

1. Click the Route tab and then click Directions. The Route Directions dialog area displays. 
2. In the route list on the left, clear the check box(es) of the route(s) you want to hide from view on the map. 

Only those routes with their check boxes selected (checked) display on your map. 
OR 
Right-click on the route you want to clear from the map view, point to Manage Route, and then click Hide 
Route. 

To Center the Map on a Route 
Use the following steps to center a route on the map. 

1. Click the Route tab and then click Directions. The Directions dialog area displays. 
2. In the route list, select a route and click Go To. 

OR 
Double-click the desired route. The route is displays on the map. 

 

If a route is not in the current map view, you can center the route by clicking the Route tab, clicking 
New/Edit, and then selecting the desired route from the Name drop-down list. 

 

Setting Your End of Day and Fuel Break Preferences 
Street Atlas USA 2005 Plus allows you to schedule end of day and fuel breaks along a route by using the Plan Trip 
option in the Route tab. You can schedule end of day breaks according to the miles (or other distance unit selected in 
Map Display) or hours driven and you can schedule fuel breaks according to your current fuel level, your vehicle's 
fuel consumption rate, and so forth. 

 

This feature of Street Atlas USA 2005 Plus works with the route preferences you have designated 
with the Route Preferences option under Route. For more information, see Setting Your Routing 
Preferences on page 149.  

To Set Your End of Day and Fuel Stop Preferences 
Use the following steps to set your time preferences. 

1. Create a route. 
2. Click the Route tab and then click Plan Trip to open the Plan Trip dialog area. 
3. Select the Estimate End of Day Breaks check box to schedule end of day breaks for your trip. (This step 

is optional.) 
 Select Hours per day to schedule your end of day breaks after a designated number of hours 

traveled per day. Then, type the amount of hours you want to travel per day in the available text 
box. Use the Flexibility drop-down list to determine the amount of time you want to be flexible 
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between breaks and defined stops. For example, if you selected 1.5 Hrs from the Flexibility drop-
down list and have an end of day break within 1.5 hours of a planned stop, the end of day break is 
moved to the planned stop. 

OR 
 Select mi per day to schedule your end of day breaks after a designated number of miles traveled 

per day. Then, type the number of miles you want to travel per day in the available text box. Use 
the Flexibility drop-down list to determine the number of miles you want to be flexible between 
breaks and defined stops. For example, if you selected 50 mi from the Flexibility drop-down list 
and have an end of day break within 50 miles of a planned stop, the end of day break is moved to 
the planned stop. 
Note: The distance units used here are based on those selected on the Units dialog area in the Map 
Display tab. For more information, see Setting Units of Measure Preferences on page 166. 

3. Select the Estimate Fuel Breaks check box to schedule fuel breaks for your trip. (This step is optional.) 
 Type the fuel tank capacity (in gallons) in the Tank Cap text box. 
 Type the fuel consumption rate (in miles per gallon or the distance unit you have selected on the 

Units dialog area in the Map Display tab) for your vehicle in the Fuel Rate text box. 
 Select the amount closest to your current fuel tank level from the Starting level drop-down list. 
 Select the amount of fuel you would like to have in your tank when warned to stop for fuel from 

the Warning Level drop-down list.  
4. Click Apply. 

Estimating the Fuel Cost of Your Route 
The Plan Trip subtab of the Route tab lets you estimate the fuel cost of your route using the fuel rate (how many 
gallons of fuel your vehicle uses per mile/kilometer traveled) and fuel price per gallon. 

To Estimate the Fuel Cost of Your Route 
Use the following steps to estimate the fuel cost of your route. 

1. Create a route. 
2. Click the Plan Trip subtab (in the Route tab). The Plan Trip dialog area displays. 
3. Click Fuel Cost. The Fuel Cost Estimate dialog box displays. 
4. Type the fuel rate for your vehicle in the Fuel Rate text box. The fuel rate can often be found in the 

vehicle's owners manual. 
5. Type the price of your fuel in the Fuel Price text box. The estimated fuel cost (in U.S. dollars) for your 

route automatically calculates when the Fuel Rate and Fuel Price text boxes are populated. The estimated 
fuel cost for your route displays in the Total Fuel Cost field. 

6. Click Close to close the dialog box and return to the Plan Trip subtab. 

Importing Routes 
Routes can be imported from many other DeLorme mapping programs by using a drag and drop operation or the 
Route tab.  

To Import an Existing Route Using the Drag and Drop Operation 
Use the following steps to import an existing route into Street Atlas USA 2005 Plus using a drag and drop operation. 

1. Open Street Atlas USA 2005 Plus. 
2. Using Windows® Explorer®, browse to the source folder of the desired file. The default directory is 

C:\DeLorme Docs\Navigation. 
3. Locate the file you want to import.  
4. Minimize or resize the Explorer window so Street Atlas USA 2005 Plus is visible behind Explorer. Drag 

the desired file from Explorer and drop it onto the Street Atlas USA 2005 Plus map. The imported route is 
automatically converted to an Street Atlas USA 2005 Plus route. 

5. To view the route, click the Route tab, click New/Edit, and select the route from the Name drop-down box. 

To Import an Existing Route Using the Route Tab 
Use the following steps to import an existing route into Street Atlas USA 2005 Plus using the Route tab. 

1. Click the Route tab and then click New/Edit. The New/Edit Route dialog area displays. 
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2. Click File and then click Import. The Import dialog box displays.  
3. Browse to select the desired route file and then click Open. The map centers on the imported route and is 

available from the Name drop-down list. 
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Info 
Getting Information About Map Features 
The Street Atlas USA 2005 Plus status bar (located above the tab area) displays point of interest name (if 
applicable), street name/address, highway, city, state, and ZIP Code information for the map location that your 
cursor is positioned on.  
You can also right-click a point, symbol, feature, or area on the map to identify it and view detailed information 
about it. The type of descriptive information varies, depending on the item you have right-clicked. You can also 
copy the information and paste it into another program, such as a word processor. 

To Get Information About a Map Feature Using Right-Click Functionality 
Use the following steps to get information about a particular map feature. 

1. Right-click the desired map feature, such as a road, town, or point of interest. The right-click options 
available for that type of feature display. 

2. Click Info. A list of information categories display.  
Note: Descriptive information may include a name or feature type, telephone number, length/area, URL, 
ZIP Code, town name, county name, state, coordinates, available radio stations, demographic detail, and so 
forth. 

3. Click the plus sign next to each of the information categories to expand the category to view more detailed 
information. 
OR 
Right-click in the information box and click Expand All to expand all of the information categories. Right-
click in the information box again and click Collapse All to minimize all of the information categories. 

4. Optional: Right-click in the information box and click Print to print your map feature information. 

To Copy Map Feature Information into Another Program 
Use the following steps to copy the data in the Info tab and paste it into another program, such as a word processor.  

1. Select the desired text by dragging across it. 
OR 
If you want all the information in the dialog area, right-click the information box and then click Select All. 

2. Right-click the information box with the selected text and then click Copy. 
OR 
Press CTRL+C on your keyboard. 

3. Open or switch to the program where you want to paste the text. 
4. Right-click the selected location and then click Paste. 

OR 
If the program you are pasting information into has a menu bar, under the Edit menu, click Paste. 
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Voice 
Voice Overview 
Equipped with speech recognition and text-to-speech technology, Street Atlas USA 2005 Plus lets you issue a series 
of voice commands to a laptop computer. The voice commands activate basic navigation, map control, and GPS 
features, providing you with hands-free program navigation so you can concentrate on your driving. When tracking 
with a GPS receiver, you can receive spoken updates about your route directions, next turn, next stop, current 
location, etc. 

To Use Speech and Text-to-Speech Recognition 
Use the following steps to use speech recognition and text-to-speech. For more information, see additional topics in 
the Voice section of this Help system. 

1. Click the Voice tab.  
2. Click Input Prefs to select a speech recognition (voice) engine, set the voice model for the current user, 

and to train the speech recognition engine to recognize your specific speech patterns. 
3. Click Monitor and select the Microphone check box to activate your microphone, display status 

information, and display the voice command list. 
4. Click Output Prefs to change and preview the tone and quality of the computer's voice. 

 

• The "Voice" label on the Voice tab will display red when the microphone is activated. 
• Street Atlas USA 2005 Plus comes equipped with Microsoft English Recognizer Version 5.1. 

Other speech recognition engines, which you may have purchased separately, can also be 
used. Such speech recognition engines must support SAPI 5.1 in order to be available to you 
in Street Atlas USA 2005. See the Speech settings in the Windows Control Panel for more 
information about your engine. 

• You must have a microphone attached to your computer to use speech recognition (for 
input). 

• For tips on using the speech recognition feature and setting up your microphone, see Speech 
Recognition Tips on page 160. 

• If you are having difficulty hearing the voice output, adjust the volume on your external 
speakers or adjust your computer's volume using the settings in the Windows Control Panel.  

• When you installed Street Atlas USA 2005 Plus, you were asked whether or not to install a 
speech recognition engine for voice input. If you want to use voice input in Street Atlas USA 
2005 Plus and selected not to install a speech recognition engine when you installed the 
program, you must uninstall and then reinstall Street Atlas USA 2005 Plus (making sure to 
select to install the speech recognition engine). 

• Windows 98 Users: If you use the Speech icon in the Windows Control Panel to modify 
speech engine properties for your computer, there may be two "Speech" icons in your 
Windows Control Panel. Please ensure that you choose the newer speech engine properties 
dialog. The dialog contains separate tabs labeled "Speech Recognition" and "Text to 
Speech". The older dialog contains only a "Speech" tab. 

 

Activating and Monitoring Voice Recognition 
The Monitor dialog area in the Voice tab lets you view status information about your microphone and the list of 
available voice commands. 

• The Microphone bar (VU meter) indicates the level of sound received from the microphone. 
• The Command Status section displays either the last recognized voice command or one of the following 

error messages: 
 Too noisy 
 No signal 
 Input too loud 
 Input too quiet 
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• The Commands list box lists the voice commands for accessing the Voice tab, navigating, using the map, 
and using GPS. 

To Activate and Monitor the Speech Recognition Feature 
Use the following steps to activate and monitor the speech recognition feature. 

1. Click the Voice tab and then click Monitor to display the Monitor dialog area. 
2. Select the Microphone check box to activate your microphone and to turn on the speech recognition 

feature. 
Note: If your microphone is active when you exit Street Atlas USA 2005 Plus, it will still be active when 
you re-enter the application. 

3. To trigger an audible signal when a voice command is recognized, select the Beep When Heard check 
box. 

4. To display all of the possible voice commands, including variations of the commands, select the Show All 
Commands check box. Both enabled  and disabled commands are displayed. 

Training the Speech Recognition Engine 
You should train the speech recognition engine to provide good speech recognition results.  

 

Before training, ensure your microphone is active and the speech recognition feature is on. For more 
information, see Activating and Monitoring Speech Recognition on page 157. 

To Train the Engine to Recognize Your Speech Patterns 
You should train the speech recognition engine to recognize your specific speech patterns. This is often done by 
reading a predetermined piece of text supplied by the creator of the speech recognition engine. If the engine supports 
multiple user models, you can train the engine to recognize more than one speech pattern. 
Use the following steps to train the speech recognition engine to recognize your speech patterns. 

1. Click the Voice tab and then click Input Prefs to display the Input Preferences dialog area. 
2. Select the microphone you intend to use from the Microphone drop-down list. 
3. Select your preferred speech recognition engine from the Recognizer drop-down list. 

Note: Select the most recent version available in the drop-down list. 
4. Select your preferred user voice model from the User Profile drop-down list. 
5. Click Options and then click Voice Training to display the speech training wizard specific to your voice 

recognition engine. 
Note: This feature is only available if it is supported by your speech recognition engine. 

6. Follow the on-screen instructions. 

 

For best results: 
• Use a close-talk microphone that rests near the side of your mouth instead of a desktop or 

built-in microphone. 
• Train the voice recognition engine in the same environment in which you will use it. For 

example, if you use the engine mostly in the car, perform training in the car. Performing 
three training sessions provides the best results. 

• When training, speak the same voice as you will when giving voice commands to the 
computer. Speak distinctly and at an average speed, as if giving a command. 

• Use the Microphone Wizard to ensure your microphone is working correctly and to view tips 
on microphone selection and placement. To use the wizard, click Options and then click 
Microphone Startup. Or, from the Start menu, you can point to Settings and then click 
Control Panel. Double-click the Speech icon to display the Speech Properties dialog box.  

• To increase the likelihood of correct voice recognition, in the Input Prefs dialog area select 
the Commands must start with check box. Click Set Phrase and type the appropriate 
word/phrase in the available text box (if using a single word, use a word with more than one 
syllable). For example, if you type computer, you would then say "Computer, zoom in."  
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Voice Commands 
Street Atlas USA 2005 Plus includes navigation, map, GPS, and Voice tab control commands. Select the Show All 
Commands check box to view all options, including those which are variations or unavailable. 

 

A blank cell indicates a shortcut key is not available for that spoken command. 

Navigation Commands  
The following table shows Navigation voice commands and their shortcut keys.  
Spoken Command Key Response 
What is the next turn? 
Next turn. 
What's the next turn? 

F5 Speaks the next turn name, time to turn, distance to turn, 
bearing to turn, and turn direction. Displays the Directions 
subtab in the Route tab. 

Show (my, the) next turn. CTRL+F5  Displays current location and next turn. Displays the 
Directions subtab in the Route tab. 

Center on (my, the) next turn. ALT+F5  Centers map on the next turn. Displays the Directions subtab 
in the Route tab. 

What is the next stop?  
Next stop. 
What's the next stop? 

F9 Speaks the next stop name, distance to stop, bearing to stop, 
and time to stop. Displays the Directions subtab in the Route 
tab. 

Show (my, the) next stop.  CTRL+F9 Displays current location and next stop. Displays the 
Directions subtab in the Route tab. 

Center on (my, the) next stop.  ALT+F9 Centers map on the next stop. Displays the Directions subtab 
in the Route tab. 

After that.  Speaks the next stop or turn information, depending on the 
previous spoken direction. 

Are we there yet? F7 Speaks the finish name, time to finish, and distance to finish. 
Show (my, the) finish. CTRL+F7 Displays current location and finish on the map. 
Center on (my, the) finish. ALT+F7 Centers map on the finish. Displays the Directions subtab in 

the Route tab. 
Directions. CTRL+F8 Speaks the next turn, next stop, finish, name, time, and 

distance. Displays the Directions subtab in the Route tab. 
Where am I? F8  Speaks current route segment, heading, speed, town, county, 

and state. 
Coordinates.  Speaks the coordinate of your current location. 
Shush. Silences GPS voice navigation, but does not turn it off. 
Be quiet. 

CTRL+E  
Silences GPS voice navigation, but does not turn it off. 

(Turn) voice nav on/off. CTRL+D  Turns voice navigation on or off. 
Show (my, the) route.   Displays your route on the map. 
Back on Track.  Adds current GPS location as a stop and recalculates the route. 
Continue (my, the) route from 
here.  

 Adds current location as a stop and recalculates the route. 

Show turns.  Activates the Show Turns dialog area in the Route tab. 
Show directions.  Activates the Directions subtab in the Route tab. 

Map Commands  
The following table shows Map voice commands and their shortcut keys.  
Spoken Command Key Response 
Pan (map, the map) left. 
Scroll (map, the map) left. 

ALT+LEFT ARROW Pans (or scrolls) the map left. 

Pan (map, the map) right. ALT+RIGHT ARROW Pans (or scrolls) the map right. 
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Spoken Command Key Response 
Scroll (map, the map) right. 
Pan (map, the map) up. 
Scroll (map, the map) up. 

ALT+UP ARROW Pans (or scrolls) the map up. 

Pan (map, the map) down. 
Scroll (map, the map) 
down. 

ALT+DOWN ARROW Pans (or scrolls) the map down. 

Zoom in. 
Zoom in 1 time. 

ALT+PAGE DOWN Zooms in one level. 

Zoom out. 
Zoom out 1 time. 

ALT+PAGE UP Zooms out one level. 

Zoom in <1–x> times.  Zooms in the specified number of levels. 
Zoom out <1–x> times.  Zooms out the specified number of levels. 
Zoom level <2–x>.   Zooms to specified level. 
Previous Map.  
Go back.   

Displays the previous map. 

GPS Commands  
The following table shows GPS voice commands and their shortcut keys.  
Spoken Command Key Response 
Start (my, the) GPS. Starts GPS tracking. 
Stop (my, the) GPS. 

CTRL+G 
Stops GPS tracking. 

GPS Status.  Displays the GPS Status subtab. 
Monitor GPS.  Displays the GPS Monitor subtab. 
Center (my, the) on GPS.  Recenters the map on the current GPS location. 
Stop Centering on (my, the) 
GPS 
Stop Center on (my, the) 
GPS 

CTRL+W 
Stops the map from recentering on your current 
GPS location. 

Clear GPS.  Clears the GPS "bread crumb trail" from the map. 
(Turn) Autorotate Map 
On/Off. 

 Turns automatic map rotation on/off. 

 

Voice Tab Commands  
The following table shows Voice Tab voice commands and the response.  
Spoken Command Response 
What can I say? Displays the Monitor dialog box. 
More commands. Displays next page of voice commands. 
Again.  Repeats your last spoken direction. 
 

Speech Recognition Tips 
The following tips provide information on using the speech recognition feature and setting up your microphone. 

• Voice commands are only active when Street Atlas USA 2005 Plus is the active window. 
• An enabled command appears with this symbol . Commands become enabled based on your current GPS 

status, your data zoom level, and other factors. 
• A disabled command appears with this symbol . 
• Holding your pointer over a command displays a ToolTip for that command. 
• Avoid noisy environments when using voice command navigation. 
• Use a close-talk microphone for best speech recognition results. 
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• Properly position your microphone to achieve the best speech recognition results. For a close-talk 
microphone, the recommended position is a thumb-width from the corner of your mouth and slightly to the 
side. For more information, see the note at the end of this topic. 

• Speak the same voice as you will when giving voice commands to the computer. 
• Maintain the manner of speech used in training the voice recognition engine. 
• Keep the microphone as far as possible from the car radio or console, computer speakers or other speakers. 
• If your microphone is near your speakers, and you are using the microphone together with voice reminders 

(GPS VoiceNav), the program may recognize some of the words that it is speaking and react to them.  Here 
are ways to eliminate this problem: 

• Make sure that you have chosen the Voice Output device (speakers, headset) and the Input device 
(on-board microphone, headset microphone) that you intend to use with DeLorme GPS voice 
navigation. Use the selections that are available in the Input Prefs and Output Prefs subtabs. 

• If more than one speech recognizer is available in the drop-down list, choose the most recent 
(highest version number). 

• Your best voice recognition responses will always be to use a close-talk microphone with voice 
output using the laptop speakers rather than a headphone speaker so that the computer will not 
"hear itself.". 

• If you are speaking with someone else in the room, have a radio or television on, and so on, the 
computer may think those sounds are commands to follow.  Only select the Microphone check 
box on the Voice tab when you intend to use it (press the F4 key on your keyboard to toggle the 
microphone on/off at any time). If you exit the program with the Microphone check box selected, 
the program will start voice recognition again when you restart the program. Voice recognition 
requires a lot of disk space and slows down the system if you are not using it.   

• Use the “Simon Says” feature to clearly distinguish commands from other noise and speech. In the 
Input Prefs subtab (of the Voice tab), set the “Commands start with” phrase to something like 
“computer” or “Simon Says” to reduce the chances of an unexpected command recognition. When 
choosing a phrase, make sure that it is more than one syllable. The phrases "Computer" or "Simon 
Says" work well. But the simple word "Map" probably will not. 

• The sensitivity of some voice engines can be tuned using the Engine Properties button in the Input 
Prefs subtab. 

• Train the voice recognition system in the environment in which you will use it (for example, in a 
noisy car). 

 

To find out the proper position for your microphone model, or to find tips on how to purchase a 
microphone, click Options and then click Microphone Startup. Or, from the Start menu, you can 
point to Settings and then click Control Panel. Double-click the Speech icon to display the Speech 
Properties dialog box. 

 

Changing Voice Output 
Street Atlas USA 2005 Plus offers text-to-speech technology so you can receive spoken updates about your route 
directions, next turn, next stop, current location, time to finish, or current coordinates when tracking with a GPS 
receiver. Text-to-speech allows hands-free navigation of the Street Atlas USA program on your computer. 
Use your text-to-speech engine to change and preview the tone and quality of the computer's voice. 

To Change the Voice Output 
Use the following steps to change your computer's voice. 

1. Click the Voice tab. 
2. Click Output Prefs. The Output Prefs dialog area displays. 
3. From the Voice drop-down list box, select a voice from the list of options. A description of the selected 

voice displays to the right of the drop-down list box. 
4. From the Device drop-down list box, select the output device from which you want to hear the computer's 

voice (for example, your speakers or a headset). 
5. To preview the voice, click Options and then click Test Voice, type a sample sentence, and then click OK. 

The sample sentence is spoken in the selected voice. 
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6. Use the Voice Volume spin box to adjust the output volume relative to the other programs you are running. 
By default, this is set to 100 (maximum). Note that you cannot set the volume higher than your speakers or 
Windows Control Panel settings capabilities. 

7. Use the Speaking Rate spin box to adjust the rate at which the computer's voice will speak. A value of 50 is 
normal. 

 

You can click Stop Speaking or press CTRL+E to halt the currently speaking voice at any time. 
Use CTRL+D to enable/disable voice output entirely. 

 

Voice Preferences 
The Input Prefs and Output Prefs dialog areas, accessed by the Input Prefs and Output Prefs buttons, display a series 
of Engine Option buttons. These option buttons allow you to view information or change preference settings in your 
speech recognition or text-to-speech engines. 

• Input Prefs—Lets you select a speech recognition engine, choose the microphone, set the voice model for 
the current user, and train the speech recognition engine to recognize your specific speech patterns. 

• Output Prefs—Lets you select a voice for spoken output, choose the output device, and provides a 
description of each selection. 

 

Some speech recognition or text-to-speech engines do not support some of the preference options. 

To View and Update Input Preferences 
To change speech input preferences, click the Voice tab and then click Input Prefs to display the Input Preferences 
dialog area. Following are the preference buttons available under Engine Options and a description of each. 

• Add/Delete Words—Choose to display the pronunciation wizard specific to your speech recognition 
engine and enter, edit, or view the words in your pronunciation vocabulary. Use this wizard when the 
speech recognition has trouble understanding a specific word that you are saying. 

• Voice Training—Choose to access the speech recognition training engine to train the engine to recognize 
your speech patterns. This process may take 10–15 minutes to complete. 

• Microphone Setup—Choose to display a wizard to adjust voice recognition whenever you change 
microphone or noise environments. 

• Recognizer Settings—Choose to change preferences for sensitivity and tolerance of errors in recognizing 
your voice. 
Note: Street Atlas USA comes equipped with Microsoft English Recognizer Version 5.1. You may have a 
more recent version (for example, Microsoft Office 2003 installs Microsoft English U.S. Version 6.1 
Recognizer). Select the most recent version. 

To View and Update Output Preferences 
To change speech input preferences, click the Voice tab and then click Output Prefs to display the Output 
Preferences dialog area. Click the Options button and choose from the available preferences: 

• Test Voice—Choose to display the preview voice dialog box for your text-to-speech engine. Type in a 
sentence and click OK to hear it spoken. 

• Audio Volume—Choose to adjust the speaker volume for all programs on your computer. This is 
equivalent to the same adjustment in the Windows Control Panel. 

• Stop Speaking (CTRL+E)—Click to cause the text-to-speech engine to stop speaking the current piece of 
information. 
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Map Display 
Map Display Overview 
Street Atlas USA 2005 Plus lets you customize the appearance of certain map features and units of measurement to 
meet your individual preferences. You can even create a set of custom features.  
To set your preferences, click the Map Display tab and then click: 

• Features to select which features display on the map, such as minor places, grids, one-way streets, ZIP 
Codes, and so forth.  
Note: The Features dialog area includes an advanced feature, where you can choose how hundreds of types 
of map objects display on the map. Select the Use Custom Points of Interest check box and then click 
Customize POIs to create a custom set of map features. 

• Display to change map magnification, to change the appearance of the map from the default colors to high-
contrast colors, or to change the data zoom level at which large POIs display on the map. 

• Units to change the units of measurement, the bearing (true north or magnetic north), and the coordinate 
format. 

Setting Map Feature Preferences  
Street Atlas USA 2005 Plus lets you change the display of a wide variety of map features so you can customize your 
map to meet your specific needs.  
You can choose to display or hide county borders, exits, grids, international labels, the map center crosshair, one-
way streets, places (minor), points of interest, roads (minor), town borders, urban areas, and ZIP Code boundaries. 
For a short description of each of these features, click the feature name and view the description in the information 
box.  
You can also customize your map features by selecting the Use Custom Map Features check box and clicking 
Customize Features. 

To Set Basic Map Feature Preferences 
Use the following steps to change the basic map feature preferences. Changes made to the map view display almost 
immediately after selection. 

1. Click the Map Display tab to open the Map Display dialog area.  
2. Click Features to view the map feature options. Under Features, a check mark indicates a feature is 

displaying on the map. 
3. Select the check box next to the map feature you want to display on the map. 

OR 
Clear the check box next to the map feature you want to hide on the map. 

 

If you cannot make changes to these basic preference check boxes, verify the Use Custom Map 
Features check box is not selected. 

To Set Custom Features 
This is an advanced feature which lets you create a specific, custom set of map features for your map display from 
hundreds of options. Note that changes are not visible until you click the Done button. 

1. Click the Map Display tab and then click Features.  
2. Select the Use Custom Map Features check box and then click Customize Features to display the 

custom options.  
Note: Custom map feature selections override selections in the basic Map Features list. 

3. To quickly search for a particular type of map feature, type the name of the desired item in the Search text 
box. A list of matching keywords displays and corresponding map feature types are listed in the Search 
Results window. Results for number of keywords and types found also displays.  

A check mark indicates the feature type displays on the map.  
• Select/clear the individual map feature check box to show/hide that feature and to center the 

directory tree (far-left window) on that type. 
• Click the small None button to the right of the Search Results window to show none of the map 

feature types listed. 
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• Click the small All button to the right of the Search Results window to display all of the map 
feature types listed. 

• Click Only to display only those map feature types listed in the Search Results window. 
• Click Exclude to display all map feature types except those listed in the Search Results window.  

4. To use the map feature tree to select which features display on the map, click the plus signs to expand the 
individual branches. A check mark indicates the feature type displays on the map.  
Note: Some branches expand further than others. Selecting/clearing a check box at a certain branch of the 
tree shows/hides all the items below that level. 

• Select/clear the individual map feature check box to show or hide that feature. 
• Click All to select all map features in the program.  
• Click None to select none of the types in the program. 

Note: A small number of features cannot be turned off. They are part of the base map display and 
cannot be changed. This explains why certain levels on the tree remain unavailable (appear 
dimmed or gray). 

5. When you are finished editing the custom map features, click Done. Your map view updates, displaying 
only those features you have selected. 

When you save the current Map File, the following map feature preferences are saved in reference to map 
features: 

• (Major) map features preferences. 
• Individual custom map feature preferences. 
• The choice to use basic or custom map feature preferences for that Map File. 

 

Map Feature Option Descriptions 
The following items are available for selection in the Features dialog area of the Map Display tab. Shorter 
descriptions of these features are available in the information box to the right of the Features selection area. 

Points of Interest (Major) 
View many different travel-related points of interest including accommodations, businesses, banks, gardens, 
hospitals, museums, recreational areas, theaters, and zoos. To customize the points of interest categories, select the 
Custom POIs check box and then click Edit POIs. 

Points of Interest (Minor) 
View general points of interest including educational, technology, government, and religious buildings/locations. To 
customize the points of interest categories, select the Custom POIs check box and then click Edit POIs. 

ZIP Codes 
ZIP Code boundaries display at data zoom level 8-0 and greater, with ZIP Code labels displaying at data zoom level 
10-0 and greater.  

One Ways 
One ways display as bright green triangles on roads, pointing toward the direction of travel (most noticeable in large 
cities). They are available at data zoom level 13 or greater. 

County Borders 
View shaded outlines of counties at data zoom levels 7-0 or greater. 

Exits 
View exits (yellow squares) and exits with services (blue squares) on primary limited access roads, interstates, and 
toll roads. Available at data zoom level 10-0 or greater. 

Grids 
The Grids option can be used to identify coordinate points on the map. Grid lines automatically adjust for the data 
zoom level of your map and are available beginning at data zoom level 3-0. 
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Places (Minor) 
Places (minor) include smaller towns (beginning at data zoom level 5-0); subdivisions (10-0) and locales, small 
islands, and natural landmarks, such as a desert (11-0). 

Roads (Minor) 
View secondary roads at data zoom level 7-0 and greater. View local and rural routes, trails and foot trails at data 
zoom level 11-0 and greater. 

Town Borders 
View town borders at data zoom level 10-0 and greater for the following states: 
Arkansas 
Connecticut 
Illinois 
Indiana 
Iowa 
Kansas 

Louisiana 
Maine 
Maryland 
Massachusetts 
Michigan 
Minnesota 

Mississippi 
Missouri 
Nebraska 
New Hampshire 
New Jersey 
New York 

North Carolina 
North Dakota 
Ohio 
Pennsylvania 
Rhode Island 
South Dakota 

Vermont 
Virginia 
Washington DC 
West Virginia 
Wisconsin 

Urban Area Color 
Displays a shaded map area in populated regions. 

International Labels 
View country labels at data zoom levels 2-0 through 5-0. 

Map Center Crosshair 
The map center crosshair indicates the map center at any data zoom level. 

Changing the Map Display 
This Help topic describes the steps necessary to change the map colors, to change the map magnification, and to 
change the data zoom level at which large POI symbols display on the map. 

To Change the Map Colors 
Often when using a laptop computer while traveling, it is difficult to see the map display on your screen. This can be 
especially true at nighttime or on a bright sunny day. Changing your default (street) map colors to high-contrast 
colors can make your map display easier to see.  
Use the following steps to change the map display. 

1. Click the Map Display tab and then click Display to display the Map Display options.  
2. From the Map Colors drop-down list, select High-Contrast Colors to change your map display to be 

darker (for improved in-vehicle visibility). Select Default Colors to change it back to the standard display. 

To Change the Map Magnification 
Use the following steps to change the map magnification. 

1. Click the Map Display tab and then click Display to display the Map Display options.  
2. Select a magnification percentage (50%, 75%, 100%, 150%, or 200%) from the Magnification drop-

down list.  
Note: Although the size of the image changes, the degree of geographic detail does not. 

To Change the Data Zoom Level for Large POI Symbols 
Use the following steps to change the data zoom level at which large POI symbols are displayed on the map. 

1. Click the Map Display tab and then click Display to display the Map Display options.  
2. Select the desired data zoom level from the Large Symbols At drop-down list. 

Notes:  
• The appearance of the POI may change at different data zoom levels. 
• If you have selected to display major and minor POIs in the Map Display Features list, the 

following actions may occur in Street Atlas USA: 
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If you select to 
view large 
symbols at 
data zoom 
level... 

You will see 
the following 
information at 
data zoom 
level 13-0 

You will see 
the following 
information at 
data zoom 
level 14-0 

You will see 
the following 
information at 
data zoom 
level 15-0 

You will see 
the following 
information at 
data zoom 
level 16-0 

You will see 
the following 
information at 
data zoom 
level 17-0 

14 names and 
small square 
symbols 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

15 small square 
symbols only 

name of the 
POI and a 
small square 
symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

16 N/A small square 
symbols only 

name of the 
POI and a 
small square 
symbol 

name of the 
POI and the 
large symbol 

name of the 
POI and the 
large symbol 

17 N/A small square 
symbols only 

small square 
symbols only 

name of the 
POI and a 
small square 
symbol 

name of the 
POI and the 
large symbol 

 

Setting Units of Measure Preferences 
Street Atlas USA 2005 Plus allows you to change the units of measure used to represent how coordinate formats, 
distance, and bearing listings display. Changing these preferences affects how units of measure display in several 
areas of the program: such as on the map and in the Control Panel.  
As you change your Unit of Measure preferences, a description of each choice displays in the information box (to 
the left of the Overview Map) immediately after it is selected. 

Coordinate Preferences 
• About Coordinate Preferences 

Changing the coordinate preferences affects the: 
 Coordinates display on the Control Panel. 
 Coordinate MapNotes. 
 Grid label display, if Grids are selected in Map Features. 
 Any other place where coordinates display or print. 

• To Set Coordinate Preferences 

Use the following steps to change how coordinate measurement units display. 
1. Click the Map Display tab and then click Units to display the Units options. 
2. Select the desired coordinate display format from the Coords drop-down list. 

 Degrees 
 Degrees, Minutes 
 Deg, Min, Sec 

Distance Preferences 
• About Distance Preferences 

Distance preferences affect how distance and areas display throughout the program.  

• To Set Distance Preferences 

Use the following steps to change the measurement units for distance and area in Street Atlas USA 2005 
Plus. 

1. Click the Map Display tab and then click Units to display the Units options. 
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2. Under Measures, select the desired measurement from the Measures drop-down list. 
• Statute Miles (statute feet are used for small distances) 
• Kilometers (Meters are used for small distances) 
• Nautical Miles/Feet (statute feet are used for small distances) 
• Nautical Miles/Meters (meters are used for small distances) 

Bearing Preferences 
• About Bearing 

Bearing listings are created as the result of creating route directions in the Route tab or from an Advanced 
(Distance From) search in the Find tab. Bearing refers to the compass direction of a given object measured 
clockwise in degrees (for example, 30°) or nearest compass point (for example, NNE) and indicated from 
True North or Magnetic North. 
Notes:  

 Magnetic declination is the difference in degrees between True North and Magnetic North at a 
specific location. 

 The bearing setting does not affect map appearance. 

• To Set Bearing Preferences 

Use the following steps to change the bearing. 
1. Click the Map Display tab and then click Units to display the Units options. 
2. Under Measures, select the desired bearing from the Bearing drop-down list. 

• True North—The direction to the north pole. 
• Magnetic North—The direction that a compass needle points. This is the default setting 

for Street Atlas USA 2005 Plus. 
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Handheld Export 
Handheld Export Overview 
The Handheld Export tab in Street Atlas USA 2005 Plus lets you cut a map which can be sent to a Palm OS® or 
Pocket PC device. 
The Handheld Export tab also features the Exchange Wizard (accessible using the Sync button). With the Exchange 
Wizard, you can send map, route information, draw points, waypoint, tracks (GPS devices only), and GPS log 
(Pocket PC devices only) files to a Palm OS, Pocket PC, or GPS device. You can also receive routes, waypoints, 
GPS logs (Palm OS and Pocket PC devices only), and tracks (GPS devices only) from a Palm OS, Pocket PC, or 
GPS device to be used in Street Atlas USA 2005 Plus. The Handheld Export section provides information for using 
the Exchange Wizard with a Palm OS or Pocket PC device.  
 

Exporting a Map to a Handheld Computer 
With Street Atlas USA 2005 Plus, you can export maps to be used on a Palm OS or Pocket PC handheld device. 
Important: You must have Street Atlas USA® Handheld or XMap® Handheld Pro (available separately from 
DeLorme) to view Street Atlas USA 2005 Plus maps on your handheld device. 

To Export a Map 
Use the following steps to export a map to a Palm OS or Pocket PC device. 

1. In Street Atlas USA 2005 Plus, click the Handheld Export tab. The Handheld Export dialog area displays. 
2. Type the city name of the area you want to export. When a match is available, press the ENTER key on 

your keyboard. 
OR 
Select an area to export from the available scroll list. 

3. Select the level of detail you want for the exported map: 
• Street Detail—Maps cut with Street Detail are routable on handheld devices and display at data 

zoom levels 8-0 and greater. 
• Regional Detail—Maps cut with Regional Detail are not routable on handheld devices and 

display at data zoom levels 4-0 and greater. 
4. Click Preview. The default export area displays on the map with lightly shaded rectangles. 
5. Click Select to accept the shaded area as your export area. 

6. If you want to edit the export area, click . To add an area, click a rectangle that is not already 
highlighted. To remove an area, click the highlighted rectangle(s).  
Note: Click Clear to clear the selected rectangles from the map. 

7. Type the file name for your new map in the File text box. 
8. Click Save. 
9. Click Sync. The Sync with Device dialog box displays. 
10. Select the device you want to send the map to from the Device Type drop-down list. 
11. Select the user you want to send the map to from the User drop-down list. 
12. If available on your map, select if you want to include the draw or route information in the exported map. 
13. Click Prepare for Sync. The map will be available on your handheld computer after your next 

synchronization operation. 

 

• To cut another map, repeat procedure listed above. 
• Click Clear at any time to clear all of the selected rectangles from the map. 
• To view a previously exported map, select it from the Saved Maps list and then click View. 
• To delete a previously exported map, select it from the Saved Maps list and then click 

Delete. 
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NetLink 
NetLink Overview 

 

You must have an Internet connection to use the NetLink tab. 

 
NetLink provides registered users with access to special offers, online support for their product, and items available 
for download. You can also use the NetLink tab to browse for additional products or data. 
The NetLink tab consists of three subtabs:  

• Home 
• Software 
• Support 

 

Using the Home Page 
The Home subtab provides special offers to registered Street Atlas USA 2005 Plus users. Follow the instructions 
provided on the screen to access each special offer. You are prompted to connect to the Internet each time you open 
Street Atlas USA 2005 Plus and click NetLink. 
 

Using the Software Page 
The Software subtab provides information about each of DeLorme's software products. Products are categorized by: 

• Travel, Recreation, & Reference 
• Professional & Business 
• GPS & Mobile 

When you select a product, a secondary browser window displays. Follow the instructions provided on the site to 
purchase the product. 

Using the Support Page 
The Support subtab allows you to search the DeLorme Support site by category or keyword(s). Once you click 
Submit, a secondary browser window displays the results of your category/keyword search. 
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Legal Information 
Street Atlas USA 2005 Plus Single-User License Agreement 
This is an Agreement between you, the end user, and DeLorme.  By using the Street Atlas USA 2005 Plus software, 
data, and documentation (the “System”), you are agreeing to be bound by the terms of this Agreement 
If you do not agree with the terms of this Agreement, you may not use the System. Return all materials within thirty 
(30) days of receipt to the dealer from which you obtained them or to DeLorme for a full refund. 
Any term or condition of an approved purchase order that differs from or adds to the terms or conditions of this 
License Agreement as well as any other modification or amendment to this Agreement will not be effective unless 
expressly agreed to in writing by both parties. 

LICENSE TERMS AND CONDITIONS 
THE LICENSED SYSTEM 
The System consists of DeLorme's patented (U.S. Pat. Nos. 4,972,319; 5,030,117; 5,559,707; 5,802,492; 5,848,373; 
5,948,040;  and 6,321,158; other patents pending) processes for the formatting, storage, retrieval, and presentation of 
geographic and geographically-related data; DeLorme's copyrighted computer program for the use of those 
processes and related functions; and compilations of geographic and supplemental data that are proprietary to 
DeLorme or its licensors.  The entire System, including the software, documentation, data compilations, screen 
displays, and map printouts are protected by U.S. and foreign copyright. You have no ownership rights in the 
System.  Rather, you have a license to use the System as long as this Agreement remains in full force and effect. 

YOUR USE OF THE SYSTEM 
NOTE:  See attached chart for a quick summary of use rights granted in connection with the various DeLorme 
software products. 
Permitted Use. This Agreement permits a registered user to use the System on a non-exclusive basis for personal, 
reference or business purposes on a single computer at one time.  You may install the System on an auxiliary 
computer in addition to your principal computer.  However, one of these two computers must be portable and the 
software may not be used simultaneously on both computers. Otherwise, once you have installed the System on one 
computer you may use the System on a second computer only if you delete the System from the first computer or 
purchase a separate license.  Installation of any part of the System on a network is prohibited unless you have a 
separate network license.  For information on network or multiple-user licensing, contact DeLorme at 
sales@delorme.com or 1-800-293-2389. You may use the System as instructed by the documentation to perform its 
designed functions only for the purposes authorized by this Agreement.  
Paper Map Printout Rights. You may reproduce paper copies of any Street Atlas USA map printouts for personal or 
household use or, if you are a business or institution, for in-house purposes, provided that distribution and use of 
such printouts and copies of printouts is limited to the location where the System is installed or limited to use by 
employees based at that location. 
Paper Locator Map Distribution Rights. You may distribute to family and friends, including via fax, paper copies of 
Street Atlas USA map printouts depicting locations of personal interest. You may distribute to your colleagues, 
clients, customers or prospects, including via fax, paper copies of Street Atlas USA map printouts depicting the 
location of your business or institution or the locations of your business or institution-related meetings or events and 
in flyers or brochures that contain no paid advertising. 
Paper Report Distribution Rights. You may reproduce for distribution to colleagues or clients up to one thousand 
(1,000) paper copies of any Street Atlas USA map printouts for use in paper reports such as appraisals or 
environmental studies, provided that no such report includes more than fifty (50) different Street Atlas USA maps 
and that the distribution does not constitute a general and unrestricted publication for sale or resale or contain paid 
advertising. 
Periodical Illustrations. You may reproduce paper copies of any Street Atlas USA map printouts as illustrations to 
articles in printed paper periodical works, such as magazines, newspapers, and newsletters, provided that the 
publication is not primarily a collection of maps, and provided that proper legend, as described below, accompanies 
the output. Such articles may also be posted on your Web site. Graphic printers hired by licensee to print DeLorme 
map images are required to purchase a license. 
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Special Presentation Rights. You may use paper copies of Street Atlas USA map displays and printouts in 
presentations to live audiences only with prior written permission from DeLorme. 
Web Site Map Display Rights. You may display on your personal, business, or institutional static Web site map 
images derived from the System, provided that you include the Legend indicated below and that you provide a link 
to the DeLorme Web site at www.delorme.com from any page featuring a DeLorme map image. If you subcontract a 
Web developer to display map images, said web developer must purchase a license. 
Legend. Any System output that is provided to a third party must include the following credit and copyright notice: 
“© 2004 DeLorme (www.delorme.com) Street Atlas USA® Plus”. You may not remove, alter, or conceal any 
copyright or trademark notices appearing on any System output, except that when creating a mural map, you need 
only retain a single legend with scale, for use in the field. 
Phone Database. You may use the phone database available separately from DeLorme, subject nevertheless to all of 
the provisions of this License Agreement. Use with Auto Dialer applications is prohibited. End User shall use Phone 
Data in compliance with any and all federal, state, or local statutes, regulations, or ordinances, including without 
limitation, any applicable privacy, do-not-call, telemarketing, or related statutes regulations or ordinances.  End User 
shall defend and indemnify DeLorme, including attorney fees, against any claims arising out of the violation by End 
User of this License Agreement. Export of phone data is limited to one thousand (1,000) records at any one time.  
Copy Services. You may use a commercial copy service to reproduce paper copies that are authorized by this 
Agreement. 
NetLink Tab. All data downloaded or purchased through the NetLink Tab is subject to DeLorme’s specific data use 
license agreement associated with those products.  Commercial use of Netlink data is prohibited.  TopoBird® data 
use is limited to recreational or personal use only.  See DeLorme’s Web site for TopoBird® derivative  data use 
license agreement.   
Legend. Any System output that is provided to a third party must include the following credit and copyright notice: 
“© 2004 DeLorme (www.delorme.com) Street Atlas USA®”. You may not remove, alter or conceal any copyright 
or trademark notices appearing on any System output, except that when creating a mural map, you need only retain a 
single legend with scale, for use in the field.  
You understand and agree that the trademarks, trade names, service marks, copyrights and other proprietary rights of 
DeLorme are and shall remain the sole and exclusive property of DeLorme, and that you will not hold yourself out 
as having any ownership rights thereto.  You further agree that you will make no use of such rights except as 
provided in this Agreement. 

PROHIBITIONS ON USE 
No Resale or Distribution. Except as expressly permitted in this Agreement, you do not have the right to sell, or to 
reproduce or distribute for sale, any part of the System or output of the System alone or in combination with any 
other text, data, software, or graphic matter. 
No Interactive Use. You do not have the right to combine the System interactively with the operation of other 
software unless licensed to do so by DeLorme. 
No Modifications or Decompilation. Except through use of any software modification functions provided with the 
System, you have no right to modify the System in any way, incorporate any part or product of it into a compilation, 
or create any derivative work. You may not reverse engineer, decompile, disassemble, or otherwise access source 
code or the logical structure and contents of the System database. 
No Third Party/Service Bureau Use.  Except as specifically provided in this Agreement, you may not (a) permit any 
third party to use the System or transfer, disclose, or otherwise make available the System to any third party, (b) use 
the System in the operation of a service bureau or (c) allow access to the System through terminals located outside 
your premises.  You agree to secure and protect the System in a manner consistent with the maintenance of 
DeLorme’s rights therein and to take appropriate action by instruction or agreement with your employees who are 
permitted access to the System to satisfy your obligations hereunder. 
No Copies.  The copying of the System, any portion of the System, or any of the printed materials accompanying the 
System is strictly prohibited. 
All rights not specifically granted by this Agreement are reserved by DeLorme. 
ADDITIONAL USE AND PUBLICATION RIGHTS MAY BE AVAILABLE UNDER A SEPARATE 
EXTENDED LICENSE AGREEMENT. CONTACT DELORME AT CUSTOM@DELORME.COM FOR 
DETAILS AND PRICING. 
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WARRANTIES AND DISCLAIMER 
Limited Warranty on Media. DeLorme warrants that the media on which the System is furnished shall, for a period 
of sixty (60) days from date of receipt (the "Warranty Period"), be free from defects in material and workmanship 
under normal use. If a defect in the media appears during the Warranty Period, return all materials to DeLorme for 
replacement, or at DeLorme’s option, refund of the license fee. 
Disclaimer of Warranty. DeLorme does not warrant the completeness or accuracy of the System, or that its use will 
meet your needs or be uninterrupted or error-free. TO THE MAXIMUM EXTENT PERMITTED BY LAW, 
EXCEPT FOR THE WARRANTIES SET FORTH ABOVE, THE SYSTEM IS LICENSED “AS IS” AND 
DELORME DISCLAIMS ANY AND ALL OTHER WARRANTIES, EXPRESS OR IMPLIED INCLUDING, 
WITHOUT LIMITATION, IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.  
No Consequential Damages. IN NO EVENT SHALL DELORME BE LIABLE FOR ANY SPECIAL, INDIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF 
REVENUES OR PROFITS, EVEN IF DELORME HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 

TERMINATION AND TRANSFER  
DeLorme may terminate this Agreement at any time for any reason including, but not limited to, if DeLorme finds 
that you have violated any of the terms of this Agreement or that you have attempted to exceed the licensed uses in 
any way. Termination will be effective upon written notice to you. Upon termination of this Agreement, you agree 
to promptly return all copies of the System, documentation, and other materials furnished to you or made by you, 
including unauthorized copies. Termination is in addition to and not in lieu of any other remedies available to 
DeLorme.  All provisions relating to property rights shall survive termination.  You are not authorized to transfer 
your rights under this Agreement. 

OTHER 
This Agreement contains the complete understanding between the parties and supersedes and replaces any prior or 
contemporaneous agreement or understanding, whether oral or written, with respect to its subject matter.  This 
Agreement shall be governed by the laws of the State of Maine, applicable to agreements wholly executed and 
wholly performed in Maine.  Any action relating to this Agreement shall be brought in federal or state court in 
Maine and the parties consent to the personal jurisdiction of either such court. 

U.S. Government Rights in Commercial Software 
Use, duplication, or disclosure by the Government of all parts of the Licensed Data except any USGS data is subject 
to restrictions set forth in the commercial computer software license agreement under which the software is 
delivered by DeLorme and as provided in DFARS 227.7202-1(a) and 227.7202-3(a) or DFARS 227.225-7013 (OCT 
1988), as applicable, or FAR 12.212(a), FAR 52.227-14 or FAR 52.227-19, as applicable. 
Copyright © 2004 DeLorme. 

Table of DeLorme Publishing Company, Inc, Software Key License Provisions 
 Street Atlas USA 

2005/Street Atlas 
USA 2005 
Handheld  

Street Atlas USA 
2005 Plus 

Topo USA XMap 

Static Web Maps Permitted if there 
is no charge and 
with credit and a 
link to DeLorme 
Web Site 

Permitted if there 
is no charge and 
with credit and a 
link to DeLorme 
Web Site 

Permitted if there 
is no charge and 
with credit and a 
link to DeLorme 
Web Site 

Permitted if there 
is no charge and 
with credit and a 
link to DeLorme 
Web Site 

Product Files, i.e., 
.RTF, .PDF 

Permitted if there 
is no charge and 
with credit and a 
link to DeLorme 
Web Site 

Permitted if there 
is no charge and 
with credit and a 
link to DeLorme 
Web Site 

Permitted if there 
is no charge and 
with credit and a 
link to DeLorme 
Web Site  

Permitted if there 
is no charge and 
with credit and a 
link to DeLorme 
Web Site 

Books Not Permitted Permitted with Permitted with Permitted with 
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written permission written permission written permission 
Commercial or 
Academic Reports 

Permitted with 
credit 

Permitted with 
credit 

Permitted with 
credit 

Permitted with 
credit 

Use in Periodical 
Articles 

Permitted with 
credit 

Permitted with 
credit 

Permitted with 
credit 

Permitted with 
credit 

Broadcast  Permitted only 
with written 
permission 

Permitted only 
with written 
permission 

Permitted only 
with written 
permission 

Permitted only 
with written 
permission 

Public Display Permitted only 
with written 
permission 

Permitted only 
with written 
permission 

Permitted only 
with written 
permission 

Permitted only 
with written 
permission 

Multiple 
Computers 

One Desktop and 
One Notebook, no 
simultaneous use 

One Desktop and 
One Notebook, no 
simultaneous use 

One Desktop and 
One Notebook, no 
simultaneous use 

One Desktop and 
One Notebook, no 
simultaneous use 

Copy Services In instances when 
copying is 
permitted, it may 
be performed by 
copy services 

In instances when 
copying is 
permitted, it may 
be performed by 
copy services 

In instances when 
copying is 
permitted, it may 
be performed by 
copy services 

In instances when 
copying is 
permitted, it may 
be performed by 
copy services 

Locator Maps Permitted with 
credit provided that 
no paid advertising 
is included 

Permitted with 
credit provided that 
no paid advertising 
is included 

Permitted with 
credit provided that 
no paid advertising 
is included  

Permitted with 
credit provided that 
no paid advertising 
is included 

 
Note: This chart is provided for convenience and reference purposes only. The scope of a user’s rights is to be 
determined based upon language appearing in the applicable license. In the event of a conflict between the chart and 
the applicable license, the license will govern. 

Important Notices 
Patent and Copyright Notice 
Street Atlas USA is a limited field of use license under United States Patent law including the following patents 
owned by DeLorme: U.S. Pat. Nos. 4,972,319; 5,030,117; 5,559,707; 5,802,492; and 6,321,158. Other patents 
pending. All software, data compilations, screen displays and map printouts are all protected by U.S. and foreign 
copyright and owned by DeLorme or its licensors. Purchaser of license acquires no rights that are not specifically set 
forth in the License Agreement included in the documentation.  

U.S. Government Rights in Commercial Software 
Use, duplication or disclosure by the Government is subject to restrictions set forth in the commercial computer 
software license agreement under which the software is delivered by DeLorme and as provided in DFARS 
 227.7202-1(a) and 227.7203-3(a) or DFARS 227.225-7013 (OCT 1988), as applicable, or FAR 12.212(a), FAR 
52.227-14 or FAR 52.227-19, as applicable. 
 
Copyright © 2004 DeLorme.  

Apache Software License, Version 1.1 
Copyright © 1999-2003 The Apache Software Foundation. All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer.  

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 
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3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment: "This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and 
wherever such third-party acknowledgments normally appear. 

4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products 
derived from this software without prior written permission. For written permission, please contact 
apache@apache.org. 

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, 
without prior written permission of the Apache Software Foundation. 

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE 
SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
This software consists of voluntary contributions made by many individuals on behalf of the Apache Software 
Foundation and was originally based on software copyright © 1999, International 3.5 Machines, Inc., 
http://www.ibm.com.  For more information on the Apache Software Foundation, please see 
http://www.apache.org/. 
 


